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Rapid P-Index  MN Rapid Phosphorus Index 
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SSURGO  Soil Survey Geographic Database 

SWAT   Soil and Water Assessment Tool 
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Project Overview 

Background and Project Need 

Topographic, hydrologic, and agronomic factors often combine to make some nonpoint sources contribute a 
disproportionate amount of pollutants such as sediments and nutrients to nearby surface waters resulting in an 
inordinate impact on the beneficial use of the water resources. Government conservation programs often have 
limited funding and landowner participation is voluntary, which may not result in enrolling the most critical 
lands. Therefore, methods or strategies to identify these priority areas are necessary to efficiently and 
proactively target the available resources for Best Management Practice (BMP) implementation.  

Critical Source Areas (CSAs) are defined as portions of the landscape that combine high pollutant loading with 
a high propensity to deliver runoff to surface waters. These areas have a higher likelihood of conveying more 
pollutants to surface waters than other portions of the landscape. Priority Management Zones (PMZs) are 
regions of the watershed targeted for conservation practices that address disproportionate or large pollutant 
loads.  

Most of the available literature regarding CSA evaluations confirms that a small fraction of the agricultural 
landscape can have a disproportionately large impact on downstream water quality (Pionke et al., 2000; Gburek 
et al., 2000; Yang and Weersink, 2004; White et al., 2009; Winchell et al., 2011 and Meals et al., 2012). White 
et al. (2009) reported that just 5% of the land area yielded 50% of the sediment load and 34% of the phosphorus 
load in Oklahoma watersheds. Pollutant loads from these agricultural CSAs were more than four times greater 
than the average load from agricultural areas within the watershed. In a large Vermont river basin, about 74% of 
the annual nonpoint source phosphorus load was estimated to come from just 10% of the land area (Winchell et 
al. 2011). In the Minnesota portion of the Cedar River watershed, Soil and Water Assessment Tool (SWAT) 
modeling showed that approximately 30% of the sediment load was coming from 5% of the watershed area 
(Barr, 2014) after accounting for the effects of streambank erosion. 

United States Department of Agriculture’s (USDA) Conservation Effects Assessment Project (CEAP) resulted 
in several lessons learned about identifying a watershed’s critical source areas (Meals et al., 2012). Most of the 
land treatment in the CEAP projects had already been implemented under previous voluntary programs and not 
deliberately targeted to CSAs. In the Little Bear River, 13% of the watershed was characterized as CSAs. 
Twenty-six percent of the CSAs had existing conservation practices, but 75% of the watershed practices were 
applied to areas with low potential for pollutant load. In the Cheney Lake Watershed only 22% of implemented 
conservation practices were located in CSAs.  

The approaches used to identify CSAs in the CEAP watersheds varied from watershed modeling, including 
export coefficients, the SWAT model, Generalized Watershed Loading Function (GWLF) and Universal Soil 
Loss Equations (USLE and Revised Universal Soil Loss Equation, Version 2 [RUSLE2]), as well as soil 
moisture and curve number modeling, monitoring data and topographic indices (Meals et al., 2012). Just a few 
of these projects used a combination of approaches to identify CSAs. 

Minnesota Board of Water & Soil Resource’s (BWSR) Environmental Benefits Index (EBI) spatially shows 
relative risk for soil erosion based on terrain attributes and soil characteristics, accounts for proximity to surface 
waters and accounts for habitat quality. As a result, the EBI represents a good tool, especially for planning-
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level, watershed-scale analysis. The limitations of the EBI are that the terrain attributes are based on 30-meter 
digital elevation model topography, so it does not make use of light detection and ranging (LiDAR) data, which 
makes it more difficult to distinguish pourpoints (locations where upland areas discharge to riparian areas) and 
the relative water quality risk.  

Most of the available tools or models used for CSA identification utilize some portion of the USLE 
(Wischmeier and Smith, 1960). The USLE is a multiplicative equation using the formula A =R x K x LS x C x 
P where: 

• A = potential long term average annual soil loss in tons/acre/year 
• R = rainfall and runoff erosivity factor 
• K = soil erodibility factor 
• LS = slope length-gradient factor 
• C = crop/vegetation and cover management factor 
• P = support practice factor 

The K and LS factors are typically calculated based on National Resource Conservation Service (NRCS) spatial 
and tabular Soil Survey Geographic (SSURGO) Database soils data. The R factor does not typically vary 
significantly for most watershed studies and the C and P factors require site-specific data or are assumed to be 
the same for planning purposes. It is important to note that, while the USLE approach represents a good 
approximation of sheet and rill erosion and the potential for loss of particulate nutrients, it is typically subject to 
the following limitations: 

• Downstream pollutant delivery can differ significantly depending on flow accumulation, proximity to 
surface waters and hydraulic connectivity with the drainage network 

• Soil loss can differ significantly depending on the shape of the slope or compound slopes of the tributary 
area(s) 

• Nutrient loss variations due to nutrient and crop management practices are not accounted for (except 
through the use of some watershed models) 

• Pollutant load generation and delivery will differ significantly depending on drainage water management 
and/or variable hydrologic source areas 

• Other methods should be used to accurately quantify the relative magnitude of gully and channel erosion 

Comprehensive hydrologic and water quality models like the SWAT and Hydrological Simulation Program-
Fortran (HSPF) models can be effective for identifying CSAs because they incorporate landcover, topography, 
soil characteristics, rainfall, and land cover management, all of which influence the mobilization and transport 
of sediment and nutrients. The primary limitation of watershed-scale modeling efforts are that they do not 
typically contain the spatial detail and/or physical processes necessary to account for gully erosion and the 
potential delivery mechanisms to simulate transport from upland to riparian areas in the system. As a result, 
researchers are recognizing the need to combine the beneficial aspects of watershed modeling with Geographic 
Information System (GIS) terrain analysis to better identify and prioritize CSAs. 
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Project Objectives 

Three main factors contribute to the identification of CSAs: the magnitude of pollutant sources, the transport 
potential and the risk for erosion. Depending on the pollutant and receiving water, some combination of these 
three factors can be used for prioritization and targeting of CSAs. PMZs, in turn, can be characterized by three 
areas of emphasis: source reduction, interception treatment, and in-channel assimilative capacity. New tools and 
technology make it possible to target conservation practices to areas of the landscape where they are needed 
most. With the increasing availability of LiDAR data for Minnesota, there is greater potential for rapid 
landscape assessments that help identify CSAs and PMZs. 

The primary goals and objectives for this project involve the development of a process that: 

• Provides a scalable, streamlined approach that combines GIS terrain and spatial analysis techniques with 
targeted site visits for pinpointing vulnerable lands where conservation implementation and funding will 
provide the most beneficial water quality improvements  

• Provides repeatable and measurable methods for ranking vulnerable sites during funding applications 
• Is flexible and allows for increasing complexity from the integration of other sources of data (modeling, 

soils, land cover, pourpoint stability, phosphorus indices, etc.) with terrain attributes to enhance 
decision-making 

• Quickly and efficiently analyzes large watershed areas and quantifies manageable number of high 
potential sites in a target area 

• Facilitates the development of watershed restoration and protection strategies 
• Supports funding requirements that implementation projects be: 

o Prioritized 
o Targeted 
o Measurable 

• Assists with initiating conversations with agricultural producers that provides visual communication 
regarding potential conservation activities will visualize the issues and potential solutions. 

 

Report Organization 

This report is intended to be an operation handbook or manual that provides combined guidance for watershed 
practitioners to use in identifying and prioritizing CSAs and delineating PMZs for optimum placement of 
conservation measures based on source magnitude, hydrologic connectivity and delivery mechanisms/erosion 
potential.  

The methodology described here-in is organized into the following sections to demonstrate how high-resolution 
GIS analysis and field verification can be integrated with other sources of data to direct practitioners to those 
sites with the greatest potential for sediment and nutrient movement across the landscape:
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1. Digital Terrain Analysis—this section is intended to deliver the information in a manner that even 
novice GIS users and technicians can readily apply when developing and verifying an in-depth/accurate 
map of the CSAs in their focus watershed. The mapping allows watershed practitioners to quickly and 
efficiently identify the specific locations and landowners that warrant site visits and field validation.  

2. Field Assessment—a suite of field evaluation tools are provided to guide the assessment of the cropland 
and streams/ditches/conveyances in your project area to evaluate the importance of the site’s potential 
for source reductions, interception treatment practices and improving channel stability or erosion 
control.  

3. Case Studies—summaries of desktop analyses, including integration of modeling/monitoring/indices, 
site evaluation protocols and decision-support guidance are also provided to enable practitioners to 
further target and prioritize candidate areas for implementation of conservation practices in multiple 
regions of the state. 
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Digital Terrain Analysis 

Overview 

This section provides digital terrain analysis methods and procedures for identifying CSA predictions. It is 
intended to be used in conjunction with the protocols described in the Field Assessment section. Digital terrain 
analysis is the preferred method for locating CSA’s due to its efficiency and high-quality, readily accessible 
input data. It has been the focus of several recent studies in Minnesota with overall accuracies ranging from 78-
88% (see Appendix section A.1 for details). This section discusses the feasibility of using GIS analysis to 
inform field assessments. For this project, GIS software is used to perform a terrain analysis, which employs 
elevation data to characterize the physical features of the landscape. Terrain analysis can be used to identify 
locations with a high potential for erosion and pollutant runoff. These identified source areas can then be 
assessed for further evaluation. Additional spatial analyses can also be incorporated, including source proximity 
to a water body and soil erosion risk factors. Terrain analysis and other spatial analyses do not eliminate the 
need for field assessments. However, they can reduce the amount of time spent in the field and enhance data 
collection efforts by enabling technicians to select potentially sensitive sites. 

It is important to note that many of the sites identified as sensitive by the GIS analysis may already have 
appropriate management and operation. Thus, these tools also provide an important opportunity to recognize 
producer accomplishments and track program progress necessary for supporting basin management and Total 
Maximum Daily Load (TMDL) efforts. 

The steps described in this section require the use of Environmental Systems Research Institute’s (ESRI) 
ArcGIS computer software with Spatial Analyst extension installed. The basic version (ArcView license) is 
sufficient for the methods described herein. This methodology is also designed to accommodate users of either 
ArcGIS versions 9.0 to 9.3.1 or 10.0 to 10.2 – the former will be referred to as 9.x and later as 10.x from here 
on. Other GIS-based software programs that are able to process large raster datasets and calculate logical map 
algebra should work for terrain analysis processing but will not be covered in this section. 

The terrain analysis process involves combining primary attributes to form secondary attributes.  The core 
primary attributes used for this terrain analysis include flow direction, flow accumulation, and slope.  Secondary 
attributes include Stream Power Index (SPI) and Compound Topographic Index (CTI). 

SPI is calculated as the product and CTI the quotient of the natural log of both slope and flow accumulation.  

SPI = ℓn(FA * β) 

CTI = ℓn(FA / β) 

Where FA represents flow accumulation and β slope 

High SPI values displayed in GIS represent areas on the landscape where high slopes and flow accumulations 
exist and thus areas where flows can concentrate with erosive potential. For this reason, SPI is very useful for 
determining potential CSA locations. Conversely, CTI can show areas on a landscape that pond and store water, 
and is therefore useful for locating potential wetland locations. The plan and profile curvature terrain attributes 
can also be used to identify upland sinkhole locations, and to aid in ravine identification (see Appendix A.2). 
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The digital terrain analysis core process can be visualized using the following flow chart: 

 

Digital Terrain Analysis Flow Chart 
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Digital terrain analysis flow chart 

Digital terrain analysis begins with a planning process where project goals are established and an appropriate 
scale for assessment is defined. The spatial scale will determine the amount of data acquisition necessary to 
address project goals. The attributes created may or may not require pre-processing. This again is at the 
discretion of the user’s project goals. The attributes are either primary or secondary in nature, depending on 
whether they derive directly from elevation data or a secondary product. The attributes, when combined with 
relevant ancillary data, should provide enough information to locate and prioritize potential CSAs. Ground-
truthing is an important step necessary to relate mapping to planned goals. The objective of ground-truthing is 
to determine best-fit threshold values for a given Area of Interest (AOI) by comparing digital terrain attributes 
to real-world conditions. When thresholds have been established, CSAs can then be located and prioritized 
using a combination of primary attributes, secondary attributes, and ancillary data. CSA validation is used to 
determine accuracy of predictions and reveal the existence of commission and omission errors. This step is 
fundamental to the user learning process since locating potential CSAs digitally is an adaptive process and 
validation provides opportunities to improve visualization and prediction techniques. Evaluation of site 
conditions should accompany field validation. The PMZ Field Assessment section was developed to assist in 
site evaluations, and to direct efforts and track results when visiting priority sites in the field. The final step is to 
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make decisions regarding how to address field-verified CSAs. This may involve contacting and working with 
land owners, determining which BMPs are most suited for the agroecoregion, and/or securing conservation 
practice funds for BMP implementation, among others.

8 Identifying Priority Management Zones for BMP Implementation in Impaired Watersheds 

 
 



Digital Terrain Analysis 2014 
 

Procedure 

Data acquisition 
For the primary attribute calculations that define terrain analysis, only a raster DEM is required, but 
ancillary data will be necessary to create CSA predictions –  all of which are available at the Minnesota 
‘data deli’ website: http://deli.dnr.state.mn.us/ unless otherwise noted. 
• DEM – A DEM contains one elevation value (as measured above Mean Sea Level) in each pixel, or 

cell, of data. Ideally, LiDAR elevation data should be used in terrain analysis for its high spatial 
resolution and accuracy characteristics. LiDAR data are available for the entire State of Minnesota, 
downloadable at the county level from either of the two links below: 
ftp://ftp.lmic.state.mn.us/pub/data/elevation/lidar/ 
ftp://lidar.dnr.state.mn.us/  
LiDAR data from the above sources provide DEM’s in both 1 and 3 meter resolutions. Digital 
terrain analyses are best processed using a 3 meter DEM to minimize processing times and file sizes 
while maintaining a high level of elevation detail (Galzki, et al., 2011). 
o Note: When downloading LiDAR data, an ftp client such as FileZilla should be used due to large 

file sizes associated with LiDAR geodatabases. LiDAR datasets for some counties exceed 5 
gigabytes and can be computationally inefficient to acquire and process. In some cases, it may be 
necessary to use lower resolution DEM data. 30m DEM data is still readily available throughout 
the state, though it should be noted that this will considerably reduce the ability to accurately 
predict CSA locations (Srinivasan et al., 2009). 

• Surface waters – Current stream data containing both perennial and intermittent networks along with 
lake/wetland layers will be necessary to determine hydrologic connection to secondary attributes. 

• Watershed catchments – Watershed data at various spatial scales. These are typically ordered from 
the number of digits in a hydrologic unit code (HUC) – from 2 digits representing regional 
watersheds to 12 digits representing subwatersheds. These layers are also convenient for use as an 
output extent when creating a clipped raster subset (see DEM clipping on page 18). 

• Cities and political boundaries – Political boundary and populated area data can be useful for spatial 
orientation, locating areas of interest, and improving map presentation. 

• Land cover/land use – The most current National Land Cover Database (NLCD) raster layer, 
available from the USDA Geospatial Data Gateway: http://datagateway.nrcs.usda.gov/  

• Environmental Benefits Index – The EBI layer integrates soil erosion risk, water quality risk and 
habitat quality factors to determine the relative conservation value of a parcel of land. It can be 
useful for locating regions with high erosion risk. The Soil Erosion Risk portion of the EBI can also 
be used alone to aid with CSA placement. The EBI and its individual layers are available at a 30m 
resolution for most of the State of Minnesota here: 
http://www.bwsr.state.mn.us/ecological_ranking/ 

• NRCS GIS Engineering tools – The freeware python-based toolset is compatible with ArcGIS 9.3 
and 10.x, allowing for seamless integration and familiar, user friendly interfaces identical to default 
ArcGIS Arctools. The NRCS tools include processes for hydro-conditioning, watershed delineation, 
conservation planning and more. Direct download link: 
ftp://ftp.lmic.state.mn.us/pub/data/elevation/lidar/tools/NRCS_engineering/NRCS_GIS_ENGINEER
ING_TOOLS_ver1.1.7.zip 
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• High resolution aerial orthophotos – Orthorectified and georeferenced photos should be used to 
ensure correct alignment with surface features. Color or Color Infrared (CIR) photos with at least 5 
meter resolution are preferred with leaf-off  periods (spring or fall) being ideal. Recently acquired 
Farm Service Agency (FSA) National Aerial Imagery Program (NAIP) digital photos from Spring, 
Summer, and Fall throughout Minnesota are readily available at: 
http://www.mngeo.state.mn.us/chouse/airphoto/ 
ArcGIS software users can connect  to the Minnesota Geospatial Information Office’s (MNGeo) 
web map service through a GIS server. This will negate the need to download any photos. 
Instructions for connection are here: 
http://www.mngeo.state.mn.us/chouse/wms/how_to_use_wms.html  
1. Open ArcMap and click on 'Add Data' 
2. Look in the Catalog, and click on 'GIS Servers' 
3. Highlight 'Add WMS Server' so that it appears in the Name window, and hit 'Add'. An 'Add WMS Server' 

window will pop up. 
4. To bring up the Imagery server, type ‘http://geoint.lmic.state.mn.us/cgi-bin/wms?’(without quotes) in 

the URL window. You can click on the 'Layers' button to see a list of the layers available under the wms. 
Click 'OK'. 

5. To bring up the Scanned DRG server, type ‘http://geoint.lmic.state.mn.us/cgi-bin/wmsz?’ (without 
quotes) in the URL window. You can hit the 'Get Layers' button to see a list of the layers available under 
the wms. Click 'OK'. 

6. Now when you look under 'GIS Servers' you have two new entries: 'LMIC WMS server (aerial 
photography) on geoint.lmic.state.mn.us' and 'LMIC WMS server (quad sheet drgs) on 
geoint.lmic.state.mn.us' 

7. Still in the 'Add Data' window under 'GIS Servers', highlight one of the services listed under #6 to bring it 
into the 'Name' window, then click on 'Add'. The service, with all of its layers, has now been added to 
your ArcMap project. 

• Other – Other useful information could range from regional data such as soils (SSURGO data), 
Highly Erodible Lands, feedlot, culvert, and point source locations to field specific information such 
as individual landowner nutrient application rates, existing conservation practice locations and 
conditions, artificial drainage size and placement, etc.
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Pre-process DEM 
Digital Elevation Models can benefit from pre-processing before terrain analysis is conducted. The 
amount of pre-processing required may depend on the user’s local knowledge of their AOI and its 
characteristics, and the resolution and quality of the original DEM. A semi-automated utility for both 
creating AOIs and hydrologically conditioning DEMs will be presented here. Alternatively, advanced 
GIS users may find it advantageous to create their own Python scripts and/or ModelBuilder flow paths 
within ArcGIS to semi-automate pre-process and terrain attribute calculations to decrease processing 
times and ensure consistent outputs. 

 
• Activate Spatial Analyst Extension 

This initial step is necessary for certain Arctool processes to run. ArcGIS will remember your 
selection and automatically activate selected extensions every time the program is run. 

 
1. From the Tools menu (ArcMap 9.x) or Customize menu (10.x), select Extensions… and 

check‐on the Spatial Analyst extension. 
 

 
 

2. Click Close.
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• Hydrologic Conditioning 
Hydrologic conditioning (HC) is the process of modifying a DEM to change flow routing and 
drainage. The most common practice of HC is to remove “digital dams” that block the hypothetical 
flow of water typically associated with road crossings and other obstructions. One method of 
removing digital dams is to “burn” the stream through the obstruction to force flow downstream. 
 
HC can be a time consuming process, thus it is important to consider whether your project goals 
would benefit from the operation, and if so, how much correction is needed and at what scale. For 
instance, some projects may only warrant burning the largest culverts along high order streams while 
others may require burning tile lines at the field scale. 
Some points to consider: 
o HC will only change terrain analysis attributes in close proximity to the digital dams removed. 
o HC is most useful when combined with pit filling – if pit filling is not necessary or suitable in 

your AOI, HC will provide minimal terrain analysis benefits. However, if pit filling is to be used, 
hydro-conditioned DEMs will tend to produce more accurate terrain attributes within filled 
depressions. For instance, when filling all sinks in a DEM, HC can improve flow routing by 
unblocking large depression areas that would otherwise fill with hypothetical water to force flow 
over obstructions. The Stream Power Index signatures in those unblocked depressions will be 
more representative of actual overland flow when sinks have been filled. 

 

 

 

 

 

 

 

 
ArcGIS includes tools that can be used to hydrologically condition DEMs, such as Topo to Raster 
(Vaughn 2012). Several 2nd party applications also exist with HC capabilities. The NRCS GIS 
Engineering toolset introduced in the Data Acquisition section (page 9) is one such utility 
recommended for its ability to burn streams through a semi-automated process of digitizing culverts. 
The user must input culverts either by importing a polyline shapefile or by manually digitizing their 
locations. 
 

The left image shows an example of how water 
ponds (in blue) behind road crossings when 
using a non-conditioned DEM. There are culverts 
present at both crossings (circled in yellow), 
though the DEM does not recognize culverts and 
sees the road as an obstruction – known as a 
digital dam. Ideally all DEM’s used for SPI 
creation should be hydrologically corrected, 
though the process can be time consuming and 
small culverts may not show up in aerial 
photography making field verification necessary.  
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See the Data Acquisition section (page 9) for the NRCS tools zip file download link. Once the file is 
downloaded to your computer, follow the readme instructions to install the software: 

 
[from the version1.1.7_ReadMe.txt] 
 
Installing the tools: 
-------------------- 
No special or admin privileges are required, simply unzip the zip file 
to a local directory.  
An "NRCS_GIS_ENGINEERING_TOOLS" folder will be created in specified 
location. Within the NRCS_GIS_ENGINEERING_TOOLS folder there will be 
an "NRCS Engineering Tools.tbx" toolbox file and a "SUPPORT" folder. 
The support folder contains the necessary scripts, files, and 
symbology layers, and must always reside in the same directory as the 
toolbox. 
 
Adding to ArcMAP: 
---------------- 
Enable the ArcToolbox window (if necessary), right click, and select 
"Add Toolbox". 
Browse to the location where the files were unzipped, then the 
"NRCS_GIS_ENGINEERING_TOOLS" Folder within, and click once to select 
or highlight the NRCS Engineering Tools Toolbox, then click the "Open" 
button in the bottom right hand corner of the dialog box. 
 
ArcMap Settings: 
--------------- 
Make sure that the Spatial and 3D Analyst extensions are enabled by 
going to the Customize > Extensions Menu (ArcGIS10) or the Tools > 
Extensions Menu (ArcGIS 9.3). 9.3 Users should also go to the Tools > 
Options Menu, click on the Geoprocessing Tab, and make sure that both 
"Overwrite the outputs of Geoprocessing Operations" and "Add Results 
of geoprocessing operations" options are selected. "Results are 
temporary by default" should also be UN-CHECKED. 
--------------- 
END 

 
When properly setup in ArcMap, the NRCS tools should resemble the following image in your 
ArcToolbox: 
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The following section will guide users on area of interst and hydrologic conditioning DEM pre-
processing using the NRCS GIS Engineering Tools. For manual AOI raster clipping, see Appendix 
section A.3. 

 
1. Launch ArcToolbox by clicking the toolbar icon (9.x) or 

ArcToolbox in the Geoprocessing menu (10.x).  
 

 
 

2. Expand the NRCS Engineering Tools, then expand the Watershed Tools toolset, followed by 
the Watershed Delineation toolset. Double‐click the Define Area of Interest tool to start it. 
Minnesota LiDAR data acquired at the county level can contain very large file sizes. It is 
therefore important to minimize the spatial area to be processed to reduce output files sizes and 
increase processing times. The Define Area of Interest tool creates a subset of a raster dataset 
and will be used for this purpose. 

 
Note: There are several additional ways to find this (or any) tool in ArcToolBox: 

o Select the Index tab at the bottom of ArcToolbox and scroll through the list to find Clip 
(Data Management) (9.x). 

o Select the Search tab at the bottom and type in ‘fill’ to find any tools with fill in their titles 
(9.x). 

o From the Geoprocessing menu, choose Search For Tools (10.x). 
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3. Browse to and Select Workspace: Choose your workspace folder where outputs will be stored. 
Select a destination directory without spaces and choose a name for the folder based on your 
project or area of interest 

4. Input DEM: Your DEM, preferably a 3m LiDAR elevation dataset. 
5. Enter your Area of Interest: Click the Add feature icon (#1 circled red in above image), then 

minimize the Define Area of interest window. The cursor should be a cross icon. The add 
feature tool works as a polygon editor, with each click creating a new vertex. The sketch is 
finished by double clicking to connect the first and last sketch vertices. Optionally, the Use 
features from field can be used with a compatible raster or vector file fitting you AOI 

6. Interval for Contours (feet) (optional): Select desired contour foot contours. If left blank, no 
contours will be created 

7. Choose DEM Elevation Units (optional): User preference  
8. Click OK to run tool script. Several new layers will be added to your map 

1 
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1. Open NRCS Engineering Tools > Watershed Tools > Watershed Delineation > 
Create Stream Network 
The Create Stream Network tool serves multiple purposes: it creates a stream network, 
it is used to burn culvert locations, and it creates a hydro-conditioned DEM all within the 
AOI established in the previous Define Area of Interest tool. 

 

2. Select Project_AOI feature: Select the AOI that was created by the previous Define 
Area of Interest tool 

3. Digitize Culverts (optional): Click the Add feature icon (#2 circled in red above) then 
minimize the current window. The add feature function works as a line sketch tool. Use 
the function to make a line that represents a culvert at any obvious or known locations 
where a culvert exists. The DepthGrid layer created by the previous tool Define Area of 
Interest can aid in showing where water backs up at impoundments such as road 
crossings (following figure). Culverts are likely to exist at these locations. Create as 
many digitized culverts as necessary to ensure an accurate stream network representation 

2 
 

16 Identifying Priority Management Zones for BMP Implementation in Impaired Watersheds 

 
 



Digital Terrain Analysis 2014 
 

 
4. Enter Stream Threshold in Acres: This value is the minimum contributing area 

required to form a stream. The default value of 1 is adequate in most situations and will 
form stream headwaters near catchment boundaries 

5. Click OK to run tool script. Several new layers will be added to your map. 
o Note: The hydro-conditioned DEM will be created and called hydroDEM but will 

NOT be automatically added to your map. It is located in an auto-created file 
geodatabase within the workspace you selected in the first Define Area of Interest 
tool.
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• Pit & Sink Filling 
Along with hydro-conditioning, pit filling should also be considered before terrain attribute 
calculations are made. This procedure fills depressions with hypothetical water flow and forces 
drainage to the lowest possible outlet. These depressions can vary considerably in scale from an 
isolated single cell to hundreds of contiguous cells covering well over a thousand acres. The pit-
filling process may not be appropriate for all areas, especially where water is held and evaporated in 
depressions or where extensive tile drainage exists. It is, however, a more conservative approach 
than using a non-filled DEM because it tends to err on the side of overestimating flows (Galzki, et al. 
2011) – SPI signatures created from pit filled DEMs are more analogous to saturation excess runoff 
flow paths produced from large storm events than unsaturated flows. For SPI creation, users may 
generally find filling pits most suitable for steep-sloping landscapes and less suitable for low relief 
areas, though it is highly advisable to experiment with various pit fill Z limits, including a “fill all” 
run and a run with no pit filling. This will allow comparisons to be made among the SPI layers and 
help determine which best represents the landscape. 
For CTI layer creation, a ‘fill all’ routine should be used to accurately depict surface water storage. 
1. Open ArcToolbox > Spatial Analyst Tools > Hydrology > Fill 

 

2. Input surface raster: Your DEM. If you used the NRCS Engineering tools previously, your 
Input surface raster will be hydroDEM for you hydro-conditioned DEM, or [Your workspace 
folder name]_DEM for your non-hydro-conditioned DEM. If you manually created a clipped 
subset of your original DEM, your Input surface raster will be the ‘dem_clip’ layer. To fill the 
tool fields, select layers from the drop‐down, drag the layer to the blank field, or browse to the 
desired layer by clicking on the folder icon left of field. 

3. Output surface raster: Browse to output workspace and name using it something you can 
remember, e.g. 'dem_fill'. It may be useful to add the unit amount used to fill the DEM so that 
users can identify each layer’s Z limit when calculating multiple filled DEMs; e.g. ‘dem_fill1m’ 
or ‘dem_fillall’ 

4. Z limit: The maximum elevation difference between a sink and its pour point to be filled. Units 
will be the same as the DEM’s Z (vertical) axis, typically meters. 
Note: The default, which is achieved by leaving the Z limit field blank, will fill all sinks 
regardless of depth 

5. Click OK to run. The output surface raster is added to your map as a new layer
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• Filter 
At times, LiDAR data expressed in fine‐resolution DEMs can contain either errors or spurious 
features which impede flow analysis and/or other terrain analysis, though these anomalies are 
becoming a non-issue with advancing technology in LiDAR acquisition along with improved quality 
control and assurance deliverables. The filter tool employs a low pass filter using a 3x3 moving 
window to “smooth” the raster and create a more contiguous dataset. Caution should be used when 
filtering, as it essentially ‘dumbs down’ the data by averaging out extreme outliers. Similar to pit 
filling, it is recommended to run terrain analysis with both filtered and non-filtered processes and 
determine which outputs best suit the terrain. The filter tool is typically run after pit filling. 

1. ArcToolbox > Spatial Analyst Tools > Neighborhood > Filter. 

 

2. Input raster: Your DEM. If pit filling was previously used, your Input raster will be 
‘dem_fill’. If pit filling was not used, but clipping was, your Input raster will be ‘dem_clipped’. 
If NRCS tools were used, the Input Raster will be hydroDEM or [Your workspace folder 
name]_DEM 

3. Output raster: Browse to output workspace and name it, e.g. 'dem_filter'. 
4. Filter type (optional): the enhancement to be performed in the filter analysis. 

o Note: The default is "LOW" which is required to do the smoothing we seek. 
5. Click OK to run. 
6. The output raster is added to your map as a new layer.
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Calculate primary attributes 
Primary attributes are derived directly from the DEM. The slope, flow direction, and flow accumulation 
primary attributes will be used to calculate secondary attributes. Many of the other primary attributes 
created here will be used to visualize landscape surfaces and terrain attributes. 
• Slope 

1. ArcToolbox > Spatial Analyst Tools > Surface > Slope 

 
2. Input Raster: Your DEM. If pre-processing was used, this should be the final DEM created, 

such as ‘dem_fill’ or ‘dem_filter’. 
3. Output raster: Browse to output workspace and name output layer ‘slope_dem’. 
4. Output measurement (optional): Select ‘PERCENT_RISE’ 

o Note: It is important for the rest of the analysis that you select PERCENT_RISE, even 
though the data will look the same. 

5. Z factor (optional): For DEMs with vertical (Z) units in meters, type 1, or else leave as default 
6. Click OK to run. The output raster is added to your map as a new layer. 

 
• Aspect 

1. ArcToolbox > Spatial Analyst Tools > Surface > Aspect 

 
2. Input Raster: Your DEM. If pre-processing was used, this should be the final DEM calculated, 

such as ‘dem_fill’ or ‘dem_filter’. 
3. Output raster: Browse to output workspace and name output layer ‘aspect_dem’. 
4. Click OK to run. The output raster is added to your map as a new layer.
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• Plan & Profile Curvature  

Plan curvature is measured perpendicular to the direction of descent and describes converging/diverging flow. It 
is well suited for describing soil water content and characteristics. Profile curvature is measured in the direction 
of maximum descent or aspect direction. It is a measure of flow acceleration and suited for erosion/deposition 
rate and geomorphology visualization.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Image courtesy of Transport Scotland (Harrison et al., 2008) 

 

Plan curvature Profile curvature 
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1. ArcToolbox > Spatial Analyst Tools > Surface > Curvature 
 

 
 

2. Input Raster: Your DEM. If pre-processing was used, this should be the final DEM calculated, 
such as ‘dem_fill’ or ‘dem_filter’. 

3. Output curvature raster: Browse to output workspace and name output layer ‘curve_dem’. 
4. Output profile curve raster: Browse to output workspace and name layer as ‘pro_dem’. 
5. Output plan curve raster: Browse to output workspace and name layer as ‘plan_dem’. 
6. Click OK to run. The 3 output rasters are added to the map as new layers.
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• Hillshade 
The hillshade tool creates a shaded relief layer from a surface raster by considering the illumination 
source angle and shadows. The resulting hillshade raster creates a pseudo 3D display of topography. 

 
1. ArcToolbox > Spatial Analyst Tools > Surface > Hillshade 

 

 
 

2. Input Raster: Your DEM. If pre-processing was used, this should be the final DEM calculated, 
such as ‘dem_fill’ or ‘dem_filter’. 

3. Output raster: Browse to output workspace and name output layer ‘hs_dem’. 
4. Accept defaults for Azimuth and Altitude 

o Note: You can try checking on Model Shadows, it can be helpful in visualization, but in 
some cases it may make little difference. 

5. Z factor (optional): For DEMs with vertical (Z) units in meters, enter 1, or else leave as default 
6. Click OK to run. The output raster is added to your map as a new layer.
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• Flow Direction 
ArcMap’s Flow Direction tool uses a calculation method called the ‘D8’ algorithm. This method is 
well suited to the identification of individual channels, channel networks and basin boundaries 
making it suitable for terrain analysis CSA identification. However, it is based on two simplifying 
assumptions that do not capture the geometry of divergent flow over hillslopes. The two 
simplifications are the use of 8 discrete flow angles, and each pixel has a single flow direction 
(Rivix, 2008). Due to these factors, the ‘D-Infinite’ algorithm was created to overcome D8 
limitations and therefore provide an increased potential to improve terrain analysis results. Several 
software programs exist with dedicated DEM processing offering both D8 and D-Infinite 
calculations (e.g. TauDEM, RichDEM, RiverTools, etc.). The D8 method imbedded in the Flow 
Direction ArcTool is used in this section, though users are encouraged to process DEMs with the D-
Infinite method Flow Direction calculation if available. 

 
1. ArcToolbox > Spatial Analyst Tools > Hydrology > Flow Direction 

 

 
 

2. Input Raster: Your DEM. If pre-processing was used, this should be the final DEM calculated, 
such as ‘dem_fill’ or ‘dem_filter’. 

3. Output flow direction raster: Browse to output workspace and name output layer 
‘flowdir_dem’. 

4. Click OK to run. The output raster is added to your map as a new layer. 
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• Flow Accumulation  
 

1. ArcToolbox > Spatial Analyst Tools > Hydrology > Flow Accumulation 
 

 
 

2. For Input Flow Direction Raster, use the output of Flow Direction from earlier step. If you kept 
the suggested name, it will be ‘flowdir_dem’. 

3. Output accumulation raster: Browse to output workspace and name output layer 
‘flowacc_dem’. 

4. Accept defaults for other parameters. 
5. Click OK to run. The output raster is added to your map as a new layer.
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Calculate secondary attributes 
• SPI  

 
1. Launch the Raster Calculator by clicking on Spatial Analyst Tools > Map Algebra > Raster 

Calculator 
 

 
 

2. Enter formula so the Map Algebra expression looks exactly as follows: Ln(("flowacc_dem" + 
0.001) * (("slope_dem" / 100) + 0.001)) 
o Note: The spaces between operators are required for proper calculation 

3. Output raster: Browse to output workspace and name output layer ‘spi’. 
4. Click OK to run calculation.
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• Compound Topographic Index (CTI)  
 

1. Launch the Raster Calculator by clicking on Spatial Analyst Tools > Map Algebra > Raster 
Calculator 

 

 
 

2. Enter formula so the Map Algebra expression looks exactly like: Ln(("flowacc_dem" + 0.001) / 
(("slope_dem" / 100) + 0.001)) 
o Note: The formula above is the same as the SPI formula with the only difference being the 

division between Flow Accumulation and Slope. 
3. Output raster: Browse to output workspace and name output layer ‘cti’. 
4. Click OK to run calculation.
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Visualizing terrain attributes 
• Terrain Attribute Comparison – Often, the best way to understand differences in terrain attribute 

calculations is to view each layer in conjunction with one another. By paying careful attention to a 
specific portion of the landscape, one can overlay each of the terrain attributes to gain a better 
understanding of the relationships between each attribute. 

• Aerial Photo Comparison - Utilizing aerial photography is a great way to better understand your 
landscape, and it may be possible to validate some of the largest features in your area of interest with 
aerial photos alone. While ground‐truthing is the most effective way to determine the accuracy of 
terrain attribute-based predictions of  CSAs, this is not always possible – especially on 
privately‐owned land. Furthermore, photos when used with flow accumulation and its associated 
secondary terrain attributes, often help in assessing whether or not further hydrologic conditioning is 
required for the task at hand. 

• Swipe function 
1. To display the Effects toolbar, right‐click anywhere in the toolbar and select Effects. 
2. Select the Swipe Tool to "wipe" a layer using a horizontal or vertical line across the screen. 

 
3. Make sure the layer you want to "swipe" is shown in the "Layer:" box. 
4. Click on the map and drag to swipe (do not release mouse button; the mouse must be 

depressed to get the swipe effect). 
 
Example of swipe function: 
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• Symbology for Terrain Attributes 
Often this is a matter of personal preference, but there are a few tips/tricks in display used for 
specific terrain attributes: 

1. Slope ‐ Colormap variations 
2. Flow Accumulation ‐ Visualize upslope contributing area as if it were a watershed boundary. 
3. CTI – Blue/water – display highest values darkest 
4. SPI – Brown/sediment ‐ display highest values darkest 

• SPI/CTI visualization – Once calculated, the SPI and CTI layers are not very informative without 
first removing a majority of the cells that have low erosion (SPI) or ponding (CTI) risk. The layer 
histograms can be used to estimate a threshold for these unwanted values for quick display changes. 
More precise methods for determining how many cells to remove from the layers are discussed in 
the Determining thresholds section on page 36. 
To modify the original SPI and/or CTI layers to display percentile values: 

1. Double click on the layer in the Table of Contents window in ArcMap to open the layer’s 
Properties menu. 

2. In Layer Properties, open the Symbology tab (1). On the right side under ‘Show’ click on 
‘Classified’ (2) and in the classification box click ‘Classify…’ (3). The Classification 
window will open. At this point users can experiment with several different classification 
methods, classes, and threshold values. Keep in mind that any changes made here in Layer 
Property Symbology will not modify the data in anyway; it will only change the way the data 
is displayed in the active ArcMap data frame. 

 

1 

2 

3 
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o The Classes pull down menu allows for the user to select the number of class breaks to be 
calculated using the user defined classification method. Using class breaks between 1 and 
10 should be appropriate for displays. 

o With the classification method, there is no right or wrong method to use, though the 
Quantile and Natural Breaks (Jenks) classification methods often match well with 
signature gradients. ESRI provides the following descriptions for each classification 
method from their ArcGIS Help Resource Center: 
 Equal interval divides the range of attribute values into equal-sized sub-ranges. This 

allows you to specify the number of intervals, and ArcGIS will automatically 
determine the class breaks based on the value range. 

 Defined interval allows you to specify an interval size used to define a series of 
classes with the same value range. 

 With Quantile classification, each class contains an equal number of features. A 
quantile classification is well suited to linearly distributed data. Quantile assigns the 
same number of data values to each class. There are no empty classes or classes with 
too few or too many values. 

 Natural Breaks (Jenks) classes are based on natural groupings inherent in the data. 
Class breaks are identified that best group similar values and that maximize the 
differences between classes. The features are divided into classes whose boundaries 
are set where there are relatively big differences in the data values. 

 The Geometrical Interval classification scheme creates class breaks based on class 
intervals that have a geometrical series. The geometric coefficient in this classifier 
can change once (to its inverse) to optimize the class ranges. The algorithm creates 
geometric intervals by minimizing the sum of squares of the number of elements in 
each class. This ensures that each class range has approximately the same number of 
values with each class and that the change between intervals is fairly consistent. 

 The Standard deviation classification method shows you how much a feature's 
attribute value varies from the mean. Class breaks are created with equal value ranges 
that are a proportion of the standard deviation—usually at intervals of 1, ½, ⅓, or ¼ 
standard deviations using mean values and the standard deviations from the mean. 

o The Data Exclusion option can be used to exclude all data below or above any user 
determined threshold value. 

3. The simplest method for display is to use two classes to represent all signatures over a certain 
threshold. This threshold value is at the users’ discretion, though quantitative methods for 
calculating statistical thresholds are presented in the Determining thresholds section on 
page 36. 
o For the simple method described here, set Classes to ‘2’ and Classification Method to 

‘Manual’ in that order. Two values will display in the Break Values column on right (see 
following figure). For this initial step, click and drag the lower break line to the 
approximate location shown in regards to the background histogram, or place it at the 
break value of ~2. This can be easily fine-tuned later. Click OK. 
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o Back in the Symbology window, there will be two class symbols displayed – one black 
and one white – with the ranges associated with each to their right. The black symbol by 
default will contain all values below the threshold we chose, and the white contains the 
values above. Double-click the white rectangle symbol and a color palette will appear. 
Click any color you prefer that is highly visible, such as ‘Mars Red’. Double-click the 
black rectangle and choose “No Color’ at the top of the palette window. If the layer is 
active, you can click ‘Apply’ the see the changes behind the Layer Properties window 
instantly, otherwise click ‘OK’. 

o Users will likely want to tweak the threshold value used to best represent the surface flow 
paths (SPI) or ponding (CTI) in their area of interest. 
 If the SPI signatures look too crowded or dense (example 1 below), the threshold 

values should be increased incrementally by clicking and dragging the vertical break 
line in the classification window until display results are satisfactory and vice versa 
for sparse SPI populations (example 2). 
Note: The symbol colors will need to be changed again after each classification 
change. 

Ex. 1 

Lower 
break 
value 
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Ex. 2 
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 Treat the CTI layer using the same technique described in the previous step. A proper 
CTI threshold should display areas of impounded water if pit filling was used during 
DEM pre-processing. 
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o Often it is preferable to display SPI and CTI signatures with color gradients that represent 
high and low values within the same signature. For this purpose we can use the 
classification window with more than two classes. 
 Under Classification Method, choose ‘Quantile’ or ‘Natural Breaks (Jenks)’ and 

Classes between 5 and 10 (user preference). 
 We will use the Data Exclusion option to remove all values below a threshold. In the 

Classification window’s Data Exclusion box, click “Exclusion…” 
Under the Value tab, type your desired data exclusion range in the blank. For 
instance, to exclude all values below a threshold value of 2, and a minimum value 
range of -14, you would enter “-14 - 2” (without quotes). The minimum or maximum 
value used can be below or above the true value respectively to ensure full exclusion 
of data in the desired range. 
Note: The range will be displayed in the underlying Classification window in the 
upper right, as Minimum and Maximum 

 Click on the Apply button to see the changes in the underlying window’s histogram to 
ensure it matches your exclusion range. If the results are satisfactory, click OK on 
both windows to return to the Layer Properties window. 
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 In the layer properties window, you can set your preferred color ramp for pixel 
display by clicking on the Color Ramp pull down. It may be best to match the highest 
values with the darkest colors and lowest values with lightest. 

 
 

 As with the two class display approach, you may find that the exclusion range used 
allows too many or too few signatures for display. The method for correction is to 
change the threshold value in the data exclusion range. If the signatures are too 
crowded, increase the threshold value closer to your maximum value, and vice versa. 
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Determining thresholds 
The SPI and CTI raster layers are most useful when displayed at a certain percentage of values above a 
threshold.  The threshold depends mainly on local topography and overall slopes, and there is often a 
range of percentile values that will represent surface features sufficiently. Common thresholds are 
typically between the top 15% of values for flat areas to the top 1% of values for high relief areas. 
 
Using estimation to visualize thresholds was previously described. This section will detail several 
methods for calculating exact percentile values from raster layers. Though not a necessary step for 
locating potential CSAs, the percent of SPI or CTI values displayed should be known to ensure 
consistency among users, or if following SOPs and/or publishing results. Methods for creating 
exportable SPI/CTI raster files with permanently-set thresholds will also be explained in this section. 
 
When determining thresholds, the user must consider the spatial extent of the area being processed, as 
software has limited abilities to process large data sizes. For instance, if using Microsoft Excel, the 
maximum records affect ability to input LiDAR data: 

 
Excel 2003 max records ‐ 65,569 
Excel 2007 max records ‐ 1,048,575 
Statistical Packages – Many around 10 million 

If Excel maximum records become an issue, users may circumvent those limitations by creating random 
samples from the SPI raster at a 95% or better confidence interval. There are also many statistical 
software packages that can readily compute percentiles from large datasets, such as the free to use R 
program (CRAN, http://www.r-project.org/). Since those programs often have a learning curve for even 
basic functioning, using a more familiar program such as Microsoft Excel may be preferable. This 
section focuses on using Excel for threshold calculations. A full explanation on using the R statistical 
software package for percentile calculations is presented in the appendix (see appendix section A.4).
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Calculating thresholds using Excel: 

When using Excel, first consider data size. Using 3m LiDAR derived attributes from an AOI of 
2,332 acres or more will contain too many records to be contained in a single Excel 2007 sheet. As 
mentioned previously, there are ways to circumvent these limitations. Two methods for using Excel 
to calculate thresholds will be described in detail. One will use an exported text file (also known as 
ASCII file) from ArcMap to be opened directly in Excel, while the other method will first use a 
random sample from stream power index values to be opened in Excel.  

• Raster to ASCII method 
1. Launch the Raster to ASCII tool by clicking on Conversion Tools > From Raster > 

Raster to ASCII in ArcToolbox 
 

 
a. Input raster: Your SPI raster layer. 
b. Output ASCII raster file: Any folder location of your choosing. Name the file ‘spi_text’   
c. Click OK to run. 

o Note: If the output text file exceeds 250mb, users should consider proceeding with 
other percentile calculation methods described in this section. 

 
2. Open Microsoft Excel with a blank workbook. 
3. In Excel 2007/2010, choose the Data tab, and click on From Text from the Get External 

Data group (pictured below). 
In Excel 2003 and earlier, navigate to the Data pull down menu and choose > Import 
External Data > Import Data… 
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4. Browse to the saved ‘spi_text’ file created previously and click Import. The Text Import 

Wizard will open. 
5. In the step 1 of 3 window, click the “Delimited” radio button and click Next. 

 
6. In step 2 of 3, under the Delimiters checkbox fields, un-select Tab, check the Space box and 

click Next. 

 
7. In step 3 of 3, leave the fields at default and click Finish. 
8. In the new Import Data window that appears, click OK. 

 
9. The data from the text file is added to your current worksheet. 
10. Notice that the first 6 rows of the sheet are populated with data properties. These should be 

deleted. Move your cursor over the 1st row header until the pointer turns into a right pointing 
arrow        then click and drag down to the 6th row (fig. 2). Once the cells are highlighted, 
right click anywhere in the blue highlighted section and choose delete. Once the header cells 
are deleted, click any cell in the sheet to unselect the highlighted rows. 
o Note: If the following ‘Large Operation’ warning box appears, click OK. 
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11. Many of the cells will contain a value of -9999 which is ArcMap’s default NoData value. All 
cells containing that value will need to be removed as they will affect the percentile 
calculation. The Find and Replace editing tool in Excel can be used for this purpose. 
In Excel 2007/2010, from the Home tab, find the editing group (far right) and click on the 
‘Find & Select’ button and choose ‘Replace…’ (pictured below). The ‘Find and Replace’ 
dialog box will open. 
Excel 2003 users should click the Edit pull down menu, then choose ‘Find…’ Select the 
‘Replace’ tab after the tool opens. 
o Note: The Find and Replace function can be quickly brought up by typing Crtl+F in all 

Excel versions. 
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12. In the Find and Replace dialog box, type ‘-9999’ into the ‘Find what’ field, and leave the 

‘Replace with’ field empty. This will replace all -9999 NoData cells with a blank cell. 

 
 

13. Click ‘Replace All’ to run the operation. 
o Note: During this operation, Excel may become unresponsive. This is normal, and the 

replace function may take several minutes to complete depending on data size. 
 

14. You should receive a notice saying Excel has completed its search. Click OK. 

 
15. To calculate percentiles from the data, we will use the built-in Percentile function. The data 

range will first need to be determined. The easiest way is to click the first cell in the upper-
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right-most corner of the sheet (A1) and type Ctrl+Shift+End. All active cells in the worksheet 
will be highlighted. Make note of the row and column header extents, e.g. ‘A1 to DFM2796’ 
as they will be used for the percentile array. 

16. Click a blank cell anywhere below the highlighted cells, and type ‘=percentile(’ (without 
quotes) and the percentile function will become active with format (array, k). 

17. For array, type in your data range from the previous step as the array using the format ‘top 
left cell:lower right cell’ e.g. ‘A1:DEF200’ then type a comma. 
 

 
 

18. For the k parameter, enter your percentile value, such as .95 for the 95th percentile threshold 
value. Finish the function by ending with a closing parentheses and hit enter. The function 
will calculate the threshold of acceptance value from your original range of SPI or CTI 
values. 
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• Random point method 
1. In ArcGIS 9.x, Open ArcToolbox > Data Management Tools > Feature Class > Tools > 

Create Random Points 
In ArcGIS 10.x, Open ArcToolbox > Data Management Tools > Feature Class > Create 
Random Points  
o Note: The Spatial Analyst or 3D Analyst extension is required to use Create Random 

Points with both ArcView and ArcEditor licenses. 
 

 

42 Identifying Priority Management Zones for BMP Implementation in Impaired Watersheds 

 
 



Digital Terrain Analysis 2014 
 

a. Output Location: Choose a geodatabase workspace as the output location. The Random 
Point tool requires an existing geodatabase, either file or personal, for output 
compatibility. Folders will not be accepted by this tool. 

b. Output Point Feature Class: Name the output file ‘random_points’ 
c. Constraining Feature Class (optional): This is the boundary of your SPI and/or CTI 

layer(s). It must be vector format (shapefile, coverage, or feature class). It is often easiest 
to use the same Output Extent vector layer when clipping the original DEM to your area 
of interest. If clipping was not used, a polygon can be created around your SPI layer for 
use as the Constraining Feature Class. 

d. Number of Points [value or field] (optional): Click the radio button next to Long, and 
use the blank to input the desired number of random points. Users should create enough 
sample points from the population size to ensure at least a 95% confidence interval with a 
1% margin of error. Table 1 can be used to this purpose. 
o Note: For determining population size of your SPI raster, see appendix section A.5. 

e. Leave the rest of the fields as default and click OK to run. The output feature class is 
added to your map as a new layer. 
 

2. Open ArcToolbox > Spatial Analyst Tools > Extraction > Extract Values to Points 
 

 
a. Input point features: Your ‘random_points’ layer created in previous step. 
b. Input raster: Your SPI or CTI raster layer. 
c. Output point features: Browse to output workspace and name output layer 

‘random_spi’ 
d. Click OK to run. The output shapefile is added to your map as a new layer. 
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Table 1 
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3. Microsoft Excel cannot open the .dbf file format so the ‘random_points’ shapefile’s table will 
need to be exported as a text (ASCII) file. 
a. Right click on the new ‘random_spi’ layer in the table on contents window, and choose 

‘Open Attribute Table’ 
b. Click the upper left pull down menu button (table options) and choose the ‘Export…’ 

option. 

 

c. In the Export Data window, click on the browse button to the right of the ‘Output 
table’ field. 

d. Save the file in a folder (not a geodatabase), naming it spi_points.txt or cti_points.txt. 
Make sure to save the file as Text File under the ‘Save as type’ pull down and click Save 
(fig. 3). 

e. Back in the Export Data window, make sure ‘All Records’ is selected in the Export pull 
down, and click OK. 

f. When the process has completed, you can select No when prompted to add to the current 
map. 
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4. Open Microsoft Excel with a blank workbook. 
a. In Excel 2007/2010, choose the Data tab, and click on From Text from the Get 

External Data group (pictured below). 
In Excel 2003 and earlier, navigate to the Data pull down menu and choose > Import 
External Data > Import Data… 

 
 

b. Browse to the saved text file created in the steps above and click Import and the Text 
Import Wizard will open. 

c. In the step 1 of 3 window, click the “Delimited” radio button and click Next. 
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d. In step 2 of 3, under the Delimiters checkbox fields, un-select Tab, and check the Comma 
box and click Next. 

 
e. In step 3 of 3, leave the fields at default and click Finish. 
f. In the new Import Data window that appears, click OK. 

 
g. The data from the text file is added to your current worksheet. 

 
5. Several columns may be currently displayed in the Excel worksheet – we are only interested 

in the column named RASTERVALU. We will now calculate the threshold value using the 
percentile function in Excel. 
a. Click on a blank cell in the sheet and type ‘=percentile(’ (without quotes) and the 

percentile function will become active with format (array, k). 

 
 

b. For array, select all cells in the column named ‘RASTERVALU’ by clicking on the 
alphabetic character above that column, then type a comma. 
o Note: Including the cell with the text ‘RASTERVALU’ in the array will not affect 

the percentile calculation. 
c. For the k parameter, enter your percentile value such as .95 for the 95th percentile 

threshold value. Finish the function by ending with a closing parentheses and hit enter. 
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The function will calculate the threshold of acceptance value from your original range of 
SPI or CTI values. 
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Rank secondary attributes 
Once the percentile thresholds are known, they can be used with the SPI and CTI layers in ArcMap. The 
percentile values will be used to display all cell pixels above those thresholds. If additional display detail 
is desired, those cells can then be further ranked with color gradients using reclassification techniques. 
Refer to the Visualize terrain attributes ‘SPI visualization’ section on page 28 for detailed instructions 
on when to use those percentile thresholds. 
 
Often, it is desirable to have multiple SPI layers each set to display different percentiles. For this 
purpose, separate SPI or CTI raster layers can be created each with permanently set percentile thresholds 
by using the Reclassify tool. 

a. In ArcMap, open ArcToolbox > Spatial Analyst Tools > Reclass > Reclassify 

 
b. Input raster: Your original SPI or CTI layer. 
c. Reclass field: This should default to “Value” 
d. The Reclassification is done using the same procedure as outlined previously and initiated 

by clicking the “Classify…” button. 
o Note: Make sure to use your desired threshold value in the data exclusion range. 

e. Output raster: Browse to output workspace and name output layer spi or cti followed by the 
percentile threshold used, e.g. “spi_95” 

f. Check the box next to Change missing values to NoData (optional). 
g. Click OK to run. The output raster is added to your map as a new layer. 

o Note: You may have to enter Layer Properties and set the new SPI or CTI layer’s 
symbology to “Stretched” for a smooth display color gradient.
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Locate potential CSAs 
The data acquired earlier will now be used to assist in CSA placement. 

1. Start a new ArcMap session with a blank map. Start populating your map with a base layer 
consisting of orthophoto(s) from the area of interest and the data layers collected in the Data 
Acquisition section. The layers in the table of contents should be generally organized so that 
orthophotos are on bottom, followed by raster layers, then polygon, polyline, and point vectors 
layers on top in that order. 
o Note: Some layers may benefit from using lowered display transparencies, such as the hillshade 

layer. This will allow base layers to still be visible. Layer transparency can be adjusted through 
the effects toolbar (1) or the layer properties display tab (2). 

 

 

2. Create a new point shapefile or feature class to use for CSA placement. 
a. To create a new shapefile, open ArcCatalog either though ArcMap (version 10.x) or the separate 

ArcCatalog application. 
b. Browse to your preferred workspace folder or geodatabase using the catalog tree, right-click on 

your folder and select New, then “Shapefile…”, or right-click on your geodatabase and select 
New then “Feature Class…” The Create New Shapefile or New Feature Class window will 
open. 

2 

1 
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o Create New Shapefile: Choose a name for the shapefile, such as “CSA points”. Make sure 
‘Feature Type’ is set to Point. You should set the spatial reference to match the spatial 
coordinate system used in your other data layers. For data acquired from many Minnesota 
government sources, including Minnesota Department of Natural Resources (MDNR) and 
MNGeo, the coordinate system used will often be “NAD 1983 UTM Zone 15N” but could 
differ, including UTM Zone 14N or 16N if using data from the far eastern or western parts of 
the state. Figure 1 shows Minnesota UTM zone grids, with zone numbers circled in red. 
An easy way to select the coordinate system is to use the Import option. From the Create 
New Shapefile window, click the ‘Edit…’ button in the Spatial Reference box. The Spatial 
Reference Properties window will open. Click the ‘Import…’ button. Browse to any vector 
of raster file currently being used in your active ArcMap session, select it and click Add. The 
coordinate system should be the North American Datum 1983 UTM system. Click OK. Back 
in the Create New Shapefile window, click OK and the new shapefile will be added to your 
chosen folder. 
• Note: When importing coordinate systems, some layers may not have spatial references 

set. ArcMap will still display those layers by automatically using the first coordinate 
system seen in the active data frame. 

o OR create New Feature Class: Choose a Name and Alias for the new feature class. The 
Name must not have spaces – instead use underscores for spaces. The Alias can contain 
spaces. In the Type pull down menu, select ‘Point Features’.  Click ‘Next >’. The second step 
involves choosing a coordinate system for the new Feature Class. Follow the steps from the 
Create New Shapefile process above using the ‘Import…’ button to select NAD 1983 UTM 
system. Click ‘Next >’ on the next three windows to create the new feature class. 

c. Add the new shapefile or feature class to your active ArcMap session by either dragging the file 
from ArcCatalog onto the map, or using the Add Data button. 

d. Before new points can be placed, an editing session must be started. Right click on the new 
shapefile or feature class point layer and choose ‘Edit Features’ then ‘Start Editing’. If a window 
appears with warnings, click Continue. You are now able to place new points on the map using 
the editing functions. 
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Figure 1 
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CSA Placement and Prioritization 
 
CSAs are defined as portions of the landscape that combine high pollutant loading with a high propensity to 
deliver runoff to surface waters, either by an overland flow path or by sub-surface drainage. These areas 
have a higher likelihood of conveying more pollutants to surface waters than other portions of the landscape 
and thus coincide well with high SPI value characteristics. Features that could be associated with CSAs 
include culverts, drop structures, gullies, ravines, grassed waterways, bank slumping and erosion, in-stream 
vehicle/livestock crossings, tile drain outlets and side-inlets, exposed tile, and open intakes. CSA features 
can be placed anywhere on the landscape but users should focus targeting efforts to specific areas, 
depending on project goals. 

 
A set of criteria were developed that facilitates systematic assessment of the factors involved in critical area 
identification. The ideal criteria incorporate the inherent characteristics associated with SPI, efficiency of 
the hydrologic system in pollutant transport, magnitude of the source, and type of pollutant into guidelines 
that can be applied throughout the watershed. Critical area criteria should be applied consistently throughout 
the project watershed. This ensures that the study area does not receive biased identification and also that 
landowners do not feel singled out or excluded from the selection process depending on whether areas of 
their land met the criteria or not (Line & Spooner, 1995). 
 
Criteria for placement and prioritization of CSAs include: 

• Magnitude of the pollutant source and risk for erosion 
o Contributing area 
o Average and/or maximum SPI values 
o SPI signature length 

• Hydraulic transport of pollutants and proximity to the water resource  
• Land use/land cover/land management 
• Subwatershed soil characteristics 
• Existing conservation practices 
• Crop productivity indices 

 
Terrain analysis users should select these CSA sites for field visits and evaluation based on: 

• GIS analysis results 
• In-house knowledge 
• Available resources (e.g., funding, staff time, etc.) 

 
Time commitments should be factored in when determining how many points to place, as creating a 
potential CSA at each hydrologically connected SPI signature could involve substantial validation time 
spent in the field. It may be preferable to only place CSAs at the locations where signature lengths are 
longest and in close proximity to surface water, the average SPI signature(s) value is high, no BMPs exist, 
and soil characteristics show high potential risk for soil erosion. It is also important to note any regional-
specific factors that may exist in the area of interest, such as sinkholes, feedlots and/or cattle grazing 
operations, and their proximity and contribution to any potential CSAs.

53 Identifying Priority Management Zones for BMP Implementation in Impaired Watersheds 

 
 



Digital Terrain Analysis 2014 
 

1. Using your orthophoto and surface water layers in ArcMap, activate the SPI layer previously set 
with your desired threshold display, then zoom into your area of interest. The SPI signatures should 
resemble surface runoff flow paths in the following maps. 

 

 

 
The above images depict how an SPI signature can be visualized as a flow path. The arrows represent flow 

direction 

54 Identifying Priority Management Zones for BMP Implementation in Impaired Watersheds 

 
 



Digital Terrain Analysis 2014 
 

 
2. The following metrics should be considered for each potential CSA. They are not listed in order of 

importance – the weight of each metric should be tailored to fit your project goals. 
• Identification by aerial photography – High resolution orthorectified aerial photos play an 

important role in the CSA identification process. The orthorectification process geometrically 
corrects aerial imagery such that the scale of the image is uniform. In GIS, orthophotos help 
match SPI and CTI signatures to physical features on the landscape. Though some large features 
can be identified using only aerial photos, they are most useful when overlain with SPI or CTI 
signatures. The layers can then be turned on and off for photo comparisons, or the swipe function 
can be used for the same purpose. When land cover type cannot be distinguished from aerial 
photography, land cover/land use layers can be used with the swipe function in a similar fashion. 

 
If multiple aerial photos are available for your area of interest, consider date, time of year, and 
surface moisture conditions present at the time of photo acquisition. Common orthophotos 
available from Minnesota Geospatial Information Office include Spring, Summer and Fall series. 
The most recently available leaf-off imagery taken during Springtime is often most preferable for 
CSA identification, as soil moisture and areas prone to ponding are most evident, and surface 
erosional features have not yet been worked through in the field. 
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The first image (previous page) is an orthophoto taken in the spring of 
2011 with several gullies evident, followed by the same photo with an SPI 
layer overlain (above). The SPI signatures closely match the surface erosion 
where flows concentrate. Note the white arrows highlight differences 
between apparent erosion on the photo vs SPI signatures, likely explained 
by the gap between date of LiDAR flown (11/27/2008) and aerial photo 
acquisition (mid-April, 2011). 
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• Signature length – SPI signature lengths are representative of their associated contributing areas. 
Longer SPI signatures will typically have larger upland contributing areas and therefore 
increased risk of sediment and nutrient load conveyance. The length should be considered in 
relation to other signatures in close proximity in order to ignore threshold bias. Slope must also 
be considered in relation to signature length, as short signatures occurring over an area of high 
relief can exhibit considerable surface erosion vs. a short signature over flat topography. 
• Note:  Signature lengths can be easily calculated when using line vector data in lieu of a 

raster SPI dataset [see Average SPI value metric below]. 

 

 
 

• Average SPI value – The portions of a signature with the highest SPI values have the greatest 
potential to erode the landscape. The overall SPI value of a signature flow path can be visualized 
using a smoothed or “stretched” color gradient. 
• Note: Advanced GIS users may prefer a quantitative approach over this qualitative visualized 

one by converting a reclassed SPI raster to polyline vector data. Individual SPI statistics can 
then be calculated for each signature. The mean, minimum, maximum, sum, and standard 
deviation can be particularly useful for prioritization purposes. Signature length can also be 
easily calculated if using line vectors. 
 
 

The figure on left shows differences between 
signatures of different average SPI values. 
The signature on the bottom has a noticeably 
higher overall SPI value than the top three 
signatures. 
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• Contributing area – The contributing area 
upland of CSAs can be used to estimate the 
amount of potential sediment and nutrient 
delivery at those pour points. Contributing 
areas can be manually created by “heads-up” 
digitization using elevation contours, or by 
using third party software to automatically 
create catchments. A free-to-use ArcToolbox 
set is available from the NRCS named ‘NRCS 
GIS Engineering Tools v1.17’ which allows 
creation of contributing area catchments from 
a user defined point (along with many other 
great scripts). The image on right shows an 
example of the NRCS tool’s Watershed 
Delineation toolset over an SPI layer and 
orthophoto. The acres and average slope are 
automatically calculated as shown. 
 
See Appendix section A.6 for step-by-step 
instructions for watershed creation using the 
NCRS tool. 

• Land use/land cover – land cover information 
can aid initial large-scale screenings for CSAs 
and be used to filter out use-types that are of 
low priority. Historical land use information 
combined with historic aerial photos can also 
be a great asset for checking crop rotation 
practices at the field scale. For instance, 
priorities can be targeted to fields identified as 
implementing several sequential seasons of 
continuous corn. 
 
The image on left shows land cover in several 
colors – brown/cultivated crop; green/forest; 
white/grassland; and blue/water. In this example, 
the three SPI signatures advancing into the 
cropland may be of higher priority than the 
surrounding signatures confined to forestland. 
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• Proximity to water – Signatures that terminate in or near surface waters are typically of highest 
concern, though the exact location of the CSA point placement may vary depending on project 
goals. For instance, if agricultural funds are to be used to install BMPs in upland areas, users 
might only target upland field SPI signatures and place points at field edges, whereas TMDL 
concerns may shift user focus to riparian areas and signatures entering waterways. 
o Note: Advanced users may wish to create an SPI layer clipped from a stream corridor buffer 

for riparian-only CSA identification, and vice versa for upland-only identification. 

 
 
 

• Existing conservation – Conservation practices (CPs) may already exist that address potential 
CSAs, some of which may be evident using high resolution aerial photos. Local knowledge of 
existing best management practices and conditions should be used when locating CSAs. It should 
be noted that the presence of CPs shouldn’t necessarily eliminate the placement of a CSA point 
unless the condition of the practice is known.  All CPs have a useful lifespan, and their condition 
cannot always be ascertained from GIS and remotely sensed data. 

  

The three images, starting 
from the furthest left, show 
an SPI signature leading to an 
intermittent stream. The 
middle image shows 
conservation practices exist 
under the SPI signature, in 
this case a grassed waterway. 
Using CIR orthophotos, 
shown in the right image, can 
also greatly aid in detecting 
vegetated areas. CIR photos 
show vegetation as red and 
bare soil as green color. 

The grey horizontal lines represent the 
extent of the stream buffer. The top 
signature terminates at the buffer-field 
edge. The lower signatures terminate at the 
stream edge. Note: the bottom middle 
signature terminates just past the buffer. A 
field visit verified a steep knick point drop to 
water level at the signature terminus. 
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• Sub-catchment soil characteristics – A Soil Erosion Risk raster layer can be used to display soils 
that are of high risk for sheet and rill erosion. The raster layer is available as part of the 
Minnesota EBI series from the BWSR website (see ‘Data acquisition’ section on page 9 for link). 
Based on the USLE, the 30 meter spatial resolution raster was calculated using rainfall erosivity 
(R), soil erodibility (K), and topographic length and slope factors (LS). The cropping 
management (C) and conservation practice (P) factors were omitted (CP=1) as they would 
warrant field specific data that is not readily available. 
The Soil Erosion Risk raster layer, much like SPI/CTI layer(s), is most useful when displayed 
with values above a certain threshold. These can be created in the same manner as the percentile 
thresholds calculated previously with SPI and/or CTI layers. Common thresholds used to display 
areas of elevated soil erosion risk can range from the top 30% of values and up, though with 
inherent USLE factor and source data variability, users may find useful thresholds significantly 
below that range. 

        
      

        
       

       
  

The hillshade layer can aid 
in locating existing 
topological conservation 
practice features, such as 
the water and sediment 
control basin pictured 
above and middle. These 
features can be hard if not 
impossible to spot with 
just aerial photos and SPI 
signatures (far left image). 

 

The image on left shows a series of small SPI 
signatures originating in an upland cultivated 
crop field. The large, tan colored shape 
represents the top 15% of the Soil Erosion 
Risk values (30 meter pixels) within the 
Pelican Lake HUC12 catchment (Stearns Co., 
MN). A field visit confirmed slight erosion 
occurring from the signature nearest the 
high Soil Erosion Risk percentile values 
(circled in white). 
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• SSURGO soils data – The NRCS SSURGO is a large collection of soil-related data that 
can be used to inform CSA identification. The SSURGO nationwide database contains a 
multitude of information sorted within unique soil map units. SSURGO data can also be 
integrated within the ArcGIS environment by use of the NRCS Soil Data Viewer 
extension which provides the ability to visually map each individual criterion with 
matching attributes. Available data range from physical soil properties to construction, 
development, and planning suitabilities (see next image). Several criteria within the 
database can be of particular use for CSA identification, including depth to water table, 
ponding and flooding frequency, crop productivity index, drainage class, and hydric 
rating, among others. 
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3. When suitable locations have been identified for CSA placement, start editing on your CSA point 
shapefile/feature class. 
• ArcGIS ver. 9.x: Using the editor toolbar: 

 

 
 
Set the Task pull down to “Create New Features” and the Target to your CSA point layer. Use 
the Sketch function (the pencil-shaped icon) to place a single geographic CSA point on the map 
with each click. 
Note: You can use the Undo button or press Ctrl+Z to remove the last point placed while editing. 
 
 

• ArcGIS ver. 10.x: Start an editing session with the CSA point layer and the Create Features 
window will open. Select the CSA point layer in the Create Feature window. At the bottom of 
the window under Construction Tools, click the Point button. 
 

 
 
The cursor will turn into a point editor, and each click on the map will place a geographical point 
at that location. 
 
 

4. When finished creating new features, save your edits, and stop editing using the Editor toolbar pull 
down menu. 
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CSA output and evaluation 
Once the CSA point layer has been completed, it can be used to create physical and digital maps, and 
exported into a variety of mobile devices to guide field work. Common mobile devices include: 
 

• Tablets with ArcGIS for Windows Mobile installed (one mobile deployment license is included 
with each ArcGIS Desktop license) 

• iPad with ArcGIS free app 
• Handheld Global Positioning System (GPS) units with a Windows mobile operating system 

installed 

 

The following Field Assessment section can aid in data collection and evaluation during field visits. An 
overall determination of site status at each CSA should be made,  for example: 

• Where appropriate conservation measures are in place, recognize good site management 
• Where improvements could be made, suggest possible conservation measures 
• Where CSA tools were in error, record the findings (tracking errors will improve both the GIS 

protocols and a GIS professional’s judgment that is required during evaluation) 
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Field Assessment 
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Field Assessment 

The process described herein will provide guidance for walking the user through the various 
steps associated with applying terrain analysis and other spatial analyses to identify PMZs and 
CSAs. This process incorporates a GIS analysis to inform field assessments. The GIS analysis is 
not intended to replace on-site field assessments, but rather to supplement those efforts. Spatial 
analyses can be used to help identify potential high-priority sites, based on their vulnerability to 
erosion and other characteristics that potentially impact water quality. The GIS assessment 
results can enhance data collection efforts and reduce the amount of time spent in the field. 

This section is intended to provide a big-picture view of the procedures and decisions that can be 
used when applying a GIS analysis to identify sites that potentially are a high-priority for 
conservation. The guidance builds upon the sections that describe suggested procedures for 
conducting the digital terrain analyses and performing the field assessments. These sections will 
be referenced during the relevant process steps. 

The organization of this guidance follows the steps in the decision tree on the following page. 
The first step involves identifying specific management objectives and the intended purpose of 
the spatial analysis. During this step, the conservation technician will identify whether the 
pollutant of concern is sediment, phosphorus, or both. Although the decision tree only directly 
addresses erosion concerns, the individual steps describe how to incorporate phosphorus. Steps 2 
through 4 involve creating and refining the list of potentially sensitive sites based in part on the 
selected GIS results, as well as office knowledge of the local setting. This is followed by steps 5 
through 9, which involve reaching out to landowners, scheduling site visits, performing field 
assessments, identifying potential concerns that impact water quality, and identifying appropriate 
management practices. The final steps – 10 and 11 – involve adjusting and updating the list of 
potentially sensitive sites based on information gathered in the field, as well as updated spatial 
analyses. 
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Decision Tree 
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Process Flow 
1 Determine objectives and select tools 

• Determine management objectives (PMZ and CSA) 
• Identify pollutant(s) of concern 
• Select spatial analysis tools that fit with identified objectives 

2 Use Spatial Analysis to Select and Prioritize Sensitive Sites 
• Run selected tools 
• Use analysis results to identify high-priority sites 

3 Create Sensitive Site List 
• Determine an appropriate number of sites to select for further examination 
• Base the list length on management objectives and available resources 
• Determine the number of sites that can be visited each year 
• Populate site list using highest-ranked sites from terrain analysis results 

4 Adjust List Based on Office Knowledge 
• Review site list for obvious errors in spatial analysis results 
• Move sites with known management practices that address issues to Acknowledgement List 

5 Work with Local Stakeholders for Information and Access 
• Reach out to local producers to share project goals 
• Gather information on site practices to refine target list 
• Identify producers who are willing to allow site access 

6 Schedule Site Visit Rotation 
• Work with producers to schedule site access (only portion of sites will be visited each year) 
• Establish a longer-term rotation for re-visiting sites 

7 Visit Sites Selected for Given Year 
• Conduct assessments of the identified sites 
• Ensure assessor has permission to access site prior to conducting examinations 

8 Complete Upland Field and Channel Forms 
• Record the findings on the assessment protocol forms, communicating institutional memory 
• Compare field assessments to spatial analysis results 

9 Are Erosion Concerns Present? 
• Use field assessment to identify presence of erosion concerns 
• Note whether concerns are being addressed by management practices  

10 Generate Acknowledgement and Issue Lists 
• Place well-maintained fields on acknowledgement list 
• Place fields in need of additional management practices on list of concerns 
• Work with landowners to increase management on sites of concern 
• Maintain master list that includes sites of concern and acknowledgement sites 

11 Update Spatial Analysis for Sensitive Sites 
• Revisit sensitive site list periodically 
• Add new priority sites as other sites move to acknowledgement list 
• Conduct new spatial analyses as necessary to update priority site identification 
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Determine objectives and select tools 
During this initial step, the conservation technician should identify the management objectives 
that can be assisted by the spatial analyses described in this guidance. These objectives will 
influence selection of the pollutant parameter(s) of concern in the watershed and influence the 
application of spatial analysis tools (explained in more detail in step 9). If the management 
objectives involve addressing excessive nutrient loading, both sediment and phosphorus should 
be selected as pollutant parameters of concern. Alternatively, for sediment and turbidity 
management the conservation technician could select sediment as the sole parameter of concern.  

The pollutant parameter(s) of concern will inform the determination of which spatial analysis 
procedure is conducted (Figure 2). 

 

Figure 2. The selection of the pollutant parameter of concern determines the spatial analysis performed. 
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If the pollutant parameter of concern is phosphorus, the spatial analyses conducted will involve 
both a bare soil USLE and terrain analysis to calculate SPI. If the pollutant parameter of concern 
is sediment, the conservation technician might opt to only conduct a spatial analysis of USLE 
and proximity to streams. However, this decision should take into account knowledge of the 
local setting. If gullies are present in the watershed, the spatial analysis should also incorporate 
an SPI analysis. A ravine script should be added if ravines exist in the area of interest. For flat 
landscapes, the USLE spatial analysis might not provide much additional information. This 
assessment is most informative where slopes are greater than two percent. It should be noted that 
the USLE applied for this process is for bare soil and does not incorporate cover or practice 
factors.  

Additional points for consideration when determining whether the SPI terrain analysis should be 
conducted to evaluate sediment concerns are provided in the following inset box. 

 

The conservation technician also should incorporate other existing data to select an appropriate 
scale for the spatial analysis that targets specific regions of concern. This approach will help 
narrow the focus of the analysis to a manageable area. Running an analysis on a large hydrologic 
unit potentially will identify more high-priority sites than can be effectively managed, given the 
available resources. In addition, if management objectives include measuring water quality 
improvement in stream, then implementing a few sites within a large scale watershed will likely 
not result in measurable concentration or load reduction improvements in the river or stream 

Assessing SPI as a Tool for Sediment Management: 

• Gather local knowledge and information regarding the magnitude and/or history of 
the presence of gullies in the watershed. The extent of past implementation of 
grassed waterways, terraces, and contour farming provides a strong indicator of 
whether gullies were or are an issue. 

• Consider the potential that ephemeral gullies have been masked by plowing or 
perennial vegetation. 

• Apply these considerations to inform decisions regarding whether the SPI terrain 
analysis will provide beneficial indicators of potentially larger channelized flow 
paths that could result in gully sites or masked ephemeral gullies. 

• Also consider the potential for using the SPI results to start a dialogue with 
producers about the likely areas where ephemeral gullies might be appearing on 
their land. 
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itself. Based on these concerns, it is suggested that the technician consider whether it is 
appropriate to scale down the GIS spatial analysis to a high-priority subwatershed. Selection of 
this subwatershed could be based on the extent of impaired waters, evaluation of monitoring 
data, or other conservation management objectives, such as critical habitat areas. 

Additional tools also could be incorporated into the analysis to select high-priority sites. For 
example, additional spatial analyses could include assessing livestock animal density or 
identifying wetland restoration potential. Conservation technicians may incorporate any other 
assessments that are conducted for specific watershed management objectives. However, steps 
for incorporating these additional options are not included in this protocol. 

Use Spatial Analysis to Select and Prioritize Sensitive Sites 
During this step, the technician performs the spatial analyses needed to identify potentially 
sensitive sites. The specific analyses that are conducted will depend on the pollutant parameters 
of concern identified in step 1. This step applies the procedures outlined in the Digital Terrain 
Analysis Section. To conduct the spatial analyses, the following process should be followed: 

• Acquire necessary data  
• Prepare data for analysis 
• Run selected tools based on the management objectives identified in step 1 

o USLE 
o SPI 

• Use analysis results to identify high-priority sites 

When generating the spatial analysis results, the technician should keep in mind that some 
agricultural fields that drain through naturally vegetated zones might have two points at which 
the delivery of eroded materials might be of concern. Suggested guidance for addressing each of 
these delivery points is provided in step 8. 

Create Sensitive Site List 
The sensitive site list should be created using the spatial analysis results that identify the high-
priority sites. The length of the list should reflect an appropriate number of sites that can be 
selected for assessment. It should be noted that not all sites on the list will be visited each year. 
Rather, a site visit rotation will be established (step 7). As such, the length of the list should be 
determined based on the total number of sites that can be assessed during the multi-year rotation. 
Considerations for determining the length include management objectives and available 
resources. The list can be adjusted later if these factors change. 

Adjust List Based on Office Knowledge 
In this step, the sensitive site prioritization list should be adjusted based on office knowledge of 
the specific sites. The list should be reviewed for potential errors in the spatial analysis results. 
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Identification of these errors can be informed by comparisons with recently collected data and 
other site information, such as recently implemented projects. Sites can be removed from the 
prioritization list, as appropriate. However, it should be noted that these sites are only removed 
from the prioritization list used to schedule site visits. All sites should be maintained on a master 
database list. The process for adjusting the site list is illustrated in Figure 3. 

 

Figure 3. Process for adjusting sensitive site prioritization list. 
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The site prioritization list can be adjusted for several reasons. Sites can be removed from the 
prioritization list (but maintained on the master list) if office knowledge confirms these locations 
are not issues. For example, the SPI results could indicate false positives. This could occur for 
several reasons, including if the site has tile drainage. In this case, the site is not experiencing the 
overland flow indicated by SPI. However, a technician still might choose to visit these sites if the 
tile outlets could be a concern or if other potential issues might exist. Another potential cause of 
a false positive result could involve the presence of a culvert. The digital elevation data might 
view roads as a dams or berms if the data are not hydrologically conditioned.  In these 
circumstances the SPI will not account for the channel flowing beneath the road. Likewise, the 
conservation technician should be aware that the spatial analysis also could miss some high-
priority sites. These “false negatives” would not show up in the analysis results. This could 
occur, in part, due to the hydrologic conditioning performed on the digital elevation data. The pit 
filling procedure conducted when preparing the data for analysis can alter the results of the SPI 
terrain analysis. If pit filling overly flattens areas, a portion of the flow from the contributing area 
might be redirected along other pathways. This could result in less of the contributing area being 
associated with the SPI ranking and therefore the SPI terrain analysis results would artificially 
indicate the site was a lower priority. Likewise, insufficient pit filling could treat an area as 
landlocked when it is frequently connected.  

Sites can be removed from the prioritization list if these sites have known management practices 
that address issues. These sites should be moved to the “Acknowledgement List,” which can be 
used to recognize producers for their conservation management efforts.  

Work with Local Stakeholders for Information and Access 
During this step, conservation technicians should reach out to local producers in order to gain 
information and permission to access sites on the prioritization list. This outreach involves 
communicating project goals and what a site visit would entail. Guidance and/or considerations 
for initiating contact is provided by a suggested script (Appendix A.7). This script can be 
considered by the office supervisors or managers, but it is not necessary to follow the language 
specifically. After the initial contact, it is recommended that the conservation technician send 
letters and follow-up with phone calls. 

The results of the stakeholder outreach will determine which sites can be visited for field 
assessments. Producers willing to allow site access should be identified. If access is denied, the 
prioritization list should be refined. Any sites removed from the list due to the lack of access 
should be maintained on the master database list. 

Schedule Site Visit Rotations 
A site visit rotation is recommended to schedule field assessments. Limited resources might 
restrict efforts in that only a portion of the sites on the prioritization list can be visited within a 
given year. The number of priority sites selected for evaluations can be adjusted to accommodate 
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available office resources. In this way, a manageable distribution of sites over several years can 
be planned.  

The process for scheduling the rotation is as follows: 

• Determine the number of sites that can be visited each year 
o Based on available resources 
o Staff time 

• Establish a rotation for re-visiting sites 
o Revisit sites on a regular time period (i.e. 5 years) 
o Based on available resources 

If sites identified through the spatial analysis overlap with farms that are already on a staff’s 
visitation schedule for other conservation program efforts, these sites could be moved up in 
priority. The list of prioritized sensitive sites does not have to be visited in the ranking order as 
they might appear on a list; rather, prioritization can be based on multiple objectives, including 
managing of office activities.  

Two separate site rotation schedules also should be considered. The first is the initial assessment 
of sensitive sites. The second site visit rotation involves follow-up visits to sites identified as 
high priority. This includes sites with water quality concerns, as well as sites where conservation 
measures were in place to address the sensitive issues. Long-term confirmation of site 
performance is recommended to track BMP conditions and/or land use cover in order to validate 
protection remains in place.  

Visit Sites Selected for Given Year 
During this step, sites are visited for conducted field assessments. The process for visiting sites is 
as follows: 

• Schedule site visits for the current assessment season 
• Ensure assessor has permission to access site prior to conducting examinations 
• Keep open communications with the producer regarding visit date and number of 

assessors 
• Visit the sites scheduled for that season 
• Conduct the field assessment (detail provided in step 8) 

Complete Field Assessment Forms 
During this step, the field technician should complete the site assessment forms. Additional 
detail regarding conducting field assessments is provided in the following sections. The chosen 
field assessments and associated forms were developed and refined based on field testing and 
feedback received from the project partners as a part of this project (see Appendix A.8).  
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The field assessments conducted include: 

Upland Field and Channel Assessment Worksheet 

This worksheet is used to record general site information. In addition, the technician documents 
field features using an aerial photograph, as well as a land use / Ag field characteristics form. 
The technician also walks the channel and completes a channel characteristics form and adapted 
Technical Note 99 form. While walking the channel, the technician also notes pour points and 
completes the pour point form. This pour point assessment should address all points at which 
eroded materials might be delivered to a resource of concern, or a change in management 
objectives. For example, a field that drains through a wooded buffer might have a pour point 
where the flow leaves the field as well as where the flow enters the channel. The pour point 
forms provide a method for documenting the various characteristics that might be encountered. 

Minnesota Rapid Phosphorus Index Form 

This form provides the necessary information for performing the Minnesota Rapid P-Index 
assessment. These data are used to identify indicators of phosphorus runoff risk. Identified issues 
then are discussed with producers to determine potential conservation management options. A 
list of identified potential BMPs that could address the phosphorus risk indicators used by the P-
Index is provided in the Rapid P-Index Screening Tool Table. 

Streambank Erosion Assessment Form 

This form is used when streambank erosion is observed. It is a qualitative assessment to 
document indicators of erosion. Erosion information collected about multiple sites can be 
combined and used to inform later watershed management initiatives regarding bank 
stabilization or pollutant loading estimation projects.  

Are Erosion Concerns Present? 
Use the results of the field assessments to identify the presence of erosion concerns. Also note 
whether concerns are being addressed by management practices. If erosions concerns are present, 
work with producers to address these issues. If erosion concerns are not present, acknowledge 
the producer for conservation management efforts (move the site to the “Acknowledgement 
List”). 

The process for assessing erosion will depend on whether the identified pollutant parameter is 
sediment and/or phosphorus. The process for phosphorus is depicted in Figure 4 and the process 
for sediment is depicted in Figure 5. 
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Figure 4. Process flow for assessing erosion concerns associated with phosphorus. 
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Figure 5. Process flow for assessing erosion concerns associated with sediment. 
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Generate Acknowledgement and Issue Lists 
During this step, the prioritization list will be adjusted to reflect the results of the field 
assessments and subsequent evaluation. Well-maintained sites should be moved to the 
“Acknowledgement List” and fields in need of additional management practices should remain 
on the list of concerns. Conservation technicians can work with landowners to increase 
management on sites of concern. In addition, all sites should be maintained on a master database 
list that includes sites of concern, acknowledgement sites, as well as sites that were removed 
from the prioritization list during step 4. 

Update Spatial Analysis for Sensitive Sites 
The sensitive site prioritization list should be periodically reviewed and revised. New priority 
sites for assessment can be added as other sites are moved to the “Acknowledgement List”. In 
addition, new spatial analyses can be conducted as necessary to update priority site 
identification. These analyses could be conducted when the following conditions occur: 

• Critical land use changes take place (e.g., regional decline in conservation reserve 
program enrollment) 

• Improved terrain analysis methods are developed (e.g., LiDAR) 
• Newly identified watershed stressors emerge (e.g., biotic impairments) 
• New technology becomes available 
• Better/new datasets are provided 
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For this part of the guidance, field procedures are conducted to both complement and evaluate 
the performance of the GIS analysis. The field assessments can be used to assess the adequacy of 
the spatial analysis in predicting CSAs. These results, though mainly qualitative, provide 
substantial insight into locating bank-related PMZ and CSA sites of concern. In addition, the GIS 
analysis can be enhanced using field data to generate an inventory of streambank locations in 
need of stabilization. Field collection methods used to develop the inventory are designed to 
inform managers regarding the extent of sensitive banks and provide efficient information 
transfer to subsequent evaluation teams. For example, the field data can assist a fluvial 
geomorphologist performing more quantitative assessments such as the Bank Erosion Hazard 
Index, Near Bank Stress, or the CONCEPTS river modeling.     

Field technicians can perform the following assessments: land use / Ag field characterization, 
channel characterization, stream assessment based on Technical Note 99 (USDA NRCS, 1998), 
and pour point characterization. Technicians also can gather data for the Minnesota Rapid 
Phosphorus Index (University of Minnesota, 2006) and conduct a qualitative streambank erosion 
assessment. The first four assessments are part of an Upland Field and Channel Assessment 
protocol designed for this project to provide on-the-ground information about sites identified as 
CSAs. The Minnesota Rapid Phosphorus Index (Rapid P-Index) is a screening tool designed to 
identify sites on which to perform the full Phosphorus Index. However, for this project, the full 
Phosphorus Index will not always be performed. Instead, the Rapid P-Index will be used to 
identify indicators of phosphorus runoff risk, and these issues then will be discussed with 
producers regarding conservation management options. It is important to note that many of the 
sites identified as sensitive by the GIS analysis will already have appropriate management and 
operation.  Thus, these tools also provide an important opportunity to recognize producer 
accomplishments and track program progress necessary for supporting basin management and 
Total Maximum Daily Load efforts. 

Depending on the objectives, watershed practitioners will likely use one or more of the following 
forms to record field data: 

• Upland Field and Channel Assessment Worksheet: This worksheet contains multiple 
forms. On these forms, staff will record general site information, including site location 
and general Ag field and channel conditions. Staff first will document field features using 
an aerial photograph. Next, staff will complete the land use / Ag field characteristics 
form. Staff then will walk the channel associated with the field and complete the channel 
characteristics form, as well as an adapted Technical Note 99 (TN-99) form. While 
walking the channel, staff will note any pour points, defined as channelized flow from the 
field to an outlet, such as surface water. Tile intakes also are considered pour points. This 
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information will be recorded on the pour point characteristics form and tile inlet pour 
point characteristics form. 

• Minnesota Rapid Phosphorus Index Form: Completing this form will provide the 
necessary information performing the Rapid P-Index assessment. 

• Streambank Erosion Assessment Form: Field technicians will use this form when 
streambank erosion is observed. Information recorded on this form can be used to provide 
a detailed inventory of identified stream sites experiencing bank erosion within a 
watershed. Requested inputs include, physical characteristics of the bank, noted animal 
and equipment impacts, presence of a perennial cover buffer, and a qualitative estimate of 
buffer quality. 
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Upland Field and Channel Assessment Worksheet 

This form is used to document the characteristics of each field and the receiving water associated with 
that field. A field is defined as a plot of land with a continuous cropping system (i.e. the portion of a 
parcel planted to corn; Note: Plots with strip cropping would be considered one field).  

Steps for completing this worksheet (a separate worksheet should be completed for each field):  

1. Document features on the aerial photograph/map using the legend provided. Please be sure to 
write the worksheet number (listed above) on the aerial photograph. (Some aerial photographs 
will be used for multiple fields. 

2. Assess the field characteristics, including management practices, tillage, etc. Fill out the “field 
characteristics” portion of this form, document features on the aerial photograph/map, and take 
photographs of any notable features. When taking photos, document the location of the feature by 
first photographing the GPS coordinates. Also record the photo numbers on the worksheet. 

3. Walk the channel along the field you just surveyed. Complete the “channel characteristics” 
portion of this form, as well as the Technical Note 99 form. While walking the channel, note any 
pour points. Take any photographs of notable features. As before, document the location of the 
feature by first photographing the GPS coordinates and record the photo numbers on the 
worksheet. 

4. Complete the “pour points” portion of this form for all of the pour points identified while walking 
the channel. A pour point is defined as channelized flow from the field to an outlet, such as 
surface water. Tile intakes also are considered pour points. Take any photographs of notable 
features. As before, document the location of the feature by first photographing the GPS 
coordinates and record the photo numbers on the worksheet. 

Materials: 

• Aerial photos  
• Camera 
• Datasheet or log book 
• Pens 

• Tape measure 
• White board and markers 
• Topographical map 
• Residue tool or photo guides 

Site ID:____________________ Date: __________________________ 

Prepared By: 
____________________________________ 

Worksheet # (write on the aerial photograph): 
___________________ 

Field # _________________ Field conditions (e.g., weather:  wet, snow 
melt, dry; Crop status: pre-plant, emerging, full 
canopy cover, harvest ...): 
_____________________________________ 

Acres   ________________________ 

GPS:  _____________________________ 

Photo #’s and brief description of feature (gully, buffer, tile outlet, etc): 
______________________________________________________________________________ 
______________________________________________________________________________ 
______________________________________________________________________________ 
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Aerial Photograph Feature Identification Form 
Site ID: _____________________ Worksheet #: ______________________ 

(Write this # on the aerial photograph) 
 
Identify the following characteristics on the aerial photograph (using the legend below): 

 

• Contributing area of surface flow (delineate boundary visual from field edge typically without entering 
field).  Might be compared later with LiDAR-based GIS topo map. 

• Receiving waters  
o Number each receiving water on the map  
o On the Channel Characteristics form, write the ID number next to the corresponding description 

• Field pour points into the receiving water (channelized surface flow) 
• Culverts 
• Subsurface drainage  

o Tile outlets along the field edge 
o Subsurface tile intakes identified in field 

• Best Management Practices in place: 
o Buffers 
o Grassed waterways 
o Terrace with subsurface tiling 
o High residue use 
o Side inlets 
o Contour farming  (indicate direction of 

tillage passes) 

o Grade control structures 
o Conservation cover 
o Cross wind trap strip 
o Streambank protection 
o Strip cropping 
o Other _______________ 
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Land Use / Ag Field Characteristics Form 
Site ID: _____________________ Worksheet #: ______________________ 

 
Crop or Other Land Use (Circle One)  
(If multiple crops are planted for a single field, 
please indicate the location of each crop on the map 
using the first letter of the crop type.) 

Corn 
Soy 
Small grain 
Alfalfa 

Pasture 
Forest 
Other _________________ 

Tillage Direction (Circle One – the dominant slope) Up/down slope 
Cross slope or nearly flat land 
Notes: 

% Crop Residue (Circle One) 0-15 15-30 >30 

Evidence of Manure Land Applications Yes ________ No __________ 
Notes: 

Manure Incorporated Yes ________ No __________ 
Notes: 

Drainage Methods Present (Circle One) Field Ditch 
Subsurface Tiling 

Drive-through Ditches 
Other _____________ 

 

If subsurface tile drainage is present, please complete the following: 

Tile Style (Circle One) Clay 
Corrugated metal pipe 

Concrete 
Plastic 

Tile Diameter ______________ in. 

Tile Intake Protection (If Applicable) 
(Use the numbered tile intakes identified on the map 
to characterize the intakes. Write each ID # next to 
the corresponding description.)  

Count of tile intakes ___________ 
Characteristics: 
Buffer (<30 ft): Map ID #’s______________        
Rock inlets: Map ID #’s______________              
Hickenbottom risers: Map ID #’s______________ 
Riser or beehive: Map ID #’s _____________ 

 

Notes: 
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Channel Characteristics Form 
Site ID: _____________________ Worksheet #: ______________________ 

 
Receiving Water Identification 
(Write the ID number of each receiving water identified on 
the map next to the corresponding description. In some 
cases, a receiving water might apply to multiple fields. 
Mark this receiving water only once on the map, but 
include it on each field worksheet for which it is relevant.) 

Lake: Map ID #’s______________ 
Perennial stream: Map ID #’s______________ 
Intermittent stream: Map ID #’s______________ 
Ag ditch: Map ID #’s______________ 
Road ditch: Map ID #’s______________ 
Wetland: Map ID #’s______________ 

Active Channel Width (Circle one) 0-5 ft 
6-10 ft 

11-15 ft 
>15 ft 

BMPs in Place within the Channel (Circle all that apply) 
(Consider the types of BMPs that are located between and 
including the banks.)  

Two-stage ditch 
Grade control 
structures 
Drop structures 

Rip rap 
Streambank 
bioengineering 
Other _____________ 

BMP Recommendations 
 

 
 
 
 

 
Site Diagrams (note: riparian borders, structures, land use, bends and culvert or bridge): 

 
Upstream      Downstream 
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Adapted TN-99 Assessment Form (USDA NRCS, 1998) 
Site ID: _____________________ Worksheet #: ______________________ 

 
Upstream / Downstream For full descriptions of the scores, please see Pages 99-106 

Channel 
Condition 
(Pg. 100-1) 

     / 
10 – Natural channel 
 
7 – Evidence of past alteration but substantial 
recovery 

3 – Altered channel 
 
1 – Channel actively downcutting or widening 

Hydrologic 
Alteration 
(Pg. 101-2) 

     / 
10 – No visible evidence of channel 
straightening; no drainage features present; 
little or no sedimentation at downstream 
culverts 
 
7 – Occasional drainage features present; 
little sedimentation at downstream culverts 

3 – Frequent drainage features apparent; <60% of 
reach straightened; large sediment deposits at 
downstream culverts 
 
1 – Drainage heavily altered; >60% of reach is 
ditch or straightened; large sediment deposits at 
downstream culverts 

Riparian Zone 
(Pg. 102-3)      / 

10 – Natural vegetation extends at least 2 
active channel widths on each side 
 
7 – Natural vegetation extends one active 
channel width on each side OR covers entire 
floodplain 

3 – Natural vegetation extends 1/3 of active 
channel width on each side OR vegetative root 
system moderately compromised 
 
1 – Natural vegetation less than a third of active 
channel width OR lack of generation OR root 
system severely compromised 

Bank Stability 
(Pg. 103-4)      / 

10 – Banks are stable and low; >33% of 
eroding surface area protected by roots 
 
7 – Banks moderately stable and low; <33% 
of eroding surface area protected by roots 

3 – Banks are moderately unstable; banks might 
be low but typically are high 
 
1 – Banks are unstable; banks might be low but 
typically are high 

Water 
Appearance 
(Rank only during 
moderate to high 
flows)  
(Pg. 104-5) 

     / 
10 – Very clear or clear but tea-colored; 
objects visible at depths of 3-6 ft 
 
7 – Occasionally cloudy; objects visible at 
depths of 1.5-3 ft 

3 – Considerable cloudiness; objects visible to 
depths of 0.5-1.5 ft 
 
1 – Very turbid or muddy; objects visible to 
depths of  <0.5 ft 

Pools and 
Riffles (Rank in 
natural streams 
only; record only 
if upstream and 
downstream 
length is longer 
than ~12 active 
channel widths 
and low flow)  
(Pg. 105-6) 

     / 
10 – Deep and shallow pools abundant (~2-
4); obvious riffles downstream of pools; 
>30% of pool bottom obscure due to depth 
 
7 – Pools present but not as abundant; 10-
30% of pool bottom obscure due to depth 

3 – Pool or riffle present but shallow; 5-10% of 
pool bottom obscure due to depth 
 
1 – Pools absent or entire bottom discernible 

Riffle 
Embeddedness 
(Rank only if 
riffles are present) 
(Pg. 107) 

     / 
10 – Gravel or cobble particles are <20% 
embedded 
 
7 – Gravel or cobble particles are 20-40% 
embedded 

3 – Gravel or cobble particles are 40-60% 
embedded 
 
1 – Riffle is completely embedded 

Please calculate the overall and total scores on the following page. 
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Overall Score  
 
(Total divided by 
number scored) 

Upstream:  (Σ      ) / (#        ) 
 

Downstream:  (Σ       ) / (#         ) 
 

Total Scores 
Upstream: ___________ 
Downstream: __________ 

 
Observations (note algal blooms, septage odors, presence of manure or other phosphorus 
sources, and turbidity-related findings):   
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Pour Point and Upland Runoff Characterization Forms. These forms are to be used to evaluate runoff from 
sites identified as high-priority by GIS analysis (e.g., SPI and USLE). These forms also should be used to 
evaluate additional areas of concern identified during site visits. The forms are sequenced to allow the field 
crew to differentiate between and characterize flows from an agricultural field that directly enter a surface water 
and flows that first pass through a natural vegetation corridor.  Timing  of the site visit, in relation to recent 
precipitation, stage of plant growth, and precipitation, will influence what erosion and pour point evidence is 
likely to be observed. 

 

It is recommended that the field crew develop its own systematic approach for evaluating a field. One method 
would be to begin the site evaluation by walking in the upland area. In this approach, the team first would 
evaluate runoff from the field and characterize management practices. The runoff evaluation would assess 
both pour points (based on the SPI metric) and sheet flow (based on the USLE metric). [It should be 
emphasized that the role of the SPI and USLE metrics is to inform initial site selection are not intended to 
restrict the field evaluation. The assessment team should note any erosion or potential water quality concerns 
observed, even if these are not indicated by the GIS analyses.] Buffer and filter strip BMPs are considered 
part of the upland Ag field, not a natural vegetated corridor, for the purposes of this assessment. The upland 
runoff evaluation should note whether the runoff flows directly to a receiving water or first passes through a 
natural vegetation corridor. If it passes through a vegetated corridor, the team should characterize the 
corridor and assess any water quality concerns associated with the flow entering the receiving water. This 
part can be completed during the upstream walk if the corridor is narrow, or on the return trip downstream. 

 

The forms should be used in the following sequence: 

1. Pour Point Identification Form and/or USLE Review Form 
a. This is a two-part form used to evaluate the appropriateness of the GIS analyses for the specific 

watershed characteristics. 
i. The Pour Point Identification Form should be used to assess whether the SPI was a good 

indicator of pour points. 
ii. The USLE Review Form should be used to assess whether USLE was a good indicator of 

water quality risk associated with sheet and rill erosion. 
b. The Pour Point Identification Form should be filled out for each pour point identified by the 

terrain analysis and those additional points observed during the site assessment. It is especially 
critical to note whether the observed pour point was predicted by SPI.   

c. The USLE Review Form should be filled out for any crucial areas identified by the USLE 
analysis and areas with erosion risks identified during the site assessment. 

2. Upland Management Characteristics Form 
a. This form should be used to characterize runoff flowing to receiving waters (as opposed to tile 

inlets). A separate form is designed to characterize flow to tile inlets (see Part 3). 
b. This form is divided into multiple parts, based on the land use where the flow originates. The 

land uses are: 
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i. Hay/pasture 
ii. Row crop 

iii. Natural vegetation 
c. Only the parts relating to the relevant, observed land uses need to be completed during the field 

assessment. 
d. The purpose of this form is to better characterize observed pour points and erosion risks, as well 

as identify cases where erosion likely would occur given field conditions (i.e., slope, soil type) 
but is being properly managed. For instance, evidence of a likely pour point might not be present 
due to field activities, such as contour cropping. 

e. Multiple parts of this form might be used in some cases. For example, a pour point might be 
indicated by the SPI in an upland area currently planted to row crops. Plowing has removed on-
site evidence of the pour point in the field, and a natural vegetated corridor exists between the 
field and receiving water. However, gullying is observed on the streambank. In this case, the 
field technician would complete both the Row Crop/Small Grains and Natural Vegetation 
Corridor sections of this form for the pour point. Although the pour point is not observed in the 
cropped field, completing the Row Crop portion of the form will help document the field 
activities that are impacting the pour point and existing management of runoff. 

3. Tile Inlet and Outlet Pour Point Characteristics Form 
a. This form should be used to characterize the contributing area to tile intake, inlet protection, and 

tile outlet condition. 
b. Assess every tile inlet and outlet as a combined pour point. Complete this form where there is 

evidence of erosion in the field and/or on the streambank at the outlet. 
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Pour Point Identification Form and/or USLE Review Form 
(Use this sheet to record information about the ability of SPI and/or USLE to identify pour points and erosion risk in different settings. This 
evaluation will help determine if these GIS analyses are appropriate tools for given watershed characteristics.) 

Site ID: _____________________ Worksheet #: ______________________ 
 

A. Pour Point Identification Form 
 

Pour Point Map ID #    
Was Pour Point 
Indicated by SPI? Yes No Yes No Yes No 

Flow Type at Pour Point 
(Circle one) 

Sheet Flow 
Tile Outlet 

Ephemeral gully (< 2ft) 
Gully 

Sheet Flow 
Tile Outlet 

Ephemeral gully (< 2ft) 
Gully 

Sheet Flow 
Tile Outlet 

Ephemeral gully (< 2ft) 
Gully 

Gully Characteristics  Width _________ 
Depth _________ 
Length ________ 

Width _________ 
Depth _________ 
Length ________ 

Width _________ 
Depth _________ 
Length ________ 

General Characteristics 
at Pour Point (Circle all 
that apply) 

Bermed with side inlet 
Gentle slopes 
Slight erosion 

Bermed with side inlet 
Gentle slopes 
Slight erosion 

Bermed with side inlet 
Gentle slopes 
Slight erosion 

Upland Land Use * Hay/Pasture 
Row Crop/Small Grain 

Natural Vegetated Corridor 

Hay/Pasture 
Row Crop/Small Grain 

Hay/Pasture 
Row Crop/Small Grain 

Pour Point Flows to **: Receiving Water 
Natural Vegetation Corridor 

Receiving Water 
Natural Vegetation Corridor 

Receiving Water 
Natural Vegetation Corridor 

If Flows to Natural 
Vegetation Corridor, is 
there a Noticeable Pour 
Point from the Corridor 
to the Water Resource? 

Yes No Yes No Yes No 

 

* If the upland land use is hay / pasture, complete Form 2A; if the upland land use is row crop / small grain, complete Form 2B.  

** If the pour point flows to a natural vegetation corridor, also complete Form 2C. 

Notes: 
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B. USLE Review Form 
 

Erosion Risk Area Map 
ID # 

   

Was Erosion Risk Area 
Indicated by USLE? Yes No Yes No Yes No 

Evidence of Erosion Yes No Yes No Yes No 
Erosion Evidence Type Gully  /  Eroded Surfaces (Rill) / Visual 

Redeposition / Bare Cropped Areas     

Basis for Erosion  Vulnerable Soil Type  
Slope 

Livestock 
Field Road 

 Sheet Flow 
Tile Outlet 

Ephemeral gully (< 2ft) 
Gully 

Sheet Flow 
Tile Outlet 

Ephemeral gully (< 2ft) 
Gully 

Gully Characteristics  Width _________ 
Depth _________ 
Length ________ 

Width _________ 
Depth _________ 
Length ________ 

Width _________ 
Depth _________ 
Length ________ 

Upland Land Use* Hay/Pasture 
Row Crop/Small Grain 

Hay/Pasture 
Row Crop/Small Grain 

Hay/Pasture 
Row Crop/Small Grain 

Erosion Area Flows 
to**: 

Receiving Water 
Natural Vegetation Corridor 

Receiving Water 
Natural Vegetation Corridor 

Receiving Water 
Natural Vegetation Corridor 

If Flows to Natural 
Vegetation Corridor, is 
there a Noticeable 
Erosion Risk from the 
Corridor to the Water 
Resource? 

Yes No Yes No Yes No 

 

* If the upland land use is hay / pasture, complete Form 2A; if the upland land use is row crop / small grain, complete Form 2B.  

** If the erosion area flows to a natural vegetation corridor, also complete Form 2C. 

 

Notes: 
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Upland Management Characteristics Form (for flow to receiving waters) 
(Use this form to record information about the characteristics of the field contributing to each pour point and erosion risk area. This form is divided 
into three parts depending on the land use type where the flow originates. Only fill out the portions of the form relevant to each site.)      

 
A. Hay/Pasture 
 

Pour Point or Erosion 
Risk Area Map ID # 

   

Hay or Pasture? Hay Pasture Hay Pasture Hay Pasture 
Evidence of Livestock 
Access to Stream Yes No Yes No Yes No 

Fence Restricting 
Livestock Access  Yes No Yes No Yes No 

Livestock Activity 
Erosion  Loafing Area 

Foot Traffic      

Evidence of Equipment 
Impacts Yes No Yes No Yes No 

Waterway Riparian 
Corridor Condition  

None 
Poor 

Fair 
Good 

None 
Poor 

Fair 
Good 

None 
Poor 

Fair 
Good 

Contributing Area 
(Estimate)    

Pour Point / Erosion 
Risk Area Flows to*: 

Stream Channel 
Ditch 

Natural Vegetation Buffer 
Other______ 

Stream Channel 
Ditch 

Natural Vegetation Buffer 
Other______ 

Stream Channel 
Ditch 

Natural Vegetation Buffer 
Other______ 

 

* If the erosion area flows to a natural vegetation corridor, also complete Form 2C. 

Notes: 

Is the erosion/flow path connected to the water resource? 

Is the erosion related to a heavy use area in the pasture? 
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B. Row Crops 
 

Pour Point or Erosion 
Risk Area Map ID # 

   

Crop Type  Corn 
Soy 

Beets 
Other ______ 

Corn 
Soy 

Beets 
Other ______ 

Corn 
Soy 

Beets 
Other ______ 

Tillage Direction Parallel to Stream 
Perpendicular to Stream 

Other _______ 

Parallel to Stream 
Perpendicular to Stream 

Other _______ 

Parallel to Stream 
Perpendicular to Stream 

Other _______ 
Residue  
(Circle one) 

> 30% 
30-15% 

< 15% 
None 

> 30% 
30-15% 

< 15% 
None 

> 30% 
30-15% 

< 15% 
None 

Contributing Area 
(Estimate)    

Pour Point / Erosion 
Risk Area Flows to*: 

Stream Channel 
Ditch 

Natural Vegetation Buffer 
Other______ 

Stream Channel 
Ditch 

Natural Vegetation Buffer 
Other______ 

Stream Channel 
Ditch 

Natural Vegetation Buffer 
Other______ 

Waterway Buffer 
Condition 

None 
Poor 

Fair 
Good 

None 
Poor 

Fair 
Good 

None 
Poor 

Fair 
Good 

Field BMPs for 
Contributing Area 
(Circle all that apply) 

Grassed Waterways 
High Residue 

Strip Cropping 
Contour Farming 

Other:  ____________ 

Grassed Waterways 
High Residue 

Strip Cropping 
Contour Farming 

Other:  ____________ 

Grassed Waterways 
High Residue 

Strip Cropping 
Contour Farming 

Other:  ____________ 
 

* If the erosion area flows to a natural vegetation corridor, also complete Form 2C. 

 

Notes: 
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C. Natural Vegetation Corridor 
 

Pour Point or Erosion 
Risk Area Map ID # 

   

Corridor Condition  Poor Fair 
Good Poor Fair 

Good Poor Fair 
Good 

Corridor Width  < 33 ft. 
> 33 ft. 

< 33 ft. 
> 33 ft. 

< 33 ft. 
> 33 ft. 

Vegetation Type Grass 
Woody Shrubs 

Trees 

Grass 
Woody Shrubs 

Trees 

Grass 
Woody Shrubs 

Trees 
Pour Point Contributing 
Area (Estimate)    

Erosion to Receiving 
Water 

None 
Gully 

Ephemeral Gully 

None 
Gully 

Ephemeral Gully 

None 
Gully 

Ephemeral Gully 
Notes: 
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Tile Inlet Pour Point Characteristics Form (for flow to tile inlets) 
(Use this form to record information about pour points that flow to tile inlets.) 

Site ID: _____________________ Worksheet #: ______________________ 
 

Pour Point Map ID #    
Field Type Cropped, Hay, Pasture, Natural Vegetation Cropped, Hay, Pasture, Natural Vegetation Cropped, Hay, Pasture, Natural Vegetation 
Tile Intake Protection Buffer 

Rock inlets 
Hickenbottom risers 

Riser or beehive 
High Residue 

Buffer 
Rock inlets 

Hickenbottom risers 
Riser or beehive 

Buffer 
Rock inlets 

Hickenbottom risers 
Riser or beehive 

Protection Condition at 
Pour Point  

None 
Poor 

Fair 
Good 

None 
Poor 

Fair 
Good 

None 
Poor 

Fair 
Good 
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Minnesota Rapid Phosphorus Index Form (University of Minnesota, 2006) 

For detailed procedures on completing this worksheet, please see pages 107-109 
Field ID:      

GPS:      

Date:      
Prepared By:      

Field Conditions (e.g. weather):      

Manure* and fertilizer  
(lbs P2O5/ac/yr) 

0 
1-100 

101-200 
> 200 

0 
1-100 

101-200 
> 200 

0 
1-100 

101-200 
> 200 

0 
1-100 

101-200 
> 200 

0 
1-100 

101-200 
> 200 

Unincorporated (within 24 hours) or 
incorporated? 

Uninc. 
Inc. 

Uninc. 
Inc. 

Uninc. 
Inc. 

Uninc. 
Inc. 

Uninc. 
Inc. 

Was manure applied? Yes No Yes No Yes No Yes No Yes No 
Erosion (t/ac/yr)      

Soil test P (ppm Olsen) 
(65 ppm Olsen = 90 ppm Bray = 100 
Mehlich) 

≤ 65 
> 65 

Unavailable 

≤ 65 
> 65 

Unavailable 

≤ 65 
> 65 

Unavailable 

≤ 65 
> 65 

Unavailable 

≤ 65 
> 65 

Unavailable 

Year of soil P test      
Distance from edge of field to 
water (ft) 

< 10 ft 
10 - 100 ft 

> 100 ft 

< 10 ft 
10 - 100 ft 

> 100 ft 

< 10 ft 
10 - 100 ft 

> 100 ft 

< 10 ft 
10 - 100 ft 

> 100 ft 

< 10 ft 
10 - 100 ft 

> 100 ft 
Internal drainage 
Good = Artificially drained or naturally 
drained 
Slow = Soil hydrologic group C or D, or 
>27% clay and without artificial drainage 

Good 
Slow 

Good 
Slow 

Good 
Slow 

Good 
Slow 

Good 
Slow 

Recommendation for collecting 
STP when not available**  (X in box 
indicates collecting STP is recommended. 
Add any notes, such as the producer 
resistance to conducting a soil test.) 
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** The lack of STP information is more of a concern when manure is being applied on fields experiencing substantial erosion. In 
addition, the field technician might consider recommending determining STP when the existing data are more than three years old. 

RUSLE2 Form 

Estimate the following RUSLE2 factors using technician professional judgment: 
Field ID      

Dominant Slope (%)      
Slope Length (ft) Either 
estimated in the field or derived 
from MN NRCS eFOTG 

     

Soil Type      
Crop Management Template 
used to run RUSLE2 

     

Practice Factor  
e.g. 1 = no BMP, 100% 
delivered; 0.7 = tilling across 
slope 

     

 
*Approximate manure application rates equivalent to 100-200 lbs 

P2O5/ac 
 Solid manure 

(tons/ac) 
Liquid slurry  
(1000 gals/ac) 

Liquid anaerobic 
lagoon (1000 gals/ac) 

Pasture  
(animal units/ac) 

Beef 25-50 5.9-11.8 34.5-69.0 3.2-6.4 
Dairy 33-67 6.7-13.3 37.0-74.1 3.4-6.7 
Turkey 2-4 2.6-5.1   
Poultry 2-4 2.3-4.7 27.8-55.6  
Swine 13-25 2.9-5.7 45.5-90.9  
Sheep 10-20   3.3-6.6 
Horse 25-50   6.0-12.0 
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Rapid P-Index Screening Tool Table 

Field ID:             

Any amount of manure or fertilizer is unincorporated             
More than 100 lbs of P2O5/ac/yr incorporated (manure and/or 
fertilizer) 

            

Soil test P is > 65ppm (Olsen) and soil loss is > 3 t/ac/yr             
Soil test P is > 65ppm (Olsen) and drainage is poor             
Erosion is > 8 t/ac/yr             
Distance to water is < 100 ft and erosion is > 5 t/ac/yr             
Distance to water is < 10 ft and erosion is > 3 t/ac/yr             
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Streambank Erosion Assessment Form  

For detailed procedures on completing this worksheet, please see page 110 
Field ID:      

GPS:      
Date:      

Prepared By:      
Field Conditions (e.g. weather):      

Length and Height of Eroding Bank (ft) L: 
H: 

L: 
H: 

L: 
H: 

L: 
H: 

L: 
H: 

Impacted by Livestock Access Yes No Yes No Yes No Yes No Yes No 

Impacted by Equipment Access Yes No Yes No Yes No Yes No Yes No 

Riparian 
Cover Type 

Perennial Cover Woody 
Grass 

Woody 
Grass 

Woody 
Grass 

Woody 
Grass 

Woody 
Grass 

Managed Land Uses 
Within 10 ft of water body 

Road 
Homestead 

Crop 
Grazed 

Livestock heavy 
use area 

Road 
Homestead 

Crop 
Grazed 

Livestock heavy 
use area 

Road 
Homestead 

Crop 
Grazed 

Livestock heavy 
use area 

Road 
Homestead 

Crop 
Grazed 

Livestock heavy 
use area 

Road 
Homestead 

Crop 
Grazed 

Livestock heavy 
use area 

Riparian Perennial Cover Quality 
 Woody Grass 

Excellent  Dense, Deep-rooted 

Good Dense, full 
canopy > 50% deep-rooted 

Fair > 50% 
canopy 

< 50% deep-rooted, > 
50% shallow 

Poor < 50% 
canopy < 50% 

 

Excellent 
Good 
Fair 
Poor 

Excellent 
Good 
Fair 
Poor 

Excellent 
Good 
Fair 
Poor 

Excellent 
Good 
Fair 
Poor 

Excellent 
Good 
Fair 
Poor 

Riparian Perennial Cover Buffer Width 
(ft) 

30 ft 
10 – 30 ft 

< 10 ft 

30 ft 
10 – 30 ft 

< 10 ft 

30 ft 
10 – 30 ft 

< 10 ft 

30 ft 
10 – 30 ft 

< 10 ft 

30 ft 
10 – 30 ft 

< 10 ft 
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Note the type of erosion indicators observed (exposed escarpment, exposed tree roots, slumped debris at the toe, etc.) and other 
erosion concerns: 

Field ID: 
 

________ 
 

Field ID: 
 

________ 
 

Field ID: 
 

________ 
 

Field ID: 
 

________ 
 

Field ID: 
 

________ 
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Adapted TN-99 Protocol 

The following text was adapted from the Stream Visual Assessment Protocol produced by the 
USDA NRCS’s National Water and Climate Center (NWCC) (USDA NRCS, 1998). This 
assessment protocol is also referred to as TN-99. The text below provides tables with ranking 
criteria for completing the TN-99 form. Additional background information is also included for 
each parameter. 

Channel Condition 
Natural channel; no 
structures, dikes. No 
evidence of down-
cutting or excessive 
lateral cutting. 

Evidence of past 
channel alteration 
but with substantial 
recovery of channel 
banks.  Any dikes or 
levies are set back 
to provide access to 
flood plain. 

Altered channel; 
<50% of reach with 
riprap and/or 
channelization.  
Excess aggradation; 
braided channel. 
Dikes or levees 
restrict access to 
flood plain. 

Channel is actively 
downcutting or 
widening.  >50% of 
the reach with 
riprap or 
channelization.  
Dikes or levies 
prevent access to 
the flood plain. 

10 7 3 1 

Stream meandering generally increases as the 
gradient of the surrounding valley decreases. Often, 
development in the area results in changes to this 
meandering pattern and the flow of a stream. These 
changes in turn can affect the natural stream 
processes, such as sediment transport.   
 
Some stream channel modifications have more 
impact on stream health than others. For example, 
channelization and damming affect a stream more 
than the presence of pilings or other supports for road 
crossings. Active downcutting and excessive lateral 
cutting result in serious impairments to stream 
functions. Both conditions are indicative of an 
unstable stream channel.   
 
Extensively bank armoring channels to stop lateral 
cutting usually leads to more problems (especially 
downstream). Often banks can be stabilized by using 
a series of structures (e.g., barbs, groins, jetties, 
deflectors, weirs, vortex weirs) that reduce water 
velocity, deflect currents, or act as gradient controls. 
These structures are used in conjunction with large 
woody debris and woody vegetation plantings.  
 
What to look for: Signs of channelization or 
straightening of the stream might include an 
unnaturally straight section of the stream, high banks, 
dikes or berms, lack of flow diversity (e.g., few point 
bars and deep pools), and uniform-sized bed 

materials (e.g., all cobbles where there should be 
mixes of gravel and cobble). In newly channelized 
reaches, vegetation might be missing or appear very 
different from the vegetation in unchannelized 
reaches (different species, not as well developed). 
Older channelized reaches might also have little or no 
vegetation or have grasses instead of woody 
vegetation. Drop structures (such as check dams), 
irrigation diversions, culverts, bridge abutments, and 
riprap also indicate changes to the stream channel.  
 
Indicators of downcutting in the stream channel 
include nickpoints associated with headcuts in the 
stream bottom and exposure of cultural features, such 
as pipelines that initially were buried under the 
stream or tile lines extending far out into the ditch. 
Other examples include exposed footings in bridges 
and culvert outlets that are higher than the water 
surface during low flows. A typical indicator of 
incision is a lack of sediment depositional features, 
such as regularly-spaced point bars. A low vertical 
scarp at the toe of the streambank might indicate 
downcutting, especially if the scarp occurs on the 
inside of a meander. Another visual indicator of 
current or past downcutting is high streambanks with 
woody vegetation growing far below the top of the 
bank. (As a channel incises the bankfull flow line 
moves downward within the former bankfull 
channel.) Excessive bank erosion is indicated by raw 
banks in areas of the stream where such bank 
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conditions would not normally be found, such as 
straight sections between meanders or on the inside 

of curves. 

 
 

Hydrologic Alteration 
Access to the flood plain, 
bank height compared to 
stream bankfull height 
(BH/BFH) ratio in the 
range of 1 : 1, up to 1 : 
1.2.  

Or 
No visible evidence of 
channel straightening, 
drainage pipes entering 
the channel, or urban 
conveyance alteration.  

Or 
Downstream culverts 
have no or little 
sedimentation and are at 
grade on both sides. 

Access to the flood 
plain, BH/BFH ratio in 
the range of 1 : 1.2   
up to 1 : 1.5.  

Or 
Occasional drainage 
features apparent, 
straightening less 
than 20% of reach, 
few inlet pipes. 

Or 
Downstream culverts 
have little 
sedimentation and 
are at grade on both 
sides. 

Access to the flood 
plain, BH/BFH ratio in 
the range of 1 : 1.5   
up to 1 : 2. 

Or 
Frequent drainage 
features apparent, 
straightening less than 
60% of reach, inlet 
pipes common. 

Or 
Downstream culverts 
have large sediment 
deposits or are not at 
grade on downstream 
side. 

Access to the flood 
plain, BH/BFH ratio in 
the range of 1 : > 2. 

Or 
Drainage is altered; 
waterbody is a ditch 
or straightened for 
more than 60% of 
reach, presence of 
inlet pipes 
substantial. 

Or 
Downstream culverts 
have large sediment 
deposits or are not at 
grade on downstream 
side, > 1 foot drop. 

10 7 3 1 

Bankfull flows, as well as flooding, are important to 
maintaining channel shape and function (e.g., 
sediment transport) and maintaining the physical 
habitat for animals and plants. High flows scour fine 
sediment to keep gravel areas clean for fish and other 
aquatic organisms. These flows also redistribute 
larger sediment, such as gravel, cobbles, and 
boulders, as well as large woody debris. The 
redistribution of these materials results in the 
formation of pool and riffle habitat that is important 
to stream biota.  
 
Under natural conditions, the river channel and flood 
plain exist in dynamic equilibrium, having evolved in 
the present climatic regime and geomorphic setting. 
The relationship between the water and sediment 
forms the basis for the dynamic equilibrium that 
maintains the form and function of the river channel. 
The energy of the river (water velocity and depth) 
should be in balance with the bedload (volume and 
particle size of the sediment).   
 
Changes in the flow regime will alter the balance 
between water and sediment. If a river is not incised 
and has access to its flood plain, a decrease in the 

frequency of bankfull flows and out-of- bank flows 
will decrease the river's ability to transport sediment.  
This can result in excess sediment deposition, 
channel widening and swallowing, and, ultimately, 
braiding of the channel. Rosgen (1996) defines 
braiding as a stream with three or more smaller 
channels.  These smaller channels are extremely 
unstable, rarely have woody vegetation along their 
banks, and provide poor habitat for stream biota.   A 
split channel, however, has two or more smaller 
channels (called side channels) that usually are very 
stable, have woody vegetation along their banks, and 
provide excellent habitat.  Conversely, an increase in 
flood flows or the confinement of the river away 
from its flood plain (from either incision or levees) 
increases the energy available to transport sediment 
and can result in bank and channel erosion.   
 
Changes in the low flow or baseflow of a stream also 
can affect stream conditions.  If the low-flow rate 
decreases, a smaller portion of the channel will be 
suitable for aquatic organisms.  The low flow or 
baseflow during the dry periods of summer or fall 
usually comes from groundwater entering the stream 
through the stream banks and bottom. Water 
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withdrawals for irrigation or industry and dam 
placement often disrupt the normal low-flow pattern.  
Baseflow also can be affected by water management 
practices and land use within the watershed.  Less 
precipitation infiltration or excessive drainage will 
reduce baseflow and increase the frequency and 
severity of high-flow events. For example, 
urbanization increases runoff, which can reduce low 
flows and increase the frequency of flooding. In some 
cases, flood frequency has increased to every year or 
more than once a year .  Overgrazing and clearcutting 
can have similar, although typically less severe, 
effects.  
What to look for: Evidence of flooding includes high 
water marks (such as water lines), sediment deposits, 
or stream debris.  These should be apparent on the 
banks, on the bankside trees or rocks, or on other 
structures (such as road pilings or culverts).  

 
Excess sediment deposits and wide, shallow channels 
could indicate a loss of sediment transport capacity. 
The loss of transport capacity can result in a stream 
with three or more channels (braiding).  
 
A landowner can provide information about the 
frequency of flooding and about summer low-flow 
conditions. A flood plain should be inundated during 
flows that equal or exceed the 1.5- to 2.0-year flow 
event (2 out of 3 years or every other year). It should 
be noted that water in an adjacent field does not 
necessarily indicate natural flooding. The water 
might have flowed overland from a low spot in the 
bank outside the assessment reach.   
 

 
 

Riparian Zone 
Natural vegetation 
extends at least two 
active channel widths 
on each side. 

Natural 
vegetation 
extends one 
active channel 
width on each 
side. 

Or 
If less than one 
width, covers 
entire flood 
plain. 

Natural 
vegetation 
extends half 
of the active 
channel 
width on 
each side. 

Natural 
vegetation 
extends a third 
of the active 
channel width 
on each side.  

Or 
Vegetative root 
system 
moderately 
compromised. 

Natural 
vegetation less 
than a third of 
the active 
channel width on 
each side.  

Or 
Lack of 
generation. 

Or 
Vegetative root 
system severely 
compromised. 

10 8 5 3 1 
 
The condition of the riparian zone is assessed by 
observing the width of the natural vegetation zone 
from the edge of the active channel out onto the flood 
plain.  For the purposes of discussing this assessment, 
the word natural refers to plant communities with (1) 
all appropriate structural components and (2) species 
native to the site or introduced species that function 
similar to native species at reference sites.   
 
A healthy riparian vegetation zone is one of the most 
important elements for maintaining a healthy stream 
ecosystem.  The quality of the riparian zone 
correlates with the width and the complexity of the 
woody vegetation within it. A wider, more complex 

riparian zone typically is associated an enhanced 
functioning of the riparian zone.  This zone:   

• Reduces the amount of pollutants that reach 
the stream in surface runoff 

• Helps control erosion 
• Dissipates energy during flood events 

 
The type, timing, intensity, and extent of alteration 
activities in riparian zones are critical for determining 
the impact of such activities.  The functional value of 
a riparian area is reduced when riparian zones are 
narrow and/or riparian zones have roads, agricultural 
activities, residential or commercial structures, or 
substantial areas of bare soils.  Concentrated flows 
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also can compromise the filtering function of riparian 
zones.  For proper functioning, no evidence of 
concentrated flows through the zone should be 
apparent.  If concentrated flows are evident, such 
flows should be from land areas appropriately 
buffered with vegetated strips. 
 
What to look for: Compare the width of the riparian 
zone to the active channel width.  The vegetation 
must be natural and consist of all structural 
components (aquatic plants, sedges or rushes, 
grasses, forbs, shrubs, understory trees, and overstory 
trees) appropriate for the area. One common problem 
is a lack of shrubs and understory trees. Another 
common problem is lack of regeneration. The 
presence of only mature vegetation and few seedlings 

indicates lack of regeneration.  Incomplete plant 
communities should not be interpreted as natural 
conditions. In addition, there should be no evidence 
of concentrated flows that are not adequately 
buffered before entering the riparian zone. 
 
Healthy riparian zones on both sides of the stream are 
important for the health of the entire system. If one 
side lacks protective vegetative cover, the entire 
reach of the stream will be affected. In doing the 
assessment, both sides of the stream should be 
examined.  The assessor should note on the diagram 
which side of the stream has problems.  
 
 

 
 

Bank Stability 

 

Assessing the bank stability involves determining the 
existence of or the potential for detachment of soil 
from the upper and lower stream banks and its 
movement into the stream. Some bank erosion is 
normal in a healthy stream. Excessive bank erosion 
occurs where riparian zones are degraded or where 
the stream is unstable because of changes in 
hydrology, sediment load, or isolation from the flood 
plain.  
 

High and steep banks are more susceptible to erosion 
or collapse. All outside bends of streams erode, so 50 
percent of the banks in even a stable stream might be 
eroding. A healthy riparian corridor with a vegetated 
flood plain contributes to bank stability.  To enhance 
stability, the roots of perennial grasses or woody 
vegetation typically should extend to the baseflow 
elevation of water in streams that have bank heights 
of 6 feet or less.  Root masses help hold the bank 
soils together and physically protect the bank from 
scour during bankfull and flooding events. 

Banks are stable; banks 
are low (at elevation of 
active flood plain); 33% 
or more of eroding 
surface area of banks in 
outside bends is 
protected by roots that 
extend into baseflow 
elevations. 

Moderately stable; 
banks are low (at 
elevation of active 
flood plain); less 
than 33% of eroding 
surface area of 
banks in outside 
bends is protected 
by roots that extend 
into the baseflow 
elevation. 

Moderately 
unstable; banks may 
be low, but typically 
are high (flooding 
occurs 1 year out of 
five or less 
frequently); outside 
bends are actively 
eroding 
(overhanging 
vegetation at top of 
bank, some mature 
trees falling into 
stream annually, 
some slope failures 
apparent). 

Unstable; banks 
may be low, but 
typically are high; 
some straight 
reaches and inside 
edges of bends are 
actively eroding as 
well as outside 
bends (overhanging 
vegetation at top of 
bare bank, 
numerous mature 
trees falling into 
stream annually, 
numerous slope 
failures apparent. 

10 7 3 1 
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Vegetation seldom becomes established below the 
elevation of the bankfull surface because of the 
frequency of inundation and the unstable bottom 
conditions as the stream moves its bedload.   
 
Specific details about the vegetation and soil also 
should be noted when assessing bank stability. 
Although the presence of vegetation is important for 
bank stability, the type of vegetation also matters. For 
example, trees, shrubs, sedges, and rushes have the 
type of root masses capable of withstanding high 
streamflow events, while Kentucky bluegrass does 

not. Soil type at the surface and below the surface 
also influences bank stability. For example, banks 
with a thin soil cover over gravel or sand are more 
prone to collapse than banks with a deep soil layer  
 
What to look for: Signs of erosion include 
unvegetated stretches, exposed tree roots, or 
scalloped edges. Additional conditions that might 
lead to bank collapse include evidence of 
construction, vehicular, or animal paths near banks or 
row cropping and grazing areas leading directly to 
the water's edge.   

 
 

Water Appearance 
(to be ranked only during moderate to high flows) 

Very clear, or clear but 
tea-colored; objects 
visible at depths of 3 to 
6 feet (or less if slightly 
colored). 

Occasionally cloudy, 
especially after 
storm event; objects 
visible at depth 1.5 
to 3 feet; might 
have slightly green 
color. 

Considerable 
cloudiness most of 
the time; objects 
visible to depths of 
0.5 to 1.5 feet. 

Very turbid or 
muddy appearance; 
objects visible to 
depth of < 0.5 feet. 
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Assessing the water appearance involves comparing 
turbidity, color, and other visual characteristics with a 
healthy or reference stream.  Turbidity primarily is 
caused by suspension of soil particles and organic 
matter in the water column. Streams often exhibit 
moderate turbidity after a storm event because of 
runoff carrying soil and organic particles or 
turbulence causing increased suspension of particles.  
One measure of turbidity is to determine the depth to 
which an object can be clearly seen. 
 
Many factors can influence the color of the water in a 
stream. The water in some streams might be naturally 
tea-colored. This is particularly true in watersheds 
with extensive bog and wetland areas. Water that has 
slight nutrient enrichment might support algae 
communities, which causes the water to be a greenish 
color. Heavy nutrient loads in streams often result in 
thick algae coatings on rocks and other submerged 
objects. In degraded streams, floating algal mats, 
surface scum, or pollutants, such as dyes and oil, 
might be visible. These observations should be noted, 
but green scum or algal scum should not be 
considered in the ranking of this indicator   

 
What to look for: Water clarity is an obvious and 
easy feature to assess. This measure should be taken 
after a stream has had the opportunity to "settle" 
following a storm event.  
 
Turbidity is easily assessed by observing the depth at 
which an object is visible.  The deeper an object can 
be seen, the lower the amount of turbidity. This 
method for evaluating turbidity should only be used 
when the stream is sufficiently deep. For example, if 
the water is clear but only 1 foot deep, the stream 
should not be rated as if the object became obscured 
at a depth of 1 foot.  
 
Water color also can be easily determined through 
quick visual observation.  The color can be used as an 
indicator of other potential water quality issues.  For 
example, a pea-green color indicates nutrient 
enrichment beyond what the stream can naturally 
absorb.   
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Pools and Riffles 
(rank in natural streams only; combine upstream and downstream observations; record visible 
findings only if upstream and downstream length is longer than approximately 12 active 
channel widths (about two reaches) and flow regime is low) 

Deep and shallow pools 
abundant (~2-4 of each); 
obvious riffles 
downstream of pools.  If 
near a pool, note if more 
than 30 percent of the 
pool bottom is obscure 
due to depth, or the 
pool is deeper than 1.6 
to 2 times the prevailing 
depth. 

Or 
Bedrock or large 
boulders abundant (not 
a D, DA or E stream 
classification). 

Pools are present 
but not as 
abundant (~1 of 
each).  If near a 
pool, note if 10 to 
30% of pool bottom 
is obscure due to 
depth, or the pool 
is less than 1.5 
times the prevailing 
depth. 

Or 
Moderate pools 
and riffles apparent 
from road crossing. 
 

Pool or riffle 
present, (not a run) 
but shallow. Five to 
10% of the pool 
bottom is obscure 
due to depth, or 
the pools are less 
than 1.5 times the 
prevailing depth. 

Or 
Sparse pools and 
riffles visible. 
 

Pools absent, or the 
entire bottom is 
discernible (not an E 
channel). 
 

10 7 3 1 
 
 
Pools, riffles, and runs are natural river features.  The 
presence of pools and riffles are an important 
indicator of natural stream functions. A healthy 
stream has a mixture of shallow and deep pools.  A 
pool is considered deep when it is 1.6 to 2 times 
deeper than the prevailing depth, while a shallow 
pool is less than 1.5 times deeper than the prevailing 
depth. Pools are considered abundant if each of the 
meander bends in the reach being assessed contains a 
deep pool.  To determine the abundance of pools, the 
assessor should observe a sample length longer than 
12 active channel widths. Generally, only 1 or 2 
pools typically would form within a reach as long as 
12 active channel widths. In low order, high gradient 
streams, pools are considered abundant if there is 
more than one pool every 4 channel widths.   
 
What to look for: Pool diversity and abundance 
typically are estimated by walking the stream or 
probing with a stick or length of rebar from the 
streambank.  Deep pools should be on the outside of 
meander bends.  
 
In shallow, clear streams a visual inspection might 
provide an accurate estimate of pools and riffles. 
Since this is a windshield survey, the assessor should 

only note the visual presence of riffles and pools.  Do 
not measure depth by walking banks. Landowners 
have not granted permission for bank access. In deep 
streams or streams with low visibility, this 
assessment characteristic might be difficult to 
determine and should not be scored. 
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Riffle Embeddedness  
(use only if riffles are present) 

Gravel or cobble 
particles are <20% 
embedded. 

Gravel or cobble 
particles are 20-40% 
embedded. 

Gravel or cobble 
particles are 40-60 
% embedded. 

Riffle is completely 
embedded. 

10 7 3 1 

Do not assess this element unless riffles are present 
or they are a natural feature that should be present. 
Sand substrates are not expected to have riffles. 
 
Riffles are areas where the water is breaking over 
rocks or other debris causing surface agitation. Such 
areas typically are located downstream of a pool. 
This element is sensitive to regional differences and 
should be related to reference conditions. 
 
Riffles are critical for maintaining high species 
diversity and abundance of insects for most streams. 
Riffles also serve as spawning and feeding grounds 
for some fish species.  For this assessment, 
embeddedness measures the degree to which gravel 
and cobble substrate are surrounded by fine 
sediments (sands silts and clays).  Embeddedness 
directly relates to the balance between the stream 
energy and sediment load.  Substantial embeddedness 
is an indicator of too much sediment.   

 
What to look for: If the riffle can be seen clearly 
from the road, the score should be based on the depth 
to which gravel and cobble objects are buried by 
sediment. [This assessment usually is conducted by 
picking up particles of gravel or cobble with 
fingertips at the fine sediment layer. The particles are 
pulled out of the bed and the assessor estimates the 
percent of the particle that was buried. Some streams 
have been so smothered by fine sediment that the 
original stream bottom is not visible. The test for 
complete burial of a streambed is conducted by 
probing with a length of rebar.]  For a windshield 
survey, riffles will be assessed by visually estimating 
the top radius of the gravel or cobble stone against 
the amount of sands, silts and clays surrounding it. 
Riffles can be limited to a few rock widths wide, and 
the measurement should be taken between the first 
row of rocks looking upstream. 
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Minnesota Rapid Phosphorus Index Protocol 

Overview 
A modified version of the Minnesota Rapid Phosphorus Index (Rapid P-Index) will be used in 
this project. The Rapid P-Index was created by the University of Minnesota to identify indicators 
of phosphorus runoff risk (University of Minnesota, 2006). For this project, the Rapid P-Index 
will be used to indicate the type of BMPs to emphasize during conservation implementation 
discussions with producers. The BMP categories are identified based on the risk factors included 
in the Rapid P-Index. When facing multiple risk factors and/or situations where mitigation 
measures are not feasible or sufficient, the full Minnesota Phosphorus Index (P Index) is 
recommended. The P Index tool provides additional information regarding the phosphorus runoff 
risk, as well as comparison scenarios that provide evaluations of the potential management 
options for water quality improvements. 

The Rapid P-Index was designed to be used as a preliminary screening tool prior to 
implementing the full Minnesota Phosphorus Index. This rapid assessment allows technicians to 
quickly evaluate the risk of phosphorus runoff from agricultural sites. Sites that are identified as 
posing the lowest risk of phosphorus runoff can then be excluded from further assessment. This 
screening saves time and resources that otherwise would be spent conducting more detailed 
evaluations of low-priority areas.  

The Rapid P-Index was designed to allow the assessor to select from one of three screening 
tools. These three separate tools each reflect a level of sensitivity. In this case, “sensitivity” 
refers to the likelihood of the tool to identify the site as “high risk” for phosphorus runoff and 
does not refer to potential impacts to the water body. Having multiple tools with different levels 
of sensitivity provides assessors with options for different evaluation thresholds that trigger 
performing a full P Index. The high sensitivity tool will identify the largest number of sites while 
the low sensitivity tool will identify the least. Identifying a large number of sites might be over-
inclusive but is less likely to accidentally omit a high-priority site. Identifying a smaller number 
of sites might leave out a high-priority site but will reduce the amount of resources required to 
conduct additional evaluations. 

For this project, the team decided to use the “high sensitivity” tool. This tool is designed to 
identify sites that are likely to have a P Index score greater than 2. This score indicates the site 
has a relatively high risk of phosphorus runoff and associated impacts on highly sensitive surface 
waters. This threshold is also appropriate if the intent is to eliminate most phosphorus inputs. 
The index value can range from zero to levels above a value of 6 if there is a very high risk of a 
field being a source of phosphorus pollution to a nearby body of water. 
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Procedure 
1. Compile data – Gather the information listed to complete the Rapid P-Index worksheet 

for each field: 
• Manure and fertilizer application rates 
• Whether manure/fertilizer is incorporated or unincorporated 
• Erosion rate 
• Soil test P 
• Year of most recent soil test P 
• Distance to water 
• Internal drainage (whether drainage is good or slow) 

 
2. Note recommendations regarding soil test P 

• The following criteria can be used, along with professional judgment, to generate 
a recommendation to gather STP data from a specific site: 

o STP data has never been taken 
o STP information is more than 3 years old 
o Manure is being applied to a field exhibiting substantial erosion (the lack 

of STP information is more of a concern on these fields) 
• If the field technician concludes that conducting a soil test is recommended, an 

“X” should be placed in the appropriate box on the Rapid P-Index Worksheet (the 
last row of the worksheet addresses soil test P recommendations). 

• The field technician also can note in the worksheet any additional factors that 
should be considered regarding STP (i.e. the producer seemed especially resistant 
to the idea of a soil test). 

 
3. Perform the screening – Fill out the Screening Tool Table based on the information 

collected in the Rapid P-Index Worksheet. Place a checkmark in each box that 
corresponds to a characteristic exhibited by the assessed field. 
 

4. Identify potential BMPs/additional assessment needs 
• Conduct additional analysis if substantial erosion is occurring, manure is being 

applied, and no soil test P is available 
• If the Rapid P-Index resulted in a “hit” on any of the checklist categories, 

determine if a straightforward mitigation measure is possible (see Table 2 for 
possible BMP options based on the P risk indicator) 

• Assess if BMP combinations will address P risk 
• Conduct full P-Index on sites where more detailed assessments are needed and/or 

straightforward BMPs will not address the identified issues 
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Table 2. Potential BMPs corresponding to indicators of phosphorus release risk. 

Potential BMP P Risk Indicator 

Nutrient Incorporation Any amount of manure or fertilizer is unincorporated  

Nutrient Management 
More than 100 lbs of P2O5/ac/yr incorporated (manure and/or 
fertilizer)  

Phosphorus Agronomic Rates 
Soil test P is > 65 ppm (Olsen) and soil loss is > 3 t/ac/yr 

Soil test P is > 65 ppm (Olsen) and drainage is poor 

Erosion Control 

Erosion is > 8 t/ac/yr  

Distance to water is < 100 ft and erosion is > 5 t/ac/yr  

Distance to water is < 10 ft and erosion is > 3 t/ac/yr  
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Streambank Erosion Assessment Protocol 

Overview 
A qualitative assessment will be used to document areas where streambank erosion is occurring. 
The following form should be completed when a field technician observes signs of bank erosion. 
These signs include the presence of an exposed escarpment, soil cracking near the bank, exposed 
tree roots and/or obvious slumped debris at the toe, or other signs. Where erosion is present, the 
technician should measure the length and height of the eroding bank. A qualitative judgment 
regarding the vegetative cover also should be indicated, along with impacts from livestock or 
equipment access. 

Procedure 
1. Identify indicators of streambank erosion – This streambank assessment only needs to 

be performed on sites where indicators of streambank erosion are present. 
2. Compile data – Gather the information listed to complete the streambank erosion 

worksheet for each location with indicators of streambank erosion.  
• Length and height of eroding bank 
• Impacted by livestock access 
• Impacted by equipment access 
• Riparian cover type 

o Perennial cover, or 
o Managed land uses within 10 feet of water body 

• Riparian perennial cover quality (N/A if managed land uses are within 10 feet of 
water body) 

• Riparian perennial cover buffer width (N/A if managed land uses are within 10 
feet of water body) 

3. Note the type of erosion indicators observed and other erosion concerns 
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Examples of Different Bank Conditions 

 

Figure A.  Tributary, Kalamazoo River watershed 

 Figure A depicts a small stable stream 
setting. 
 
Completing a streambank erosion inventory 
form at this site would not be necessary. This 
stream illustrates well-established perennial 
vegetative cover. The buffer width is > 30 
feet. 
 

 

 

Figure B.  Kalamazoo River 

Figure B depicts a site with noticeable bank 
erosion.  
 
Exposed roots indicate active erosion. Slumped 
soils indicate undercutting typical for erosion 
induced by channel hydrology. This stream has 
poor perennial vegetative cover (shallow grass 
roots and sparse woody vegetation density). The 
buffer width is < 10 feet. 
 
For this site, the evaluation would measure the 
bank height using the average dimension along 
the bank that stretches from submerged toe of 
the slope to grassed soil horizon. 
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Figure C.  Rouge River 

Figure C depicts a site with outside bend bank 
erosion. 
 
For this site, a streambank erosion assessment 
would be conducted. The erosion illustrated 
here is typical of erosion induced by channel 
hydrology. Perennial vegetative cover is poor. 
The buffer width is < 10 feet. 
 
This site is an interesting example of bank 
erosion. Grass/woody roots extend to the 

waterline, but are so few and shallow that they provide minimal bank protection. Also, this 
site is downstream from a dam (not pictured). Impoundments usually are associated with 
atypically high erosion due to increased sediment transport capacity as a result of the low 
sediment concentrations in the water released from the impoundment. 

 

Figure D.  Hagar Creek, Ottawa County, MI 

Figure D depicts a site with active erosion on at 
least three bank locations. 
 
The tree root balls shown slumping into the 
stream (middle of the photo) is typical of erosion 
inducted by channel hydrology. The near bank to 
the left has poor woody vegetative cover and poor 
grass understory cover. Buffer width is < 10 feet.  

 
 

 
 
(Photos and some narrative content were adapted from MI DEQ Standard Operating Procedure – 
Assessing bank erosion potential using Rosgen’s Bank Erosion Hazard Index (BEHI). Available 
at: http://search.michigan.gov/search?affiliate=mi-deq&query=stream%20bank%20erosion ) 
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Full Minnesota Phosphorus Index 

The full Minnesota Phosphorus Index (P Index) provides managers with an estimate the risk of phosphorus 
loading from an agricultural field to surface water. This tool enables the evaluation of potential options to 
reduce the risk of phosphorus loss. The Data Collection Sheet for the P Index can be found at the below web 
address: 

http://www.mnpi.umn.edu/downloadfiles/DataCollectionSheet.pdf 

This link provides both a data form and a one-page instruction sheet describing and defining the form fields. 
This information format follows the input requirements for the Minnesota Phosphorus Index tool. 

For more information about the P Index in general, please see the following website: http://www.mnpi.umn.edu/ 
This link also will provide you with information on downloading the P Index computer tool. 
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Case Studies 

Accurate delineation for modeling and controlling nonpoint source pollution requires identification of the 
mechanisms for generating runoff, the pathways for delivery and quantification of the relative pollutant 
loadings, as well as the risk for erosion.  Field testing and case study summaries of the desktop analyses and site 
evaluation protocols from various agroecoregions across the state have been provided to enhance the transfer of 
the technologies to conservation districts across the state.   

Watershed practitioners may be using a number of different tools and ancillary sources of data for pre-planning, 
targeting and project work besides the resources described in the previous sections of this report, including:  

• Ortho Imagery 
• Feedlots 
• Impaired waters coverage 
• Water monitoring data 
• Endangered species data 
• Drinking Water Supply Management Area (DWSMA) delineations 
• RUSLE2 
• MinnFARM 
• SWAT 
• HSPF 
• Crop productivity indices 
• Soil fertility 
• BMP inventories 
• Minnesota restorable wetlands 
• Karst features 

The PMZ case studies discussed in this section demonstrate how the available tools and data are adaptable to a 
wide range of conditions provided the user has a good knowledge of conditions. When trying to solve the 
complex issues involved with impaired waters it is important to examine all the attributes of the study area: 
hydrology, soils, land use and people.  These assessments are a vital part of that process.  

Each case study is organized either by location/watershed or integrated application, and they typically describe 
the agroecoregion, landscape and scale of the study area, known impairments, types of CSAs identified in both 
GIS and field, the type of field validation preformed, as well as observations and lessons learned, where 
appropriate. 

117 Identifying Priority Management Zones for BMP Implementation in Impaired Watersheds 
 



Case Studies 2014 
 

Agroecoregions 
An agroecoregion is a concept stemming from an extensive multi-disciplined research project conducted at the 
University of Minnesota. The idea of agroecoregions was created to define regions with relatively homogenous 
physical characteristics in agriculturally impaired Minnesota watersheds. Minnesota has 39 distinct 
agroecoregions which are landscape units that share relatively uniform crop productivity, climate, geologic 
parent material, soil drainage, and slope steepness. The researchers found that the variance in soil erosion, 
stream biotic habitat, stream water quality, lake water quality, and ground water quality was smaller within 
agroecoregion boundaries than within watershed boundaries, and that through linked biophysical and economic 
modeling, the economic costs of reducing phosphorus loads to streams were lower when BMPs were targeted to 
specific agroecoregions compared with an untargeted strategy involving entire watersheds (Hatch et. al., 2001). 
Thus agroecoregions provide a nice complement to CSA identification and remediation. 

The following site provides a link to download the Minnesota agroecoregion layer as a polygon feature class 
within and outside a file geodatabase (either can be directly accessed within ArcGIS software): 
http://devel.gisdata.mn.gov/da_DK/dataset/agri-agroecoregions/resource/f53059b9-8339-4528-a8b4-
b291551062de 

The Zumbro River watershed was the focus of a study involving digital terrain analysis and CSA identification; 
several locations in the watershed were visited between 2012 and 2013 and excerpts from those findings are 
highlighted in the first three agroecoregions and associated case studies described in the following sections. 

Level Plains 
The Level Plains agroecoregion is located in Southeast MN (see next image) and composed of fine-textured, 
soils with row crop production on relatively flat to moderately steep topography without sinkholes. The 
majority of soils are poorly drained, while a significant portion is well drained. This agroecoregion has a 
very high density of intermittent streams and a moderate density of permanent streams. Water erosion 
potentials are high, while wind erosion potentials are low. Practices to control soil erosion by water and 
sediment delivery to streams are important. These include conservation tillage, and grassed filter strips 
along streams. Tile intakes at the base of steep slopes should be replaced with French drains or blind inlets 
(Olmsted1). 
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Case Study #1 

Case study #1 is located in Dodge County, MN in the headwaters of the Middle Fork of the Zumbro River 
near West Concord, MN. A 1¼ mile long ditched stream section was walked on Nov. 18th, 2012. 

November weather in 2012 as monitored at the Dodge County Municipal Airport had a mean temperature of 
37°F and a total of only 0.19 inches of precipitation compared to a 30+ year average of 1.76 inches (NOAA 
archives). The region was considered to be in moderate drought at the time (droughtmonitor.unl.edu). The 
stream section walked has a turbidity impairment. 

Several CSAs were identified in the field, nearly all of which were gullies and a few instances of bank 
slumping and tile outlet erosion. Length, width, and depth measurements were taken at each identified 
erosional feature.
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Observations and lessons learned: In ditched stream sections with steep, high walls, an SPI signature as 
short as one to two pixels (depending on threshold used) can often coincide with significant erosion in the 
field as compared to the same length signature along flat riparian areas. When using short SPI signatures to 
identify and rank potential CSAs, it is especially important to consider contributing area and soil erosion 
risk characteristics for each point. 

Several SPI layers were calculated in the study area to show how both pit filling and hydro-conditioning 
affect signatures. The site shown in the following images was chosen for the presence of a large culvert road 
crossing and a high concentration of stream flow. Sites with those two characteristics tend to produce 
erroneous SPI signatures when pit filling without hydro-conditioning is used (3A). Note the signature that 
parallels the buffer just north of the stream, which doesn’t exist in the non-pit filled images. Also note the 
signature that starts at top of images and either terminates at buffer (non-pit filled) or stream (pit-filled).

The ephemeral gully shown in these 
images is entrenched starting 
approximately 185 yards from the pour 
point and drains an area of 43 acres with 
average slope of 3.9%. The bottom left 
image displays the top soil erosion risk 
raster values – the yellow corresponds to 
the top 3%, and red the top 1% within 
the HUC12 catchment. The bottom right 
image shows the SPI signature 
associated with the erosional feature, 
created using 1 meter pit fill z-limit. The 
picture on left was taken from the 
opposite (northern) bank looking south-
southwest. 
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1A 1B 

2A 2B 

The above figures show SPI signatures calculated from a 3 meter DEM with varying degrees of pre-processing performed. 
All SPI signatures are from the 97.5th percentile within the extent shown (~136 acres). Figures in the left column were not 
hydro-conditioned, while figures in right column were – the DEM was hydro-conditioned by burning the stream (blue line) 
through the north-south oriented road crossing culvert in the top-right of image. 
1A & 1B – Not pit filled. The results are essentially identical. 
2A & 2B – Pit filled using a 1 meter z-limit. The displays are nearly identical with only slight color gradient variation 
between the two. Note the new signatures near the buffer just north of stream that didn’t exist in 1A & 1B. These additions 
can influence CSA predictions. 
3A & 3B – Pit filled with no maximum z-limit, meaning all pits were completely filled. In this example, 2B and 3B are 
nearly identical. This is not always the case [see case study #5 – Steep Dryer Moraine]. Note the straight signature 
somewhat paralleling the stream in 3A. This can be used to estimate where main channel flow will exist during flooding or 
culvert blockage. Caution should be used when identifying potential CSAs from those seemingly “erroneous” signatures. 
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Rochester Plateau 
The Rochester Plateau agroecoregion is located in Southeast MN and composed of well-drained, fine-
textured loessial soils developed on moderate to steep slopes in karst with a high density of intermittent 
streams and sinkholes, and a mixture of row crop, livestock operations, and dairy production systems. Water 
erosion potentials are extreme, while wind erosion potentials are low. Stream water quality ranges from fair 
to poor. Phosphorus transport risks to surface waters are high to severe. Major resource concerns in this 
agroecoregion are soil erosion by water, cattle and hog operation management, nutrient management from 
manure and fertilizer, and rapid leaching or seepage of pollutants to ground water in areas with karst 
topography and sinkholes. Soil erosion should be controlled by any or all of the following practices where 
applicable: conservation tillage, contour farming, stripcropping, terracing, grassed waterways, and sediment 
detention basins. Riparian buffer strips are recommended along streams. Best management practices for 
cattle include livestock exclusion from streams, and practices to reduce feedlot runoff (Olmsted1). 

 

122 Identifying Priority Management Zones for BMP Implementation in Impaired Watersheds 
 



Case Studies 2014 
 

Case Study #2 

Case study #2 focuses on a small tributary to the Middle Fork of the Zumbro River in northeast Dodge 
County, MN approximately 5 miles from Pine Island, MN. The naturally meandering stream contains a Soil 
Conservation Service grade stabilization structure (shown below) that was constructed in 1967 for 
controlling gully erosion in the draw and was the site for several sedimentation surveys over the years. 
Several disjointed sections of the stream were field verified by walking along the stream corridor on 
October 15th, 2012, including the 1.2 mile section containing the pond. 

 

5 acre permanent pool surface area SCS Grade Stabilization Structure on un-named creek, Dodge Co., MN.  

October weather in 2012 as monitored at the Dodge County Municipal Airport had a mean temperature of 
46°F and 1.28 inches of precipitation compared to an historical average of 2.24 inches. The region was 
considered to be in moderate drought at the time. 

CSAs identified were mostly gullies along with some bank slumping and tile outlet erosion. Some areas 
were worsened by cattle grazing operations in and near the stream. Length, width, and depth measurements 
were taken at each identified erosional feature. 
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Observations and lessons learned: Most of the larger gullies near case study #2 flowed through riparian 
forestland where little underbrush was present and were formed from tile outlets located near the fluvial 
terrace. 

Picture #2 

The gully shown in picture #1 near Berne, MN 
was the result of concentrated flow from a 
corrugated 6 in. drain tile outlet (picture #2), and 
further exacerbated by cattle livestock in and 
near stream. Forest canopy cover at the pour 
point reduced chance for vegetated filter 
establishment. The lower right image shows the 
SPI signature associated with this gully (all pits 
filled), which contains a lower average value 
compared to several surrounding signatures. The 
semi-transparent white pixels represent this 
HUC12’s top 5% of values from the soil erosion 
risk raster [see Locate potential CSAs - Sub-
catchment soil characteristics section]. 

Picture #1 
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Erosional features on the south side of the stabilization structure were expected to be verified in field due to 
the presence of multiple long SPI signatures, though none were located – possibly due to cattle exclusion in 
forested areas both north and south of the pond. 

The image on left shows a 
long (~1/2 mile) SPI 
signature with several high 
SPI values following a 
forested ravine. Users 
would typically expect to 
see surface erosion 
associated with such an 
SPI, though a field visit 
showed very little erosion 
and soil deposition evident 
from the upslope tree line 
to the pour point due to a 
well maintained filter strip 
(circled in white). 
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Blufflands 
The Blufflands agroecoregion in SE MN has well drained, fine-textured soils on very steep to extremely 
steep slopes in karst topography. Sinkholes can occur near incised stream drainage networks. This 
agroecoregion has a very high density of intermittent streams and a moderate density of forested perennial 
stream networks. Water erosion potentials are extreme, while wind erosion potentials are low. The risk of 
phosphorus transport to surface waters is moderate to high. On steep lands, practices to control water 
erosion are important. These include avoiding row crops on steep lands, or if they must be grown on steep 
lands, using a combination of conservation tillage, strip-cropping, and terracing. Buffers, along with 
practices that provide stable conveyances of flow, should be provided for ravines and gullies (Olmsted1). 
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Case Study #3 

Cold Spring Brook is a designated trout stream in western Wabasha County and drains into the Zumbro 
River at Zumbro Falls, MN. The stream is located in the Bluffland agroecoregion where forested ravines are 
commonly found. Sedimentation from upland and in-stream sources have caused Cold Spring Brook to be 
the target of several in-stream trout habitat improvement and bank stabilization projects over the last several 
years, with Trout Unlimited funding and conducting much of the work. 

Approximately five miles of Cold Spring Brook and its surrounding tributary stream corridors were walked 
in early to mid-June of 2013 for CSA field validation. The preceding winter at the Rochester International 
Airport (26 miles south of Zumbro Falls) recorded above average snowfall amounts totaling 73.1” from July 
2012 to June 2013. The average annual snowfall for Rochester, MN is 48”. The area also received record 
snowfalls in the first week of May, with Zumbro Falls reporting over 14 inches on May 2nd and 3rd (NOAA). 
The spring of that year was especially wet in Southeast MN, with April and May receiving precipitation 
well above average. April and May precipitation totals were 6.33” and 11.04” respectively, with average 
values of 3.24” and 3.63” respectively (as reported at the Rochester International Airport). Observations 
during the June field visits noted few crop fields around Zumbro Falls had worked fields due to very wet 
soils. 

Several critical areas were identified in the field – ravines were the most commonly identified feature 
followed by edge of field gullies and bank erosion. Landowner attempts at remediating erosion were evident 
at many of the sites. The most common practice was rip-rap placement at head cuts/knick points to control 
gully erosion and felled trees in ravine channels to reduce flows. Length, width, and depth measurements 
were taken at each identified erosional feature.
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SPI threshold was found to best represent the flow 
paths during field verification of this bluffland 
agroecoregion. The SPI layer shown here was created 
using a 1 meter pit fill z-limit. 

 

Forested ravines with multiple branches are common in bluffland agroecoregions. Many of the ravine branches 
were actively advancing into upland fields (pictured). Hillshade layers can aid in identifying these ravines and 
existing conservation practices such as the grade stabilization structure shown (bottom right). The 98th percentile 
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Observations and lessons learned: Despite the above average precipitation in spring, Cold Spring Brook – 
which is nearly 15 river miles long from headwaters to outlet – lost surface flow only 2 river miles from its 
outlet to the Zumbro River (as observed on June 5th). This changed the priority of any CSAs upstream in dry 
runs as they presented lower risk of moving sediment downstream. This example emphasized the need for 
current stream data that includes both perennial and intermittent classifications. 

 

 

 

The image below shows a steep bluff near 
Cold Spring Brook. The bluff had a slope of 
~50% (160ft high by 320ft wide). The 
hillshade layers help to visualize the area, and 
most SPI signatures can be seen terminating 
near the bluff’s toe. During a field visit, one 
site along the bluff was found to have 
considerable active erosion. The gully had a 
near-vertical head cut of ~10 ft. The SPI 
signature associated with the feature was the 
only signature originating from the bluff with 
connectivity to the stream. This section of 
bluff was also within the top 10% of soil 
erosion risk raster values contained within this 
HUC12 catchment. 
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Steep Wetter Moraine 
The Steep Wetter Moraine agroecoregion, located in east-central Minnesota, consists of dissected till plain 
and outwash valleys with ravines commonly occurring along steeply incised river channels, and with a mix 
of row crops and pasture land. 
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Case Study #4 

The case study #4 site is located in a HUC12 catchment adjacent to the St. Croix River near Basswood 
Grove, Washington, Co., MN. The site was visited to field verify the existence of a potential CSA that was 
located with GIS digital terrain analysis techniques. The site was selected due to the presence of a long SPI 
signature with a high mean value (top 1% of SPI from the HUC12) and flow through elevated soil erosion 
risk values (top 5% in HUC12, white areas in top right image). The SPI shown was created using no pit 
filling. Field verification showed no erosion present due to active landowner management of several 
conservation practices, such as the filter strip pictured bottom left and many grassed waterways. Color 
infrared ortho-imagery (bottom right image) can be used to locate these conservation practices and give a 
rough evaluation on their condition and density.  
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Steep Dryer Moraine 
The Minnesota Pollution Control Agency (MPCA) assembled a set of BMP implementation strategies for 
TMDL turbidity reduction compliance in the Chippewa River Watershed in central Minnesota and provided 
the following descriptions of the Steep Dryer Moraine and Central Till (following section) agroecoregions: 

The [Steep Dryer Moraine located in Central to NW MN] agroecoregion consists of loamy soils such as the 
Chapett, Langhei, and Barnes series developed from glacial moraines. Soils are located on very steep slopes, 
and are well-drained. Water erosion rates can be severe to extreme, while wind erosion can be moderate to 
severe. The risk of phosphorus losses to streams and lakes by runoff and erosion is moderate. There are 
numerous lakes in this agroecoregion, and a moderate density of intermittent streams. Stream water quality 
is generally poor in this agroecoregion, while lake water quality is threatened. Drinking water wells have a 
median depth of 80 ft. 
Original vegetation was prairie, aspen-oak, oak openings and barrens, and big woods - hardwoods. 
Protection of lake water quality is a high priority in this agroecoregion. Conservation tillage systems that 
leave crop residue and maintain soil surface roughness are important. Contour farming and strip cropping 
are recommended where feasible. Highly erodible land should be placed in permanent grass easements.    
Restoration of wetlands is encouraged. 
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Case Study #5 

The Pelican Lake watershed, located 15 miles SW of St. Cloud, is a 28.5 sq. mi. catchment that is part of a 
current TMDL study focused on reducing phosphorus in the lake. 

Saint Cloud, MN received 78.5” of snowfall between July 2012 and June 2013 which was above the average 
annual of 47”. The spring precipitation amounts for March, April and May were above average with totals 
of 2.63”, 2.90”, and 4.98” respectively compared to averages of 1.55”, 2.57”, and 2.95” respectively. 

SPI layers were created in the watershed to locate potential sediment/nutrient erosion sources, followed with 
CSA predictions along the streams that discharge into the lake.  Field visits to the area in mid-May of 2013 
did not reveal significant sources of non-point source pollution adjacent to surface waters as most areas had 
wide buffers with thick perennial vegetation in combination with well drained soils. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Observations and lessons learned: Similar to the 1st case study from the Level Plains agroecoregion, several 
SPI calculations were also made throughout the Pelican watershed with varying amounts of DEM pre-
processing occurring for each run, specifically pit filled and hydro-conditioning (see following graphics). 
One particular location showed what appeared to be spurious signatures when pit filling with no hydro-
conditioning was employed (following graphic 3A), though the flow was confirmed by the landowner 
stating that ice breakup frequently blocks flow at the road crossing culvert during spring melt and the SPI 
signature was actually where flow diverts. Out of the six graphics shown, the SPI signatures displayed in 
graphic 2B created from a 1m z-limit pit filled and hydro-conditioned DEM was confirmed to most closely 
resemble surface runoff during periods of normal stream flow in the Pelican watershed.

along the stream bank for stabilization. There was no further evidence of erosion upland of the slumping. 

The longest hydrologically connected SPI signature of the 
top 1% of values in the study area was along Mill Creek 
(pictured above left). The accompanying field photo 
shows signs of slumping in the small pasture 
(foreground) and the landowner had installed rip-rap 
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1A 1B 

2A 2B 

The six graphics on left display 
SPI signatures calculated from a 3 
meter DEM with varying degrees 
of pre-processing performed. All 
SPI signatures are from the 97.5th 
percentile within the extent shown 
(~41 acres). Graphics in the left 
column (A) were not hydro-
conditioned, while graphics in 
right column (B) were – the DEM 
was hydro-conditioned by burning 
the stream (blue line) through the 
east-west oriented road crossing 
culvert.  

1A & 1B were not pit filled. The 
results are essentially identical. 

2A & 2B were pit filled using a 1 
meter z-limit. 

3A & 3B were pit filled with no 
maximum z-limit, meaning all pits 
were completely filled. 
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Central Till 
This agroecoregion in central Minnesota consists of well-drained, moderately steep to steep landscapes with 
fine textured soils of the Ahmeek, Greenwood, and Mora series.  Water erosion potentials can be high.  
Stream and lake water quality are generally fair.  Ground water quality is generally fair.  Original vegetation 
was big woods - hardwoods, conifer bogs and swamps, aspen-birch, and prairie (MPCA Chippewa River 
Watershed Draft TMDL BMP strategies). 

 

Case Study #6 

The study area in case study #6 is near Spring Hill, MN in central Minnesota. The site was visited in mid-
April of 2012 to field verify CSA predictions made using terrain analysis attributes. Factors that led to 
choosing the site include the presence of long SPI signatures with high average cell values through steep 
upland slopes. 
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The field visit did not verify considerable erosion present in the upland field containing the SPI signatures 
possibly due to the field being recently tilled. The downstream area from the pour point relating to the 
highest ranked SPI signature at the site had in-channel sedimentation evident. That particular SPI was found 
to terminate at an in-stream vehicle crossing built with course gravel and no buffer. 

St. Cloud winter snowfall total received between July 2011 and June 2012 was 27.4” 
(http://climate.umn.edu/) – well below the average of 46.1”. March and April precipitation totals were near 
average for those months. 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

This example near Spring Hill, MN shows a long SPI signature with a 
high average value (centered, upper right photo) containing the top 1% 
of values in a 16.5 sq. mi. HUC12 catchment. A newly built concrete 
culvert was installed at the downstream road crossing (circled in 
yellow). A modified CTI raster was used in the top right image (blue 
pixels) to show the potential ponding if the culvert was to fail, or jam 
with ice, which could create additional hydrologic connections to several 
nearby SPI signatures. 

The ponding raster also aided in locating a nearby sinkhole depression, 
shown in the right image with the sink circled in yellow. 
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Wetter Clays & Silts 
The Wetter Clays & Silts agroecoregion is located in south-central Minnesota and is a vast, flat fertile plain 
of poorly drained deep soils dominated by row cropping with low erosion rates and high nitrate losses. The 
region has had a dramatic increase of drain tile installation within the last two decades and the majority of 
fields now take advantage of artificial drainage. 
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Case Study #7 

Case study #7 focuses on the small 8.6 mi2 Beauford Watershed in Blue Earth County, MN – part of the 
larger HUC8 La Sueur Watershed in the Minnesota River Basin near Mankato, MN. All the ditched streams 
in the Beauford watershed were walked as part of a project to both identify upland erosion and assess the 
cost and time involved in doing so. Side inlets were the most commonly identified erosion-related feature in 
the watershed. Side inlets are a form of artificial drainage common in the Minnesota River Basin and other 
regions with very flat terrain. Ditch cleaning piles left along the channel corridors inhibit overland flow 
from entering streams at low points. This can often lead to gullies developing at the edge of fields parallel to 
the ditch, so a culvert drain pipe is installed to drain runoff at those points. Unfortunately this allows a direct 
discharge of untreated overland runoff to outlet into surface waters, unless a waterway or other type of 
conservation practice is present upland. Gullies were also identified during the survey. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The erosional feature shown in this example is a 
side inlet near Beauford, MN. The multi-branching 
SPI signatures shown top left are common in this 
region due to very flat topography. The bottom 
right image shows a spring-time aerial photo of a 
long surface runoff flow network approximately 
500 yards west of the side inlet shown above. 
Artificial drainage tile lines exist in the fields as 
shown in the inset photo (orange lines represent 
tile lines).  The center of the photo shows a darker 
area with mineral deposits evident from 
evaporation where ponding still occurs during 
spring thaw and rainstorm events. 
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Unnamed Creek (Stearns County) 

Case Study #8 

Unnamed Creek watershed in the southwestern part of Stearns County was targeted for several reasons. 
Unnamed Creek is impaired for turbidity and has an approved TMDL Report. It also falls within an area in the 
county where there is access to additional Environmental Quality Incentives Program (EQIP) funding. This part 
of the Sauk River watershed is part of the USDA National Mississippi River Basin Initiative (MRBI) (NRCS 
MRBI website). A good working relationship with a number of farmers in this area increased opportunities to 
gain access to test the PMZ tools. We initially focused on landowners with known management information 
(soil tests, manure info, crop rotations). 

Choosing this area to focus for this effort was an example of targeting at a county level. The area chosen with 
identified impairments allowed us to access existing funding to address priority concerns. 

 

 

 
Unnamed Watershed 
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For the next step of the process, resources were evaluated at the watershed level. CSAs were identified 
(green/purple dots on the map above). Based on GIS analysis of the terrain model (using the freely available 
MnDNR LiDAR datasets), these points represent areas in the landscape that have the greatest potential for 
channelized overland flow and sediment and nutrient delivery (see the Digital Terrain Analysis section).  

The county parcel data was overlaid to define tracts of land by ownership. The tracts with the greatest number 
of predicted CSA’s were prioritized. These sites have the greatest potential of delivery of pollutant load to the 
stream. 

Random identifiers were assigned to the tracts, using the same numbers for the fields and CSA’s. This 
organized our work while maintaining landowner privacy. There are many things to consider, including the 
Freedom of Information Act (FOIA), relationships with neighbors, other organizations, regulations, etc.  

 

 

A few of the sites were visited in the Unnamed Creek watershed. A sample of CSA’s was chosen from each 
area to give a good representation of the watershed for the case study.  A multi-leveled targeting approach was 
now scaled down to the field level.   
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At Site 6, Unnamed Creek runs from west to east along the southern part of the property. There is also a side 
ditch that flows into the main channel.  
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CSA 6C was a site with a fairly long Stream Powered Index (SPI) signature. The site visit revealed that a well 
maintained grassed waterway was present that discharged to a side branch of the targeted stream. The structure 
had an outlet pipe for the surface runoff and an outlet for a drainage tile. This site is still a potential CSA 
because you would want to evaluate that the waterway is functioning. You would also want to determine if you 
can locate a tile inlet to see if that is a potential source of nutrients/sediment.  In this case, there was not an open 
tile intake. 

The MN Rapid Phosphorus Index was performed on the contributing field and the result was a “low” rating 
(low potential for phosphorus loss), good buffer conditions and good manure 
management.  
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The stream channel at this location was also 
evaluated using the Bank Erosion Hazard Index 
(BEHI) and found the channel rating to be 
“moderate” (ditched channel with limited 
access to a floodplain, but with good surface 
protection and root density). 

(The BEHI was later removed from this 
guidance due to time and confidence in 
expertise and replaced it with the Streambank 
Erosion Assessment Form). 
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Unnamed Creek site 6A was showing signs of erosion. Although the contributing field has very minimal slopes 
the vegetation along the channel was highly degraded due to over grazing (frequent animal access). There was 
also a tile outlet at this location. It was desired to locate the tile inlet if possible and assess it as a CSA. There 
was no surface intake for this tile. This is a site where animal access and prescribed grazing plans should be 
discussed with this landowner to improve the vegetative cover at the CSA. 

The MN Rapid Phosphorus Index was performed on the contributing field and the result was a “low” rating 
(low potential for phosphorus loss) due to low sheet and rill values and good manure management. 

Contributing Field Pourpoint & Tile Outlet 

Contributing Field 

Pourpoint 
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The BEHI and TN-99 were completed on the stream channel at this site. The BEHI index came up “high” in 
portions of the stream, due to the lack of vegetation and root depth of portions of the stream bank largely from 
animal impact as well as a high bank height to bank full height ration. Stabilizing this crossing by using 
selective animal access and a prescribed grazing would be beneficial on this site. 

Contributing Field 

Pourpoint 

Upstream Downstream 

Unnamed 

Creek 
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Unnamed Creek Site 7 is just upstream of the previous site.  There were several CSA’s predicted on this site. 
The majority of the area the channel flowed through was located within a well-managed grazing area.
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The Site 7B CSA had a large contributing area coming off a field in a corn and soybean rotation. The first 
picture is looking in the contributing field. There was no evidence of channel erosion at the pourpoint. The 
grazed buffer had very good vegetative cover.  The MN Phosphorus Index was performed and rated “very low” 
(low phosphorus runoff potential (no manure application, good commercial P management and low sheet and 
rill erosion value and a good buffer). The TN-99 rated “high” (good bank vegetation/root density, stabile 
hydrologic conditions and a good riparian zone). The stream channel was mostly in a natural cover. 

Unn
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Creek 
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Unnamed 
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Pourpoint 
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Site 7 did not initially have a CSA indicated on the map. The analyst saw the BMP (grassed waterway) in the 
aerial and did not place a CSA. The field survey indicated that there was significant stream bank erosion caused 
by the side inlet structure and that stream bank protection might be necessary. This finding resulted in the 
placement of a CSA when doing the terrain analysis despite that fact that an existing BMP was in place. 

Pourpoint 

Unnamed 
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ek 
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Site 19 represented the last segment of Unnamed Creek before it enters the Sauk River. It runs through a fairly 
undisturbed natural area, with adjacent fields. There were no signs of animal grazing in this area. There were no 
CSA’s in this section, but while conducting initial road crossing assessments, it was determined that there was a 
great deal of stream bank instability in this area. The landowner granted access to do further evaluations.

     

Unnamed 

Creek Sauk    River 
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Although no CSA’s were present at Site 19, a number of the field tools were completed at selected cross 
sections along the channel. The BEHI determinations resulted in “moderate” to “high” ratings. The outside 
bends of this meandering stream exhibited poor root density, poor bank vegetation, and minimal access to the 
floodplain especially in wooded areas. The first site, Cross Section 19A, had a good buffer but a lack of access 
to the floodplain. The channel bed was full of fine eroded sediment.

Unnamed Creek – Site 19 – Cross Section 19A 

Stream Assessment Adjacent Buffer 

Unnamed 

Creek 
Sauk    River 
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More severe bank erosion was observed in the wooded sections of the stream due to lack of understory growth 
and reduced root density. One of the reasons for this increased erosion in the lower section of stream was from a 
change in soil parent material. The soils tended towards more sand and gravel with unstable characteristics at 
high bank angles.  
 
Hydrological modifications are believed to represent the major issue in this watershed. One landowner stated 
that the stream used to run year round with moderate flows but had changed to where it now runs higher and 
faster in the spring but almost dries up during the summer. Tiling, modification to the natural channel 
(straightening, deepening), wetland drainage may be the primary causes. The increased peak flow results in 
greater soil erosion from the stream bank. Practices that can store water will be promoted throughout the 
watershed to address peak flows and reduce the bank erosion causing the turbidity impairments. 
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Pearl Lake/Mill Creek (Stearns County) 

Case Study #9 

Pearl Lake is listed as impaired for Nutrients (Phosphorus) and portions of Mill Creek for E. coli.  This area was 
also in a MRBI (NRCS MRBI website) (which is a special Environmental Quality Incentives Program (EQIP) 
funding) area. The president of the Pearl Lake Association raised concerns about the turbidity of the water 
entering the lake from Mill Creek at certain times of the year. The PMZ tools were applied to further evaluate 
the issues. 
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The digital terrain analysis focused on 
two channels entering the west side of 
the lake. Both outlets showed visible 
sediment flumes in the aerial 
photography. Initially, the analysis 
clipped out the combined watershed 
area of the two channels. After setting 
our threshold and placing the CSA’s it 
was revealed that almost every CSA 
was on the north channel (Mill Creek) 
due to steeper terrain in that watershed 
which skewed the results. It was clear 
that the southern channel was also 
contributing to the lake impairment so 
the watershed of each channel was 
clipped out and the analysis was run 
separately on each to highlight the 
CSA’s with the highest potential in each 
watershed. 

In further advancement of the tools the 
Universal Soil Loss Equation (USLE) 
data was included in the mapping to 
further prioritize CSA’s. SPI (Flow 
Channelization and Power) signatures 
that also ran though high USLE 
(potential for erodibility) areas signified 
the highest potential for nutrient and 
sediment delivery. 

Next, CSA points were intersected with 
land ownership to target the parcels that 
had the greatest potential for loading 
and to maximize the effectiveness 
of time in the field.
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Site 10 had a very high concentration of CSA’s with some very strong SPI signatures running through high 
USLE areas. It was also apparent in the aerial photo that there was an animal crossing at the creek near the road. 
This increased the priority of the site for the initial evaluation.
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CSA 10H had a few SPI signatures converging on it and 
was a location where the meandering stream came very 
close to the field edge. When evaluated in the field no 
signs of channelization and very minimal signs of 
sedimentation were observed at the pour point. Good 
landuse management and a functional buffer were found 
at this site limiting the potential for issues at this CSA. 

Pourpoint 
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CSA 10M was not located during the original desktop analysis. It was a tile inlet located during the field visit. 
As shown in the aerial image there is a SPI signature to the southwest of the tile inlet. This was incorrectly 
located as a result of the pit filling function of the terrain analysis. What it is actually indicated on the map is 
what would happen if the field depression was to fill up with water and overflow. With the tile in place this 
would not happen. The tile inlet was identified as a potential nutrient source. The inlet was in a depression and 
was showing signs of erosion and soil loss. Also, there was no inlet protection in place (just an open tile). It is 
recommended that tile inlet protection be installed or the inlet be buffered to reduce the chances of sediment and 

nutrients leaving the field and entering Mill Creek. 
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CSA 10F represented a site with very strong SPI signature running through USLE areas. In addition, this area is 
a livestock crossing that was in need of better management. The stream at this site had been heavily lined with 
riprap. This indicated that there was a past issue with stream bank stability at this location. There was some 
active erosion occurring on the site as well. The landowner will be moving the livestock crossing to a better 

location and reestablishing vegetation along the stream at this location.  
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Site 11 was the next site downstream. It also had a high number of CSA’s, strong SPI signatures and USLE 
signatures.
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One of the sites evaluated (11F) showed stability in the field and had a wooded buffer with slight signs of 
channelization and erosion.  
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Although the office terrain analysis tools did point us towards issues in the field we found that field work can 
never be replaced completely with remote sensing tools. This stream bank erosion is something that would not 
be identified with the office analysis but has the potential to contribute a substantial load of sediment to the 
system. The stream analysis field tools were used at this site. If a number of issues like these were identified, 
the results of the field analysis tools can be used to prioritize a plan of action in addressing the erosion sites.  

 

 
 

 

Streambank Erosion 

 

Streambank Erosion 
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After going through the PMZ process on this channel the source of sediment/nutrients that may be contributing 
to the impairments of Pearl Lake have become more apparent. It is estimated that there are five to six main 
issues that we may need addressing (livestock stream crossing, a private ditching system, stream bank 
instability site  s, unprotected tile intakes, etc.). Work is underway with the S   auk River Watershed District to 
implement a water quality monitoring program to increase our understanding of the loading in this system. Wo   
rk will then be initiated with the local land owners to pursue implementation funding to address the issues. 

Performing a BEHI Assessment Performing a MN Phosphorus Index 
Assessment 

Mill Creek Site 10 

Upland Assessment Worksheet Upper Part of Unnamed Creek 
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MAWQCP (Stearns County) 

Stearns County is one of the four pilot areas for the MDA’s MN Agricultural Water Quality Certification 
Program (MAWQCP). This Program is a joint effort of the MDA, MPCA, BWSR, MDNR, USDA NRCS, and 
the US Environmental Protection Agency. It’s a voluntary program designed to accelerate adoption of on-farm 
conservation practices that protect Minnesota’s lakes and rivers. Producers who implement and maintain 
approved farm management practices will be certified and in turn assured that their operation meets the state’s 
water quality goals and standards for a period of 10 years (see more at 
http://www.mda.state.mn.us/protecting/waterprotection/awqcprogram.aspx). 

There are about 800 producers in the Stearns County pilot area that we will be participating. The tools discussed 
in this guidance will be used at multiple levels for this effort. First we will be running the terrain analysis 
guidance across the project area and prioritizing the areas within the pilot area with the highest potential for 
pollution to target as high priority sites. We will then follow the protocols on individual farms as a pre-planning 
tool that would be used with the farmer. 
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The desktop targeting tools allow us to identify several things before we get into the field.  The following 
graphic shows strong signatures ending before they get to the channel, but we can clearly see sediment flume 
dumping into the flood plain. This sediment and nutrients could make their way into the channel during high 
runoff events. 

 

This site shows long SPI signatures ending in water bodies and channels in the Public Water Inventory. 

 

Sediment Flume 
from Eroding CSA 

 

CSA entering PWI 
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Here is another site exhibiting strong SPI signatures running though high USLE values. This site has some high 
priority CSA’s that need to be discussed with the land owner. 

High USLE Values 

 

Strong SPI Signature 
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Integrating HSPF Modeling with Stearns County Case Studies 

The drainage areas were delineated for each of the CSAs identified in the Unnamed Creek watershed and 
intersected with a GIS layer that contained the land segment areas modeled in HSPF. The HSPF modeling 
output was then obtained and integrated with the CSA subwatershed GIS data to determine the relative aerial 
sediment loading rates.  The results of this analysis can then be combined with information from the field 
assessment to prioritize those areas that have the greatest need for implementation of conservation practices. 
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The drainage areas were delineated for each of the CSAs identified in the Pearl Lake watershed and intersected 
with a GIS layer that contained the land segment areas modeled in HSPF. The HSPF modeling output was then 
obtained and integrated with the CSA subwatershed GIS data to determine the relative aerial sediment loading 
rates.  The results of this analysis can then be combined with information from the field assessment to prioritize 
those areas that have the greatest need for implementation of conservation practices. 
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Integrating SWAT Modeling with Cedar River Watershed Terrain Analysis 

The Cedar River and Turtle Creek Watershed Districts encompass an 8-digit HUC scale watershed in southern 
Minnesota. Four larger reaches impaired for turbidity and the draft TMDL report (Barr, 2014) calls for greater 
than 80% solids reduction from high flows (0-10% flow duration). SWAT modeling, calibrated for flow and 
sediment loading at approximately the 10-digit HUC scale accounted for more than 900 existing BMPs, 
including: 

• 830 filtration practices (grassed waterways, water and sediment control basins, filter strips and side inlet 
protection) 

• Pond/wetland restoration areas (both parcel-based and regional treatment) 

The following figure shows how the SWAT modeling sediment yields and flow-weighted mean suspended 
solids concentrations are anticipated to vary across the watershed.  The modeled estimates can be combined 
with the results of the digital terrain analysis to further prioritize the areas of the watershed that are in need of 
conservation practices. 
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The following figure shows how the 90th percentile SPI signatures produced from the terrain analysis were 
compared with the locations of inventoried BMPs to identify and further refine the CSAs that require 
implementation of new BMPs. 

 

 

168 Identifying Priority Management Zones for BMP Implementation in Impaired Watersheds 
 



Case Studies 2014 
 
 

For the same area, the following figure shows the delineated area tributary to each of the remaining CSAs. The 
resulting drainage areas for each CSA can be intersected with the watershed modeling output to further 
prioritize potential project areas following field verification of the delivery mechanisms and/or erosion 
potential. 
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Based on the results of the watershed modeling, a smaller subwatershed was identified as a priority for 
demonstrating potential restoration options. To assist in locating and testing the benefit of potential BMPs, a 
grid-cell discretization of the SWAT model was applied to the study area shown in the following figure. This 
version of the SWAT model allows for detailed estimates of sediment export based on the two-dimensional 
interaction of 30x30-meter areas of the landscape, including the potential effects of stream power and channel 
erosion. As a result, the grid-cell modeling accounts for artificial drainage and erosion and deposition 
throughout the system, which allows for prioritization based on the estimated effects at various receiving water 
scales. Since the resolution of the model output is still larger than the 3-meter resolution used in the digital 
terrain analysis, the 99th percentile SPI signature lines were superimposed in the following figure to identify the 
30-meter grid cells that have a defined hydrologic connection to the surface water system and would be 
expected to possess the highest risk for gully or channel erosion. The integrated data, combined with field 
verification, can be used to prescribe and prioritize the implementation of conservation practices. 
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Integrating Terrain Analysis with Sub-Field Soil Fertility 

The following figure illustrates how the 99th percentile SPI signature data can be integrated with sub-field scale 
soil fertility data, using Bray phosphorus soil test results (previously generated from an outside testing lab), to 
prioritize the pourpoints that have the greatest need for implementation of conservation practices. 
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Integrating Terrain Analysis with Watershed Modeling for Ravine Erosion 

An inventory and assessment of the Bluff Creek Lower Valley completed in 2007 identified sites contributing 
sediment to Bluff Creek as well as the erosion severity at those sites. Erosion severity was qualitatively assessed 
by a geomorphologist based on the relative volumes of erosion observed at each site and divided into four 
categories: stable, minor, moderate and severe. Numbered site locations are shown in the following figure. 
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A terrain analysis was conducted for each of the ravines based on SPI calculations to further assess the erosion 
potential for each ravine (Barr, 2013).  The SPI is a function of both slope and tributary flow accumulation area, 
but does not necessarily equate to volume of water flowing to a particular point on the ground.  The SPI 
represents the ability of intermittent overland flow to create erosion, but the SPI values are not differentiated 
based on soils type or land cover effects on runoff volume or erosion.   SPI values were calculated for every 100 
ft2 of the Bluff Creek watershed and the top 5 % of values are displayed in the following figure along with the 
peak SPI value and location for each of the ravine watersheds. 

The terrain analysis, erosion survey and watershed modeling results were combined to help assess each of the 
ravines in the lower reach of Bluff Creek, including the ravine erosion classification, annual peak flow and 
runoff volume, and the max SPI value and average of the top 5 % SPI values for each of the ravine watersheds 
obtained through the terrain analysis.   
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The results of the integrated analysis were grouped in the following figure which shows the relationship 
between the average SPI and the modeled peak flow rate between 1990 and 2008 grouped by ravine erosion 
severity.  On average, ravines with low modeled peak runoff rates were surveyed as having either stable or 
minor erosion.  Ravines with a higher Stream Power Index showed minor erosion when compared to the stable 
ravines.  Ravines surveyed with moderate erosion displayed higher average modeled peak flow rates with 
comparable SPI values than both ravines with minor or stable erosion.  On average, ravines surveyed as having 
severe erosion had both higher SPI values and modeled peak flow rates than the ravines surveyed with minor or 
stable erosion and higher SPI values than those surveyed as having moderate erosion. 
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Appendix 

A.1 Digital terrain analysis accuracy results 

Table 3 shows comparisons between the Sediment Delivery Potential (SDP) of erosional features identified 
or not identified in several Dodge Co., MN study areas using the GIS–based validation survey technique and 
a 97.5th percentile threshold calculated from each HUC12 study area. 

SDP scores consist of three incremental values of risk: low, medium, and high (1, 2, and 3 respectively). 
The score was determined by a field technician’s best professional judgment. Some of the factors that 
influenced the SDP score include general size and position of the feature in the landscape, the size of the 
drainage contributing area, and obvious indicators of sediment delivery, such as active alluvial fans. 
Although subjective, these SDP scores provide qualitative categories that can be used to compare the 
relative impact of gullies on potential water quality degradation (Galzki et. al., 2011). 

Table 3 

 Validation result    
SDP value of 
erosional 
features 

Features 
identified 

Features  not 
identified 

Total erosional 
features 

identified 

Accuracy 
(%) 

Commission 
errors 

1 (Low) 44 15 59 75% N/A 
2 (Medium) 23 6 29 79% N/A 
3 (High) 8 0 8 100% N/A 
Total 75 21 (omission 

errors) 
96 78% 74 of 139 

pts 
 

In total, 96 features (gullies, ravines, tile outlets, bank slumps, grassed waterways) were identified in the 
field. 

Overall, GIS terrain analysis correctly predicted the location of 78% of field erosion source areas. Accuracy 
was greatest for large features (100%). 

The ‘Total’ row is showing that out of the 96 features identified, 75 were closely associated with an SPI 
signature from GIS terrain analysis, and 21 were not (omission errors). The commission errors, also known 
as false positives, are predicted CSA points (there were 139 in total) placed using preliminary GIS analysis 
that were not closely associated with a field surveyed location. 

The following two figures contain boxplots using data from the same Dodge Co. study areas. Figure 6 
compares a 1-10 SPI rank to erosional feature SDP assigned values. The lower limit of the box represents 
the 1st quartile, the top limit is the 3rd quartile, and the middle solid line is the median value of the data. The 
whiskers are 1.5x the inner quantile range, with dots representing outliers. Figure 7 shows the same boxplot 
configuration with a comparison made between field verified points vs. an equal number of randomly 
generated points. 
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Figure 6 

Figure 7 
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Table 4 shows comparisons between the SDP of erosional features identified or not identified in several 
Wabasha Co., MN study areas using the GIS–based validation survey technique with a 97.5th percentile 
threshold. 

Table 4 

 Validation result    
value of 
erosional 
features 

Features 
identified 

Features  not 
identified Total erosional 

features identified 
Accuracy 

(%) 
Commission 

errors 

1 (Low) 12 1 13 92% N/A 
2 (Medium) 15 3 18 83% N/A 
3 (High) 3 0 3 100% N/A 
Total 30 4 (omission 

errors) 
34 88% 12 of 34 pts 

 

In total, 34 features (gullies, ravines, tile outlets, bank slumps, grassed waterways) were identified in the 
field. 

Overall, GIS terrain analysis correctly predicted the location of 88% of field erosion source areas. Accuracy 
was greatest for large features (100%). 

The ‘Total’ row is showing that out of the 34 features identified, 30 were closely associated with an SPI 
signature from GIS terrain analysis, and 4 were not (omission errors). The commission errors, also known as 
false positives, are predicted CSA points (there were 34 in total, it was a coincidence that there were also 34 
field points) placed using preliminary GIS analysis that were not closely associated with a field surveyed 
location. 

The following two figures contain boxplots using data from the same Wabasha Co. study areas. Figure 8 
compares a 1-10 SPI rank to erosional feature SDP assigned values. The lower limit of the box represents 
the 1st quartile, the top limit is the 3rd quartile, and the middle solid line is the median of the data. The 
whiskers are 1.5x the inner quantile range, with dots representing outliers. Figure 9 shows the same boxplot 
configuration with a comparison made between field verified points vs. an equal number of randomly 
generated points.
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Figure 8 

Figure 9 
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The following table and figure (Table 5 and Figure 10) were published in the 2011 Galzki, et. al. paper, 
published in the Journal of Soil and Water Conservation. They show terrain analysis accuracy results in the 
same format presented in the two proceeding examples. Galzki’s study was conducted in two watersheds, 
named Beauford and Seven Mile Creek, within the Minnesota River basin, near Mankato, MN. 

Table 5 

 

 
Figure 10 
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A.2 Create Stream Power Index for ravine identification 

A ravine is defined as a small, narrow and deep depression, smaller than a valley, and larger than a gully 
(Bates and Jackson, 1984). Ravines grow by head cutting action, but unlike gullies, are too large to be 
transversed by farm equipment. 

Researchers  at the  University of Minnesota’s Dept. of Soil, Climate & Water developed an algorithm 
to aid in ravine identification while working in the Minnesota River Basin. The algorithm output is a 
topographic indice similar to the Stream Power Index, but includes aspect information which takes 
concave ravine profiles into account. This algorithm consisits of slope steepness greater than 7%, 
standard deviation of aspect greater than 40%, and a flow accumulation threshold between 200 and 7400 
cells, depending on topography. 

Starting from the procedures outlined in the Digitial Terrain Analysis section, the ravine algorithm will 
begin with a Digital Elevation Model. 

The algorithm output generally displays best results when pit filling is included during DEM pre-
processing. This is explained in the ‘Pre-process DEM’ section. 

The Slope and Aspect raster layers are calculated directly from the DEM as shown in the ‘Calculate 
primary attributes’ section. Remember to use ‘PERCENT_RISE’ in the arctool output measeurment. 
The Flow Accmulation raster is also used for the algorithm, and thus a Flow Direction raster will need to 
be created before Flow Accumulation. 

1. The Reclassify tool will be used to set the raster layer parameters for the ravine algorithm. Starting 
with the Slope raster layer, open the Reclassify Tool: 
a. In ArcMap, open ArcToolbox > Spatial Analyst Tools > Reclass > Reclassify 
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b. Input raster: Your Slope (slope_dem) layer. 
c. Reclass field: This should default to ‘Value’ 
d. Reclassification: Click on the ‘Classify…’ button. 

o Using the classification method pull down, select Equal Interval, and select 1 from the 
Classes pull down. 

o Click the ‘Exclusion…’ button and type ‘0-7’ (without quotes) in the exclusion value 
field, and then click OK. 

o Click OK at the bottom right of the Classification window to return to the 
Reclassify tool. 

e. Output raster: Browse to output workspace and name output layer ‘slope_ravine’ 
f. Check the box next to Change missing values to NoData (optional) 
g. Click OK to run. The output raster is added to your map as a new layer 
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2. Open the Reclassify tool again to process the Flow Accumulation raster layer: 

 

a. Input raster: Your Flow Accumulation (flowacc_dem) layer. 
b. Reclass field: This should default to ‘Value’ 
c. Reclassification: Click on the ‘Classify…’ button. 

o Using the classification method pull down, select Equal Interval, and select 1 from the 
Classes pull down. 

o Click the ‘Exclusion…’ button. The best exclusion range used here will vary depending on 
the overall topography steepness. As a general guideline: for steepest slopes, type ‘0-7400’ in 
the exclusion range (without quotes), and for shallow slopes, type ‘0-200’. 

o Click OK at the bottom right of the Classification window to return to the Reclassify tool. 
d. Output raster: Browse to output workspace and name output layer ‘fa_ravine’ 
e. Check the box next to Change missing values to NoData (optional) 
f. Click OK to run. The output raster is added to your map as a new layer
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3. The Aspect raster layer is first processed using the Focal Statistics arctool before being reclassified. 
To begin processing the Aspect raster: 
 
a. In ArcMap, open ArcToolbox > Spatial Analyst Tools > Neighborhood > Focal Statistics 

 

 
 

b. Input raster: Your Aspect (aspect_dem) layer 
c. Output raster: Browse to output workspace and name output layer ‘aspect_FS’ 
d. Statistics type (optional): Select ‘STD’ (standard deviation) from the pull down menu. 
e. Leave the other options as default (as shown above) and click OK to run. The output raster is 

added to your map as a new layer 
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4. Open the Reclassify tool once more to continue processing the Aspect raster layer: 

 

a. Input raster: Your Aspect Focal Statistics raster layer from the previous step (aspect_FS) 
b. Reclass field: This should default to ‘Value’ 
c. Reclassification: Click on the ‘Classify…’ button 

o Using the classification method pull down, select Equal Interval, and select 1 from the 
Classes pull down. 

o Click the ‘Exclusion…’ button and type ‘0-40’ (without quotes) in the exclusion value 
field, and then click OK. 

o Click OK at the bottom right of the Classification window to return to the Reclassify tool 
dialog. 
• Note: The ‘Old values’ range listed may not be rounded to 40. It is okay to leave the 

value as is, or simply click the value and change it to 40, without decimals. The same is 
true for previous Slope and Flow Accumulation reclassifications. 

 
 

d. Output raster: Browse to output workspace and name output layer ‘aspect_ravine’ 
e. Check the box next to Change missing values to NoData (optional) 
f. Click OK to run. The output raster is added to your map as a new layer
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5. Now that all thee raster layers have been reclassified into single-level rasters, the Extract by Mask 
Arctool will be used to extract only the pixels from all three layers that overlay each other. 
 
a. In ArcMap, open ArcToolbox > Spatial Analyst Tools > Extraction > Extract by Mask 

 

 
 

b. Input raster: Your reclassified Aspect layer ‘aspect_ravine’ 
c. Input raster or feature mask data: Your reclassified Slope raster ‘slope_ravine’ 
d. Output raster: Browse to output workspace and name output layer ‘aspslop_mask’ 
e. Click OK to run. The output raster is added to your map as a new layer 

 
 

6. The Extract by Mask Acrtool will be used one more time to create the final ravine raster. 
 
a. In ArcMap, open ArcToolbox > Spatial Analyst Tools > Extraction > Extract by Mask 

 

b. Input raster: Your reclassified Flow Accumulation layer ‘fa_ravine’ 
c. Input raster or feature mask data: Your Aspect/Slope masked raster from the previous mask 

iteration ‘aspslop_mask’ 
d. Output raster: Browse to output workspace and name output layer ‘ravines’ 
e. Click OK to run. The final Ravine output raster is added to your map as a new layer 
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A.3 Create Area of Interest DEM manually using Clip 

• Clip DEM Raster 
Minnesota LiDAR data acquired at the county level can contain very large file sizes. It is therefore 
important to minimize the spatial area to be processed to reduce output files sizes and increase 
processing times. The Clip ArcMap tool creates a subset of a raster dataset and will be used for this 
purpose. 

o Note: There are two Clip tools in the ArcToolbox – only one of which will create a subset of 
raster data. 

 
1. Open Data Management Tools >  Raster > Raster Processing > Clip 

 

 
 

2. Input Raster: Your DEM 
3. Output Extent (optional): A raster or vector (point, line, or polygon) layer that covers the full 

extent of you AOI. For example, this could be a shapefile/feature class that you created yourself, 
HUC12 catchment(s), any digitized landscape feature, etc. 

4. Check the box next to Use Input Features for Clipping Geometry (optional). 
5. Output Raster Dataset: Browse to output workspace and name with something you can 

remember, e.g. 'dem_clipped'. 
6. Click OK to run. The clipped output surface raster is added to your map as a new layer. 
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A.4 Calculating thresholds using R statistical package 

It may be preferable to use a dedicated statistical software program to calculate percentile thresholds, as 
they are capable of handling large data sets. Though most any statistical program can be used for this 
calculation, R is recommended as it’s both free to use and able to process simple to complex functions. 
The calculation of thresholds using R is straight forward and will require downloading and installing the 
R stats package along with a small add-on. 

 
1. Acquire and install R 

Download R for your Windows, Mac, or Linux operating system from the following link: 
http://cran.r-project.org/bin/windows/base/old/2.14.2/ 
o Note: It is recommended to install R version 2.14.2 for full compatibility with maptools. 
 

2. Launch the R application. RGui will open with an active R Console window. The R console 
contains a command line that will be used for all R function inputs. 
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3. Install and load the maptools add-on package. This will allow the user to import dbf files directly 
into R. 
a. To install maptools, type in command line: 

 
install.packages("maptools", repos = "http://cran.case.edu") 
 

If prompted to use personal library, choose Yes. 
Note: Make sure computer is connected to internet for this step. 
 

b. Load maptools package into R by typing in command line: 
 

library(maptools)  
 

Note: The maptools package will need to be loaded into R each time the application is run 
using the above command. It will only need to be installed one time. 

 
4. Prepare data for import into R. When exporting raster layer data for R input, any NoData cells 

around the area of interest will be exported as well. To circumvent NoData cells in exported data, 
convert raster cells to point shape data by using the Raster to Point Arctool as follows: 

 
a. Open ArcToolbox > Conversion Tools > From Raster > Raster to Point 

 

 
b. Input raster: your SPI or CTI layer. 
c. Output point features: Browse to output workspace and name output layer either spi_points 

or cti_points. 
o Note: Avoid storing the output feature in a geodatabase, as the .dbf table will be 

inaccessible from that location. Instead, store it in a folder as a shapefile. 
d. Click OK to run. 

o Note: The output from the Raster to Point shapefile contains three types of files, one of 
which is a .dbf file that contains attribute information. In this case, it contains each 3x3 
meter cell value needed to compute a threshold (assuming a 3m DEM was used). 
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5. Import data into R 
a. We will import the Raster to Point shapefile’s .dbf table computed previously. Recall the 

output location of that file. R uses programming language that is case sensitive and requires 
certain formatting. We will use the following format for the read import function: 

identifier <- read.dbf(“directory address/file_name.dbf”) 

The identifier is a user created name assigned to data and is therefore not case sensitive. It 
cannot contain spaces. Users should adopt naming conventions using either no space or a 
period (.) symbol as a separator to make reading, sharing, and verifying code easier. The 
address location must use forward slash (/) as the directory separator. 

Example of read import syntax: 

SPIpoints <- read.dbf(“C:/My GIS data folder/spi_points.dbf”) 

Press enter once the command has been typed. There should be no messages displayed. 

Note: The program may not be responsive for a few minutes depending on the size of the 
imported file. 

b. Check your imported data’s header and make note of the column names by using the head 
function in the R console: 

 
head(your.identifier.name) 

 
Example: 

head(SPIpoints) 
 

The exact name of the raster value’s column is needed for threshold calculations. Typically, 
Raster to Point dbf files use ‘GRID_CODE’ for the raster value column name. 
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6. Calculate threshold percentile values 

Percentiles are calculated using the quantile function in R. 
 

quantile(your.identifier.name$raster_value_column_name, percentile) 
 

The ‘your.identifier.name’ is taken from previous step a; ‘raster_value_column_name’ is 
taken from previous step b; and percentile is recognized in R as a probability statement – any 
numerical value between 0 and 1 can be used. 
Note: a list of several percentiles can be used in one command line by using c(percentile1, 
percentile2,…percentileN) 
 

Examples: 
 
 quantile(spi.points$GRID_CODE, .85)                                            #one percentile 
 quantile(SPIpoints$GRID_CODE, c(.9, .95, .975, .99))          #multiple percentiles 
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A.5 Determine the cell count of your raster layer of interest 

1. Double click on the layer in the table of contents window. 
2. In the symbology tab, select ‘classified’ in the left window. If asked to calculate a histogram, say 

yes. 
3. Click on the ‘Classify…’ icon. 
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4. The number of records in the raster layer will be displayed in the top right under 
Classification Statistics as Count. This can also be thought of as the population size of the 
SPI raster. 

 
 

5. Click cancel on both windows to revert back to your original symbology. 
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A.6 Delineate catchments using NRCS GIS Engineering Tools 

The contributing area upland of CSAs can be used to estimate the amount of potential sediment 
and nutrient delivery at those pour points. The NRCS offers a free tool called ‘NRCS GIS 
Engineering Tools v1.17’ which allows creation of contributing area catchments from a user 
defined point. 

1. Define Area of Interest 
a. In the NRCS Engineering Tools toolbox, expand Watershed Tools followed by 

Watershed Delineation and double click the Define Area of Interest tool script 

 

1 
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b. Browse to and Select Workspace: Choose your workspace folder where outputs will be 
stored 

c. Input DEM: Your DEM, preferably a 3m LiDAR elevation dataset. 
d. Enter your Area of Interest: Click the Add feature icon (1 circled red in above image), 

then minimize the Define Area of interest window. The add feature tool works as a 
polygon editor, with each click creating a new vertex. The sketch is finished by double 
clicking to connect the first and last sketch vertices. 

e. Interval for Contours (feet) (optional): Select desired contour foot contours. If left 
blank, no contours will be created 

f. Choose DEM Elevation Units (optional): User preference  
g. Click OK to run tool script. Several new layers will be added to your map 

 

2. Create Stream Network 
a. In the NRCS Engineering Tools toolbox, expand Watershed Tools followed by 

Watershed Delineation, and double click the Create Stream Network tool script 

 

2 
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b. Select Project_AOI feature: Select the AOI that was created by the previous Define 
Area of Interest tool 

c. Digitize Culverts (optional): Click the Add feature icon 2 circled in red above then 
minimize the current window. The add feature function works as a line sketch tool. Use 
the function to make a line that represents a culvert at any obvious or known locations 
where a culvert exists. The DephthGrid layer created by the previous tool can aid in 
showing where water backs up at impoundments such as road crossings. Culverts are 
likely to exist at these locations. Create as many digitized culverts as necessary to ensure 
an accurate stream network representation.  

 

d. Enter Stream Threshold in Acres: This value is the minimum contributing area 
required to form a stream. The default value of 1 is adequate in most situations and will 
form stream headwaters near catchment boundaries. 

e. Click OK to run tool script 

 

197 Identifying Priority Management Zones for BMP Implementation in Impaired 
Watersheds 

 



Appendix 2014 
 
3. Create Watersheds 

a. In the NRCS Engineering Tools toolbox, expand Watershed Tools followed by 
Watershed Delineation, and double click the Create Watershed tool script 

  

b. Select AOI Stream Network Feature: Select the stream network feature that was 
created by the previous Create Stream Network tool 

c. Digitize Outlets: Click the Add feature icon 3 circled in red above then minimize the 
current window. The add feature function works as a line sketch tool. Each click adds a 
vertex and double clicking ends the sketch. Use the function to make a small line 
perpendicular to any stream outlets where a watershed is to be created. A catchment will 
be created upstream of the digitized outlet line(s). 

d. Click OK to run tool script. The watersheds will be added to your map as a new layer 

3 
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e. Enter Stream Threshold in Acres: This value is the minimum contributing area 
required to form a stream. The default value of 1 is adequate in most situations and will 
form stream headwaters near catchment boundaries. 

 

The blue stream line oriented north-
south in the image on left is flowing 
south and empties into the east-west 
oriented stream. To create a catchment 
of the north-south stream, a digitized 
outlet (shown with blue dots) is made 
perpendicular on that stream near its 
outlet. The catchment will terminate at 
that perpendicular line. 

199 Identifying Priority Management Zones for BMP Implementation in Impaired Watersheds 
 



Appendix 2014 
 
 

A.7 Suggested Methods for Approaching Landowners and Operators 

The following series of tips are provided as a guide for field staff requesting permission from 
landowners to conduct a site assessment associated with identifying PMZs and CSAs. The tips 
include ways to prepare prior to making the initial contact, methods to explain the purpose and 
uses of the site assessment, how the farmer can place restrictions on the use of the collected data, 
and brief descriptions of the assessment tools being used. At the end of this appendix is a 
suggested script for approaching landowners, provided for those who are interested in seeing an 
example approach. This script is intended to be adapted by users to fit the purpose of the specific 
data collection effort. When adapting the script, the user can include local knowledge of the 
watershed conditions and known personal interests of the producer being contacted. This 
document also includes talking points and answers to some frequently asked questions. In some 
cases, a producer might indicate that a PMZ or CSA on the property also is affecting the farm 
operation. These opportunities can be used to engage the producer regarding potential ways the 
site assessment can benefit both watershed conservation efforts and on-farm management.  

When approaching producers and gathering site information, it is important to be aware of 
the following data use restrictions: 

• Producers hold complete control over data regarding their operation. 
• Data collected under other Farm Bill programs cannot be used for a new purpose without 

the written consent of the producer. 
• Producers must be made aware of the uses of data collected under a new purpose. The 

level of commitment to share the data remains under producer control. 
• The producer has three options for sharing data: Data is not to be shared, data may be 

shared when identification, location, and personal information is not revealed (e.g. data is 
presented in summary form), data sharing is unrestricted. 

Overview  

Gaining access to lands is essential for conducting site assessments. These site visits serve dual 
purposes. The first purpose is to identify PMZs and CSAs for focusing conservation efforts. The 
second purpose is acknowledge producers for effective conservation efforts and/or engage 
producers regarding additional conservation practices that could be undertaken.  

Sites for field assessments can be selected based on terrain analysis and other spatial analysis 
methods, as well as office knowledge of local watershed characteristics. (This site selection 
process is described in the Sensitive Site Identification Guidance document.) These spatial 
analyses utilize GIS software to characterize the physical features of the landscape. The analyses 
techniques are used to identify potential high-priority sites, based on their vulnerability to 
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erosion and other characteristics that potentially impact water quality. Sensitive site 
identification using spatial analyses is intended to help conservation organizations delineate 
areas and zones that can be prioritized for further assessment and protection. The use of spatial 
analysis is intended to supplement, not replace, field assessments and can be used to inform site 
selection and enable organizations to focus limited resources on potentially high-priority areas.  

Field assessment results also can document successful conservation efforts to acknowledge 
producers for their success and good work. These documented efforts then could be applied 
toward environmentally based initiatives, such as the Minnesota Agricultural Water Quality 
Certification Program. This program is being created to provide ten years of relief from new 
regulatory requirements to producers that meet certain requirements. Site assessment results also 
could provide some of the necessary information for participating in environmental initiatives 
like corporate supply chain sustainability programs. These programs allow food processors to 
label their products as environmentally friendly when a certain level of farm stewardship has 
been met. In return, the processor might make additional payments to producers for achieving the 
level of performance required by the label. Site visit results could provide supporting 
justification for future funding applications for BMP implementation based on indications that 
the site is of regional or watershed importance. In addition, the site assessment could document 
progress toward achieving TMDL nonpoint source load allocations. 

The outcomes of site visits also can be used to provide feedback to producers regarding 
opportunities to improve conservation practices. In this scenario, the tools have identified 
sensitive management areas that are not currently being addressed by BMPs. This information 
can be used to engage the producer on how issues can be corrected in ways that also benefit the 
farm operation. These discussions should emphasize that the producer is not being penalized. 
Rather, the conversation should focus on how BMP opportunities can be beneficial to both the 
producer and water quality objectives. These discussions can incorporate educational materials 
about watershed goals and BMP options. 

Assessment Tools 

The following tools are being applied through the site visits: 

Terrain Analysis:  Terrain analysis is a GIS-based assessment that analyzes changes in 
topography. For this project, elevation maps are used to identify locations that are likely to 
have a high erosion potential. This is combined with a spatial analysis of erosion risk based 
on soil type to provide indicators of locations that potentially are vulnerable to ephemeral rill 
and gully erosion.  

Spatial Analysis:  Spatial analysis is a GIS-based assessment that can analyze multiple 
landscape attributes.  For instance, spatial analysis can be used to identify wetlands with 
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different restoration potentials, variability in livestock densities, and/or the potential for sheet 
erosion.  . 

Upland Field and Channel Assessment:  This assessment involves field evaluations that 
determine whether the GIS analysis correctly identified the sensitive site, as well as gather 
information about runoff pathways on that site. Several reasons could result in the GIS 
analysis not aligning with field observations. For example, the issue might be managed 
appropriately, therefore alleviating the issue. Alternatively, the GIS analysis results might 
have omitted a sensitive site. These limitations should be incorporated into the users 
understanding of the tool and possibly lead to later refinements of the tool itself. 

Streambank Erosion Assessment:  This is a river or stream assessment that indentifies 
banks with signs of active erosion. This is an inventory assessment to document the 
characteristics of the eroding sites. Erosion information collected about multiple sites can be 
combined and used to inform later watershed management initiatives regarding bank 
stabilization or pollutant loading estimation projects. 

Minnesota Rapid Phosphorus Index:  A version of the Minnesota Phosphorus Index called 
the Rapid Phosphorus Index (Rapid P-Index) can be used to evaluate the potential for 
phosphorus releases from a site. This screening tool is designed to be easy to use with 
minimal time requirements. If the results indicate a potential concern, the users are 
encouraged to perform the full Minnesota Phosphorus Index. However, the Rapid P-Index 
can be used to simply identify indicators of phosphorus runoff risk and open discussions for 
addressing the identified concerns. 

 

GETTING STARTED 

The initial contact with landowners should be direct, factual, and respectful; apply common 
sense; and easy to understand. Ultimately, the approach should create compelling reasons for 
producers to take a personal interest in the initiative. Experience has demonstrated that it is 
helpful to overlay parcel ownership information on the spatial analysis maps to aid in identifying 
the appropriate people to contact. Once landowners are identified, it can help to reach out to 
existing personnel who have first-hand knowledge of the identified landowners. These 
individuals can provide valuable background information, including occupation, history of work 
with the conservation agency, type of farm operation, etc. This knowledge can assist with 
selecting an appropriate approach tailored for each landowner. 
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MAKING THE INITIAL CONTACT 

The following template can be used when contacting landowners to introduce the project and 
request access to the property: 

1. Identify yourself 
State your name, organization, and ask if the landowner has time to talk. If not, 
arrange a time to call back. 

2. Introduce the project 
Explain that you are working on a watershed study that will enable conservation 
funding to be allocated more efficiently. You would like to be able to access their site 
to apply the new tools. The visit will involve assessing potential sediment and 
nutrient runoff from the site. The data gathered will not be used for regulatory 
purposes and will be shared with others only to the extent the farmer allows. 

3. Emphasize the importance of their land and assistance for this effort 
These tools will help with watershed planning and improving water quality. They also 
can be used to acknowledge conservation efforts made by landowners or assist 
landowners with identifying additional conservation opportunities. 
 

Offer to meet in person to provide additional information and show the maps and tools being 
evaluated. If a short introductory visit is not necessary, proceed to the next steps. 

4. Explain exactly what will occur during the site visit 
A team of a few people will walk the riparian zone, measure stream attributes, and 
look at the adjacent upland to determine the nature of the runoff. This information is 
being collected to help identify high-priority areas for conservation efforts. In some 
cases it is beneficial to obtain some management information (however, this might 
not always be the case). 

5. Re-emphasize that the 
assessment information will remain anonymous 

The data collected will not be shared without the written consent of the producer and 
the land and operation will not be identified. The information will be used only for 
voluntary watershed planning. If the visit identifies an opportunity for an operation to 
benefit from soil and water conservation BMPs, potential options that would benefit 
both the operation and watershed goals can be discussed. 

6. Try to arrange a date and time for the site visit 
Explain how many people will be going, their agency affiliation, when they will be 
there, and for how long. Emphasize that no regulatory agency personnel will be 
conducting the assessments. If nutrient management records or information on field 
equipment operations will be needed, alert the producer in advance. 

7. Ask if there is vehicle access to the stream 

203 Identifying Priority Management Zones for BMP Implementation in Impaired Watersheds 
 



Appendix 2014 
 

8. Invite the landowner to come along and offer them copies of the information 
collected 

9. Ensure them that you will close all gates and won’t drive over crops or leave ruts in 
the field 

10. Thank them for their help 

After the site visit is complete, consider sending a thank you letter from the agency or project 
leader. 

EXAMPLE CONTACT LETTER TEMPLATE 

[Recipient Name]: 

My name is [Insert Sender Name Here] and I work for [Insert Organization Here].  As you may 
know, [Insert Water Body of Concern Here] is exhibiting serious problems with [Insert 
Pollutants of Concern Here], especially after large runoff events.  These impairments are 
changing the nature of this stream and are impacting all downstream uses including agriculture, 
recreation, and wildlife.  The [Organization] is currently in the process of assessing this 
watershed to determine where to best direct technical and financial assistance to its land users to 
address the source of these impairments.   

We would like to visit with you on your property to discuss some of the watershed assessment 
tools that we are employing in this area.  We can also discuss any other information or ideas that 
you have that could help us in this effort. 

Please contact me at [Insert Phone Number Here] to set up an appointment or for more 
information.   

Sincerely, 

[Sign] 

Frequently Asked Questions 

Q: What organizations are involved in this project? 

A: Explain your organization’s title and purpose. If other organizations also plan to attend, 
provide their titles, organization affiliation, and reason for their interest. If beneficial and 
appropriate, reassure the producer that no regulatory personnel will be in attendance. 

Q: What type of information will be collected? 

A: Data related to stream stability, topography, vegetation types, land use, and cropping systems 
will be collected. Sharing of the gathered information will remain under the control of the 
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producer. Options range from being completely anonymous to providing written permission to 
release selected information (e.g., when used to justify funding for desired practices). 

Q: How will the gathered information be used? 

A: Initially, the information will be used to evaluate and efficiently select sites for the 
prioritization of providing technical assistance and public funding. The information also can be 
used to acknowledge producers who are effectively implementing conservation practices to 
manage their vulnerable sites. 

Q: How many people will be on my property? 

A: Generally, a team will consist of two or three field technicians from the office running the 
program (SWCD, Conservation District, Watershed Management Organization, ...).  

Q: How long will people be on my property? 

A: Gathering the information typically takes a few hours. 

Q: How will you access my property? 

A: We will park and walk into the fields and riparian areas selected for evaluation. 

Talking Points 

• Project purpose: 
o Outcomes of this project are not intended for any regulatory purpose. 
o The results of site assessments can be used to recognize producers who are 

successfully managing erosion issues. 
o Local planners can use these tools to create targeted water quality protection plans 

within watersheds with surface and groundwater concerns. The appropriate tools 
and models will help the planner determine where these problems are occurring, 
the extent of these problems, and the cost to implement the needed BMPs. 

• Information sharing: 
o The use or sharing of the gathered information is controlled by the producer. 
o All data will remain anonymous, unless specific permission is granted by the 

producer. 
• Utilizing the data for funding applications: 

o Accurately identified PMZs and their associated water quality plans are the best 
way to access funds from many federal and State water quality improvement 
programs. This includes improving the ability to leverage the public funds for 
production oriented BMPs such as precision agriculture systems for nutrient 
placement.  
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o Funding for soil and water conservation is becoming more and more targeted to 
PMZs because of mandatory TMDL assessments, grant sourced funding, 
increasing competition for conservation dollars, public demand for accountability, 
and reduced conservation agency budgets. 
 The Clean Water, Land and Legacy Amendment (3/8s of 1 percent of the 

State’s sale tax revenue dedicated to natural resource conservation, parks 
and trails, and the arts) created an extraordinary opportunity in Minnesota 
for conservation funding. The Clean Water portion of this amendment is 
projected to generate 90 million dollars a year to protect, enhance, and 
restore the State’s water resources.     

 Seven partnering agencies and the University of Minnesota administer 
these funds and each has an application review board or council. 

o Properly prepared Clean Water Fund grant proposals will help conservation 
organizations access money that will go directly to land users to get the needed 
conservation practices on the ground. 

o Land users can obtain funding to fix gullies that are interfering with field 
operations, stop eroding stream banks that are encroaching on fields and pastures, 
fix a feedlot that is out of compliance, set up prescribed grazing systems that can 
double forage production, or help pay for cover crops to improve the soil and stop 
erosion.  (Cite many examples specifically how these dollars can improve the 
farming operation and protect the water resource.) 
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A.8 SWCD Survey Results from Review of Field Evaluation Forms 

The field evaluation forms were tested by the Stearns County, Washington County and Chisago 
County Conservation Districts (CD).  The CD field staff provided feedback which altered the 
forms in order to ensure the forms and protocols were user friendly and effective. The field staff 
were supplied a draft field manual and accompanying evaluation forms. They also were provided 
with training on how to apply the field evaluation protocols presented in the manual.  

The staff then used the protocols and forms to perform site evaluations. This included mapping 
features on an aerial photograph, performing visual stream assessments, and documenting pour 
point characteristics. The staff also performed a Minnesota Rapid Phosphorus Index and 
conducted a streambank erosion inventory. 

The staffs were asked to complete a survey after conducting the field evaluations using the 
provided protocols and forms. The survey was used to inform revisions to the field manual and 
forms regarding: 

• Overall value 
• Ease of use 
• Helpfulness of the training 
• Effectiveness of site assessment 
• Whether the staff would choose to use the protocol again 
• Suggested ways for improving the protocols and forms 

 

The results of this survey are summarized in the following table. 
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Conservation District  Chisago Stearns Washington All 

Upland Field & Channel 
Site Assessment Time 
Required (minutes)  

15 30 4 16 

# of Sites Completed  9 23 183 215 

Ease of Use  Good Good Undecided Good 

Informative?  Good Good Good Good 

Useful?  Good Excellent Excellent Good+ 

Will You Use this in the 
Future?  

Yes Yes Yes Yes 

Visual Stream Assessment 
(TN-99) Time Required 
(minutes) 

15 15 15 15 

# of Sites Completed 14 30 5 49 

Ease of Use Good Good Undecided Good 

Informative? Good Good Undecided Good 

Useful? Good Undecided Undecided Good 

Will You Use This in the 
Future? 

Yes Yes Yes Yes 

 

The field manual protocols and forms were revised based on this feedback to make the field 
evaluations more effective and useful to the staff. For example, the full Minnesota Phosphorus 
Risk Index (P-Index) evaluation was replaced with the Rapid P-Index evaluation. This was 
considered to ease the rigor and associated time commitment while maintaining the value of the 
P-Index regarding implementation planning and generating discussions with farmers. If the 
results of the Rapid P-Index indicate phosphorus concerns, a full P-Index can be completed. The 
recording forms also were adapted to be more friendly for using in the all-weather conditions 
encountered in the field. In addition, the full Bank Erosion Hazard Index (BEHI) and Near Bank 
Stress (NBS) evaluations were replaced with a more qualitative inventory form. This approach 
better reflected the time constraints of field staff.  After adjustment of the protocols the field staff 
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in Stearns County tested the new protocols to ensure the performance of the materials were 
adjusted appropriately.  The protocol cycle of generation, test and adjust was completed three 
times in order to provide documents that met the needs and expectations of the field staff. 
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